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Part 1: Using the Conventional 
Programming Application 
This part describes the basic operation of the Conventional Program-
ming Application.

Topics

� Getting Started

� The Application Interface

� Conventional Programming Application Basics
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Getting Started

This application provides an easy way of changing settings 
and features of Tait Orca portable radios using a standard 
IBM-compatible PC. 

This manual is intended as an installation guide and reference 
for the Conventional Programming Application. It provides 
the following information:

� installation instructions and hardware setup

� an overview of the Conventional Programming Applica-
tion

� reference guide to all parameters and settings

Minimum System Requirements
The application requires the following minimum configura-
tion:

� an IBM compatible PC with an 80486 microprocessor 
(or better)

� Windows® 95, Windows 98, Windows 2000 or Win-
dows NT® 4

� 16 MB of RAM

� a VGA colour graphics display

� a hard disk drive with 8 MB of free space (20 MB Rec-
ommended)

� CD-ROM drive

� a printer (if you intend to keep a hard copy of data)

� a Microsoft or compatible mouse and driver (if you wish 
to use the program with a mouse)

Equipment Supplied
� application CD-ROM

� radio programming lead with an RJ-11 telephone-style 
socket at one end and an accessory connector at the other 
(TOPA-SV-007)

� radio programming cable with a 9-pin or 25-pin serial 
connector at one end and an RJ-11 telephone-style plug 
at the other

Application Installation
To install the application:

1. Insert the CD-ROM into your CD drive.

2. If the autorun does not automatically start, double-click 
on My Computer.
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3. Double-click on the CD-ROM drive to view the CD’s 
contents.

4. Double-click on the file setup.exe.

The installation program will guide you through the installa-
tion process. Read the information presented on the screen 
carefully.

Connecting a Radio to the PC
To connect the radio to the PC:

1. Connect the programming cable to the programming 
lead.

2. Connect the accessory connector to the radio.

3. Connect the serial connector to the computer’s serial 
port.

Plug the serial connector into one of the COM ports. You 
can specify the COM port the application uses to communi-
cate with the radio using the File>Preferences command.

Once connected, the radio must be switched on before it can 
be programmed. To ensure the radio does not switch itself 
off during the session, use a fully-charged battery or a DC 
service adaptor (TOPA-SV-005).

If your serial connector is 25-pin and 
your computer has a 9-pin serial port, 
you will need an adaptor cable. This is 
available from your PC dealer. 
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Conventional Programming Application 
Basics

When you first start the Conventional Programming Appli-
cation, the main window appears showing:

� Menus: A series of menus along the top of the window. 
See “Menu Commands” on page 15.

� Toolbar: A toolbar with a series of buttons. See “The 
Toolbar” on page 20.

� Forms tree: A list of forms. See “The Forms Tree” on 
page 20.

Before changing any radio settings you can:

� read a radio or

� open a radio programming database that has been saved 
to disk or

� create a new radio programming database file

Press the F1 key for context-sensitive help.

Reading a Radio
To read a radio, the radio must first be connected to the PC. 
Once the radio is connected:



14 Conventional Programming Application Basics   © Copyright Tait Electronics Ltd, 2004

� select Radio>Read or

� select the Read button from the tool bar

As the programming database is read from the radio, the 
application indicates the radio type and tier, and the database, 
hardware and software version numbers. If you get an error 
indicating that the correct COM port is not selected, you can 
change the COM port by selecting the File>Preferences 
command. 

Once the radio’s programming database has been read, you 
can begin changing data. Click on the name of a form in the 
forms tree. See “The Forms Tree” on page 20 for more 
information.

Opening a Radio Programming 
Database
To open a radio programming database file saved to disk:

� select File>Open or

� select the Open button from the tool bar

Once the data has been loaded, you can begin changing data. 
Click on the name of a form in the forms tree. See “The 
Forms Tree” on page 20 for more information.

Creating a New Database
To create a new database when you first launch the applica-
tion, start changing the default data in the various forms. See 
“The Forms Tree” on page 20 for more information.

To begin a new database from an existing database, select 
File>New.

To save the database, select File>Save.
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The Application Interface

The application interface consists of:

� Menus: A series of menus along the top of the window. 
See “Menu Commands” on page 15.

� Toolbar: A series of buttons. See “The Toolbar” on page 
20.

� Forms tree: A list of forms. See “The Forms Tree” on 
page 20.

Menu Commands
The bar along the top of the main window shows the follow-
ing menus:

� File

� Radio

� Tools

� Internet

� Help

Keyboard: Select a menu by pressing the Alt key, then the 
first letter of the menu’s name. Use the up and down arrow 
keys to scroll through the list of commands, and press the 
Enter key to select a command. Select another menu using 
the left and right arrow keys. Press the Esc key to close a 
menu; the menu bar remains selected. Press the Esc key again 
to return to the main window.

Mouse: Select a menu by clicking on it, then clicking on the 
required command.

File Menu
The commands available from the File menu are: 

� New

� Open

� Save

� Printer Settings

� Print

� Preferences

� Exit

New
Selecting the File>New command loads the application’s 
default data. Warning: default data should not be pro-
grammed to a radio.
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Open
Selecting the File>Open command opens an existing file.

If a file was saved with comments, the comments will be dis-
played in the Comments window and the radio information 
will be displayed in the Radio Information window.

Save
Selecting the File>Save command opens the Save file win-
dow. If the file has not previously been saved, the application 
uses the radio’s serial number to suggest a file name.

Any comments you enter in the Comments window will be 
saved with the file, together with the information displayed 
in the Radio Information window.

Printer Settings
Selecting the File>Printer Settings command opens the Print 
Setup dialog in which you can select the printer you wish to 
print to.

Print
Selecting the File>Print command opens the Print Selections 
window. You can then select one or more forms using the > 
button (select highlighted form) or >> button (select all 
forms), and print data in those forms using the Print button.

If you wish to print data from the current form only, you can 
select the Print button at the bottom of that form.

Preferences
Selecting the File>Preferences command opens the Prefer-
ences form. The options are:

� Select Application Language

� Communication Port

� WWW Addresses

Select the Advanced button to change Advanced Options, 
which are:

� Startup Mode

� Prompt to warn about losing data on read/write

� Highlight factory only fields as they become editable

Select Application Language
Select the language the application will be displayed in. 
Changing the application language will cause the default data 
file to be loaded, so ensure you save any data files before 
changing languages.

Communication Port
Select the port used for communicating with radios.
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WWW Addresses
If you wish to change the URL used when the options in the 
Internet menu are selected, enter the new information in the 
appropriate WWW Address field.

� Tait World Address: The address used when the Inter-
net>TaitWorld command is selected

� Tait Support Address: The address used when the Inter-
net>Tait Support command is selected

� Tait Application Upgrade Address: The address used 
when the Internet>Tait Update command is selected

Startup Mode
The Startup Mode options determine whether the applica-
tion starts up in Customer or Factory mode. 

If you wish to be prompted to run in Factory mode when 
you launch the application, tick the box. If not, untick the 
box and select a Default Startup Mode. There are three 
options:

� Save On Exit: The application starts in the mode in 
which it was last running.

� Customer: The application will always start in Customer 
mode.

� Factory: The application will always start in Factory 
mode. Note that a DBYXY Security Key must be 
attached to the PC’s Parallel Port to run the application 
in factory mode.

Prompt to warn about losing data on read/write
When this option is ticked, the application will warn you 
when:

� the Radio>Read command has been selected and the 
application’s current data will be overwritten

� the Radio>Program command has been selected and a 
radio’s programming database is about to be overwritten.

If you do not wish to be warned upon selecting these com-
mands, untick this box.

Highlight factory only fields as they become 
editable
When this option is ticked, factory only fields that can be 
edited will be displayed as white text on a black background.

Exit
Selecting the File>Exit command exits the application. You 
will be asked to confirm your decision.

Radio Menu
The commands available from the Read menu are:
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� Read

� Program

Read
Selecting the Radio>Read command reads the radio’s pro-
gramming database and loads the relevant information into 
the application’s forms. If there are errors in the program-
ming database, the application will display a log of those 
errors, including the actions taken to correct the information.

Program
Selecting the Radio>Program command programs the 
radio’s programming database with the settings in the appli-
cation’s forms. 

Tools Menu
Selecting another Tait application from the Tools menu 
launches the application. If the application cannot be found, 
you will be prompted to locate the executable (*.exe) file. If 
you browse for and select a new executable file, the path for 
that application will be updated and the application will be 
launched. Next time you select that application from the 
Tools menu the new path for the executable file will be used.

The other option in the Tools menu is Radio Messages. 
Selecting the Radio Messages command opens the Radio 
Messages form. In the Radio Messages form, you can change 
the display messages that the radio is programmed with. You 
must enter a password before you can change messages. If 
you do not have a password, contact your local Tait office.

Select the language for which you wish to change messages. 
The Description field tells you where the Radio Message is 
used. Each message is restricted in length; you cannot enter 
more characters than permitted for a message.

Select the OK button to save the changed radio messages and 
exit the form or the Cancel button to discard changes and 
exit the form. Selecting the Restore Original Radio Mes-
sages button changes all radio messages to their default values.

Internet Menu
The commands available from the Internet menu are:

� TaitWorld

� Tait Support

� Tait Update

TaitWorld
Selecting the Internet>TaitWorld command launches your 
default browser and loads the TaitWorld web page. Enter the 
address used in the Preferences form (File>Preferences).
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Tait Support
Selecting the Internet>Tait Support command launches 
your default browser and loads the Tait support request web 
page. Enter the address used in the Preferences form 
(File>Preferences).

Tait Update
Selecting the Internet>Tait Update command launches your 
default browser and loads the Tait technical issues web page. 
Enter the address used in the Preferences form (File>Prefer-
ences).

If you do not have a Username and Password, contact your 
local Tait office.

Help Menu
The commands available from the Help menu are:

� Contents

� Search For Help On... 

� About

For context-sensitive help, press the F1 key.

Contents
Selecting the Help>Contents command launches the online 
help, open at the Contents tab.

Search For Help On...
Selecting the Help>Search For Help On... command 
launches the online help, open at the Search tab.

About
Selecting the Help>About command displays information 
about the application.
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The Toolbar
The toolbar commands are as follows.

The Forms Tree
The forms tree on the lefthand side of the main window lists 
the forms available. 

Two options, Selcall and Status and Channels Setup, have a 
+ beside them. Selecting either option displays additional 
forms. 

Keyboard: Scroll through the forms using the up and down 
arrow keys. Press the Enter key or the spacebar to open the 
form, or, in the case of the Selcall and Status and Channels 
Setup options, display additional forms.

Mouse: Click on the name of a form to open it and begin 
changing data, or on the Selcall and Status and Channels 
Setup options to display additional forms.

The buttons along the bottom of each form are as follows.

� OK: Saves the form data and exits the form. Pressing the 
Esc key or Alt-O also saves data and exits the form.

� Cancel: Discards any changes made and exits the form. 
Pressing Alt-C also discards changes and exits the form.

� Print: Sends data from the current form directly to the  
printer selected in Printer Settings. Pressing Alt-P also 
prints current data. If you wish to print data in other 
forms, select File>Print.

� Help: Displays online help for the form. Pressing F1 or 
Alt-H also displays online help for the form.

Opens an 
existing radio 
programming 
database file
Equivalent to the 
File>Open 
command

Prints current data
You can select the 
forms you wish to 
print data for
Equivalent to the 
File>Print 
command

Programs a radio 
with the settings 
in the 
application’s 
forms
Equivalent to the 
Radio>Program 
command

Saves the current file
If the file has not 
previously been 
saved, the 
application uses the 
radio’s serial number 
to suggest a file 
name
Equivalent to the 
File>Save command

Reads a radio’s 
programming 
database and loads 
the relevant 
information into 
the application’s 
forms
Equivalent to the 
Radio>Read 
command
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Changing Data
If a field’s data is greyed out, then that data is displayed for 
information only and cannot be changed. If a field name is 
greyed out, then that option is not available for the radio 
being programmed. For information on a field that is greyed 
out, select the Help button at the bottom of the screen, then 
select the name of the field you want information on.

Keyboard: Use the Tab key to move between fields.

Mouse: Click on a field.

How you change the data for each field depends on how that 
data is displayed. There are three options:

� text box

� combo box

� tick box

Where a range of possible numeric values is available for a 
field, then that range is shown in the bottom righthand cor-
ner of the form. 

Text Box
A text box is used for numeric and alphanumeric data.

Keyboard: Select a text box using the Tab key. Enter the 
required data.

Mouse: Select a text box by clicking on it with the mouse. 
Enter the required data.

Combo Box
A combo box is used for fields that have a range of possible 
values and appears as a box with an arrow at the righthand 
side.

Keyboard: Select a combo box using the Tab key. You can 
then display the options available by pressing the Alt key and 
the down arrow key at the same time. Use the up and down 
arrow keys to scroll through the options until the required 
value is displayed, then press the Enter key. 
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Mouse: Select a combo box by clicking on it, which displays 
the list of values. Select the required value from the combo 
box.

Tick Box
A tick box is used for fields that are either enabled or disa-
bled. If the box is ticked, the field is enabled; if the box is 
blank the field is disabled.

Keyboard: Select a tick box using the Tab key. Use the 
spacebar to enable and disable the field.

Mouse: Select a text box and change its value by clicking on 
it with the mouse.

When the field is selected, a dashed box appears next to the 
tick box.

Using Arrays
An array is used where many lines of data are required, each 
containing the same type of information. The data in an array 
is displayed in text boxes and combo boxes. Combo boxes in 
an array appear to be text boxes until they are selected, when 
an arrow appears on the righthand side.

Forms that contain arrays also contain additional buttons:

� Add: Adds a new row enabling data entry. Pressing F2 
also adds a new row.

� Insert (Channels form): Inserts a new row using the next 
available ID, then reorders all rows by ID number.

� Repeat: Duplicates the data from the selected row, giving 
it a new name.

� Delete: Removes the currently selected row of data. 
Pressing F3 also deletes the selected row.

Keyboard: Select the different fields in an array using the Tab 
key or the right and left arrow keys. Pressing the up or down 
arrow keys moves up or down a row of data.

Mouse: Click on the required field.

Copy and Paste data in the Channels 
Form
You can copy data from the Channels Form grid and paste it 
into another application. You can also copy data from a 
spreadsheet or text editor and paste it into the Channels 
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Form grid. This can be useful when you need to configure a 
number of records. Note that this functionality is available in 
the Channels Form grid only.

Clipboard data format

The clipboard data needs to be in the format used by the 
Channel Form grid.

The first row of the grid must contain all the column head-
ings: "ID", "Channel Name", "Rx Freq (MHz)", etc.

Each channel is configured on a separate row. The settings 
must be valid and should correspond to the column headings. 
The application will reset invalid fields to default values.

NOTE: In a spreadsheet, each field should appear in a unique 
cell. If you use a text editor, separate rows by carriage returns 
and columns by tabs. 

How to Copy and Paste

You must access the Cut, Copy, Paste and Select All options 
by right clicking inside the form. There are no key-stoke 
combinations available.

How to copy from the grid
1. Click on the channel that you want to copy.

To select additional channels, hold down the control or 
shift key and select the channels. 

To select all the channels, right click inside the Channels 
Form grid and select Copy All from the pop-up menu.

2. Right click on the selection. Select Copy from the pop-
up menu

How to paste data into the grid
1. Right click inside the Channels Form grid. Select Paste 

from the pop-up menu.

NOTE: If a channel that is being pasted has a unique ID, it 
will be added to the list. If the channel ID is already in use, 
that channel will be overwritten by the new data.
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Part 2: Basic Radio Settings
This part contains detailed information on changing basic radio set-
tings.

Forms

� Specifications Form

� Subaudible Signalling Setup Form

� Receive Monitoring Form

� Transmitter Setup Form
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Specifications Form

The Specifications form shows basic radio information such 
as the radio model and the frequency band. You can also set 
various radio interface options in this form, including the 
power-up message, the security PIN and the radio message 
language. The Specifications form is shown below.

Radio Model Information
The radio model information fields show the radio product 
code and information contained in the product code (e.g. 
TOP-H2210) that is particularly relevant to radio program-
ming.

You cannot directly modify the Product Code field. How-
ever, if you change Band and/or Model, Product Code is 
updated to reflect the new values. Fields that are not relevant 
to the different Band and/or Model are automatically set to 
their default values.

You may wish to read data from a radio of a different type 
and use the settings as a template for programming radios of 

frequency band

model (Orca Elan/Excel/Eclipse/5010/5015/5020)

radio variant (conventional/trunked)

bandwidth (universal/wide)

TOP-H2210
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another variant. If so, change the values of Band and/or 
Model after loading the template file but before changing any 
other radio settings.

Product Code
The Product Code field is automatically read from the radio’s 
memory and shows the radio’s model number, which you 
can find on the back of the radio. However, if the radio has 
been upgraded, the model number on the back of the radio 
will not match that read from the radio.

Band
The Band field sets the frequency band the radio operates at 
and is indicated by the fourth position (first after the hyphen) 
in the Product Code number.

This letter indicates the frequency band as outlined in the 
table on the right. 

The Band field must be set correctly in order to validate 
channel settings, and changing the value of Band will:

� amend the Product Code field to reflect the different fre-
quency band

� set the values of Rx and Tx Frequencies (Channels form) 
to 0, as any frequency values previously entered are 
invalid for the new Band

Model
The Model field indicates the radio model, which is indi-
cated by the sixth position (third after the hyphen) of the 
product code.

1 = Orca Elan

2 = Orca Excel

3 = Orca Eclipse

4 = Orca 5010

6 = Orca 5020

7= Tait Radio Modem

8= Orca 5015

Note: Contact your local Tait 
office for information on the 
availability of different frequency 
bands.

Band Frequency Range

A 66-88 MHz

B 136-174 MHz

C 174-225 MHz

D 220-270 MHz

E 270-310 MHz

F 290-340 MHz

G 336-400 MHz

H 400-470 MHz

I 450-530 MHz

J 806-870 MHz

K 896-941 MHz

frequency band

TOP-H2210

radio model

TOP-H2210
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The Model field must be set correctly as not all programma-
ble features are available for all radio models. Changing the 
value of Model will:

� amend the Product Code field to reflect the different 
model

� make selectable fields relevant to the new Model that 
were greyed out for the previous Model

� grey-out fields not relevant to the new Model

Radio Serial Number
The Radio Serial Number is automatically read from the 
radio’s memory. It is used for identification only and so the 
data in the field is greyed out. The Radio Serial Number has 
no effect on the normal operation of the radio.

User Security PIN
The User Security PIN field does not apply to Orca Elan and 
Orca 5010 radios. 

User Security PIN sets the PIN number the user is required 
to enter during the power-up sequence. Enter a number up 
to five digits long, or NONE if no PIN number is required.

Power-up Message
The Power-up Message fields set the power-up message, 
which can be up to 24 characters chosen from:

A to Z 0 to 9 ! @ # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , 
. _ " ’ space

Enter up to 12 characters in each box, including leading 
spaces if you want the message to be centred. 

Although Orca Elan and Orca 5010 radios do not display a 
power-up message, the Power-up Message fields can be pro-
grammed as an aid to identifying radios.

Radio Message Language
The Radio Message Language field does not apply to Orca 
Elan or Orca 5010 radios.

The Radio Message Language field sets the language radio 
messages appear in. Select from the languages listed.

Default Mode
The Default Mode field sets the mode the radio reverts to at 
power up and after 10 seconds of no user activity. The modes 
available and the radios they are available on are outlined in 
Table 1 on page 30. 

security PIN

A security PIN (personal identifica-
tion number) is a number up to five 
digits long the user is required to enter 
when the radio first powers up. When 
a security PIN is required, the radio 
displays the message ENTER 
CODE and then waits for the correct 
PIN to be entered before displaying 
the power-up message.The radio can-
not be used until the correct PIN has 
been entered.

power-up message

The power-up message is the message 
displayed after the radio is turned on.
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If Default Mode is set to NONE, the radio powers up in the 
mode selected when the radio was last on. 

List Operations
The List Operations field does not apply to Orca Elan and 
Orca 5010 radios.

The List Operations field determines the behaviour of scroll-
ing lists. There are two options.

� Wrap Around: The list is treated as a continuous loop, 
with the first and last entries adjacent. The next entry dis-
played after the last is the first, and vice versa.

� Stop at End of List: The list movement stops when the 
first or last entry is reached. 

The setting of List Operations does not apply to volume 
selection, which is always Stop at End of List.

Table 1: Default modes available for Tait Orca conventional radios

Option Elan Excel Eclipse 5010 5015 5020 Description

Channel � � � � � � Channel Entry Mode. In channel entry mode, 
or channel selection mode, the user can 
change to a different channel or scan group. 
Channel entry mode is automatically available 
on all radios.

DTMF ✗ � � ✗ � � DTMF Dialling Mode. In DTMF dialling mode, 
the user can dial DTMF strings. DTMF dialling 
mode is available when the Manual DTMF 
Dialling field in the DTMF form is enabled.

Selcall ✗ � � ✗ � � Selcall Dialling Mode. Using Selcall dialling, 
the user can dial Selcall sequences using the 
keypad.

Status ✗ ✗ � ✗ ✗ � Status Entry Mode. In status entry mode, the 
radio user can change the status to reflect 
their current activity. The corresponding sta-
tus digit is sent with Selcall sequences that 
include a variable status.

Alpha 
Symbol

✗ ✗ � ✗ ✗ � Alphanumeric Entry Mode. In alphanumeric 
entry mode, the user can select and execute 
up to 20 alpha symbols.

Menu ✗ ✗ � ✗ ✗ � User Function Menu Entry Mode. In user 
function menu entry mode, the user can cus-
tomise radio options. For Orca Eclipse radios, 
the user defined menu is set up in the User 
Selectable Parameters Form. For Orca 5020 
radios, the user defined menu is set up in the 
User Defined Menu Form.

None � � � � � � No Default Mode. When no default mode has 
been programmed, the radio powers up in 
the mode selected when the radio was last 
on.
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Channel Entry Lock
The Channel Entry Lock field applies to Orca Excel, Orca 
5015 and Orca 5020 radios.

Channel entry lock prevents the user from selecting a new 
channel from the keypad when a valid channel has already 
been selected from the 16-way selector. When the user tries 
to enter a new channel, the radio gives a long, low-pitched 
beep to indicate that the action is invalid. 

If channel entry lock is enabled, the radio user needs to 
change to a position on the 16-way selector for which no 
channel or scan group has been programmed in order to 
select a channel from the keypad. If channel entry lock is 
enabled and you wish the user to be able to select channels 
greater than 16 from the keypad, be sure to leave at least of 
one of positions 1 to 16 blank.

Channel Reversion Timer
The Channel Reversion Timer field applies only to Orca 
Excel, Orca 5015 and Orca 5020 radios. Set the channel 
reversion timer to a time from 10 to 250 seconds in steps of 
one second.

You can also set this field to 0, which disables the channel 
reversion timer. Disabling the channel reversion timer is not 
recommended since it may cause confusion for the user as the 
channel the radio is on does not always correspond to that 
indicated by the 16-way selector. 

Default Microphone
The setting of the Default Microphone field determines 
which microphone operates during normal operation. Select 
Top or Bottom. While the radio is in handset mode, the bot-
tom microphone operates, regardless of the setting of this 
field.

If the radio being programmed is not capable of supporting 
this feature, the Default Microphone feature is set to Bottom 
when the radio is programmed. Radios with a blue function 
key 1 support this feature.

Received Signal Tracking
The Received Signal Tracking field sets the received signal 
tracking option. 

It is recommended that this feature only be enabled when 
operating universal band radios on a wideband system and 
where there is noticeable distortion in the received audio due 
to a frequency offset in the received signal. Enabling received 
signal tracking improves the quality of the received audio by 
allowing the radio to track directly onto the received fre-
quency.

16-way selector

The 16-way selector is the larger of the 
two switches on the top of Orca Elan, 
Orca Excel, Orca 5010, Orca 5015 
and Orca 5020 radios. Each position 
on the 16-way selector can denote a 
channel or a scan group.

channel reversion timer

The channel reversion timer deter-
mines how long the radio remains on 
a channel selected from the keypad 
after a period of inactivity. When the 
channel reversion timer expires, the 
radio reverts to the channel indicated 
by the position of the 16-way selector.

handset operation

Tait Orca radios can be operated as a 
normal radio where the user holds the 
radio with the microphone about 15 
cm away from the mouth or it can be 
operated like a telephone handset. 
Handset mode is useful in noisy envi-
ronments, when privacy is required or 
in quiet environments when the lowest 
volume setting seems too loud.

received signal tracking

Received signal tracking eliminates 
any frequency offset between the 
incoming signal and the radio’s 
receiver, making the radio more toler-
ant of frequency errors in other radios.
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If the radio being programmed is not capable of supporting 
this feature, it is disabled when the radio is programmed.
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Subaudible Signalling Setup Form

The fields in the Subaudible Signalling Setup form determine 
settings for CTCSS and DCS transmissions. CTCSS and 
DCS for individual channels are set in the Channels form 
(Rx and Tx Signalling fields). The Subaudible Signalling 
Setup form is shown below. 

For more information on subaudible signalling, see:

� “Squelch and Signalling: Filtering Out Unwanted Noise 
and Traffic” on page 145

� “Signalling” on page 146

Rx CTCSS/DCS Filter Enabled For
The Rx CTCSS/DCS Filter Enabled For field determines 
the settings for the radio’s CTCSS/DCS filter. The filter can 
be automatically switched off for channels that do not have 
CTCSS or DCS.

� All: The filter is active on all channels, regardless of 
whether they are programmed with CTCSS or DCS.

� CTCSS/DCS: The filter is active only on channels that 
have CTCSS or DCS programmed for the receive fre-
quency.

Tx DCS Polarity
The Tx DCS Polarity field sets the polarity of all transmitted 
DCS codes defined in the Channels form. Some systems 
require the DCS code to be inverted when transmitted. 
Select Normal or Inverted.

CTCSS/DCS filter

The CTCSS/DCS filter removes 
any CTCSS or DCS tones that may 
be present on the received audio. The 
filter limits the range of frequencies the 
radio passes from the incoming signal 
to the speaker and so in some situa-
tions affects signal quality. Filtering 
can be automatically switched off for 
channels that do not have CTCSS or 
DCS.

DCS polarity

DCS signals are susceptible to polar-
ity inversion at various points in the 
signal path from originator to recipi-
ent. On some systems, consistent 
inversions can be compensated for by 
forcing the radio to decode the inverse 
of every codeword.
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Rx DCS Polarity
The Rx DCS Polarity field sets the polarity of all received 
DCS codes defined in the Channels form. Select Normal or 
Inverted.

Reverse Tone Burst Duration
The Reverse Tone Burst Duration field specifies how long a 
CTCSS reverse tone burst is transmitted. Reverse tone burst 
transmission increases the speed of receiver shutdown in 
some repeaters and associated equipment.

Set a value from 0 to 250 ms in steps of 1 ms. Setting this field 
to 0 disables reverse tone burst transmission.

The recommended value is 130 ms, which works for all 
CTCSS tones between 67.0 and 250.3 Hz. It should not be 
necessary to deviate from 130 ms unless your system has spe-
cific requirements.

Subaudible Signalling for Rx Gate
The Subaudible Signalling for Rx Gate field applies to the 
Tait Radio Modem only. 

Subaudible Signalling for Rx Gate determines whether the 
radio should detect valid subaudible signalling before the Rx 
Gate line is asserted. If checked, valid subaudible signalling 
must be detected before the Rx Gate line is asserted. If 
unchecked, the Rx Gate line is set to an asserted state based 
on squelch only. 

reverse tone burst

Reverse tone bursts can be used when 
CTCSS subaudible signalling is 
used. When reverse tone bursts are 
enabled, the phase of the generated 
tones is reversed for a number of cycles 
just before transmission ceases, which 
can increase the speed of receiver shut-
down in some repeaters and associated 
equipment. The phase reversal occurs 
after any ANI transmission.
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Receive Monitoring Form

The fields in the Receive Monitoring form set properties 
related to the operation of the radio’s monitor function. Four 
other fields specific to Selcall affect monitor:

� Third Tone Monitor Reset and Appended C Tone 
Monitor Reset in the Selcall Features form

� RMR Sequence and Selcall Muting in the Selcall Iden-
tity (Rx) tab.

The Receive Monitoring form is shown below.

For more information on monitor, see:

� “Monitor: Listening In On Channel Traffic” on page 148

Monitor Function Disables
The Monitor Function Disables field determines whether 
monitor disables the Selcall signalling mute or the Selcall sig-
nalling mute and the subaudible signalling mutes. 

� All Mutes: Both the Selcall signalling mute and the sub-
audible signalling mute (CTCSS and DCS) are disabled 
when monitor is activated. The radio user is able to hear 
all traffic. 

� Selcall Mute: Only the Selcall signalling mute is disabled 
when monitor is activated. The radio user only hears traf-
fic that has valid subaudible signalling.

monitor

Monitor allows the radio user to over-
ride a channel’s signalling and so hear 
all traffic on a channel. Note that 
monitor is not permitted in some coun-
tries.

mute

A mute controls the circumstances 
under which a received signal is passed 
to the radio’s speaker. When a mute 
is active, the radio’s speaker only 
unmutes under certain conditions, 
determined by the type of signalling 
operating on a channel.
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Auto Quiet Time
The Auto Quiet Time field sets the duration of the auto 
quiet timer. When the programmed duration of the auto 
quiet timer expires, monitor deactivates and the radio 
resumes quiet operation. Enter a value between 1 and 255 
seconds in steps of 1 second, or 0 to disable the auto quiet 
timer.

Auto Quiet Timer Countdown
The Auto Quiet Timer Countdown field determines 
whether the auto quiet timer resets or continues its count-
down after being suspended.

� Continuous: The auto quiet timer resumes from the 
point at which it was suspended.

� Reset: The auto quiet timer resets to its programmed 
value (Auto Quiet Time field) and begins counting down 
once again.

Monitor State at Power Up
The Monitor State at Power Up field determines whether 
monitor is inactive or active when the radio is turned on. 

� Active: Monitor is activated when the radio is turned on.

� Inactive: Monitor is not activated when the radio is 
turned on.

Monitor with Call Setup
The Monitor with Call Setup field determines whether 
monitor is activated when an outgoing Selcall call is made. 

� Enabled: Monitor is activated when a Selcall call is suc-
cessfully sent.

� Disabled: The radio can transmit Selcall calls without 
activating monitor. Monitor must be activated via 
another method before communication commences.

Selcall must be enabled (Enable Selcall field, Selcall Identity 
(Rx) tab) before this field can be enabled.

Monitor with Call Received
The Monitor with Call Received field determines whether 
monitor is activated when a Selcall call is received that 
matches one of the radio’s RxDecode sequences and has no 
control status attached.

� Enabled: Monitor activates upon the receipt of an appro-
priate Selcall call.

� Disabled: The radio user has to press a radio key to 
answer the call before monitor is activated.

auto quiet timer

The auto quiet timer determines how 
long monitor remains active. The auto 
quiet timer is suspended while the 
radio is transmitting or while there is 
valid activity on a channel. Once a 
transmission is complete or when the 
radio is switched to another channel, 
the auto quiet timer either begins 
counting down once again (continu-
ous) or resets to the programmed dura-
tion of the auto quiet timer (reset).

Rx decode sequence

The Rx decode sequence is the radio’s 
unique identity on a Selcall system. 
When the radio’s Rx decode sequence 
is decoded as the receiver identity in an 
incoming Selcall sequence, the radio 
recognises the sequence as intended for 
it and responds appropriately.
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[MON] Key Short Press
The [MON] Key Short Press field applies only to Orca 5015, 
Orca Excel and Orca Eclipse radios.

� Enabled: A brief press of the monitor key toggles monitor 
on and off.

� Disabled: A brief press of the monitor key only disables 
monitor.

[MON] Key Long Press
The [MON] Key Long Press field applies only to Orca 5015, 
Orca Excel and Orca Eclipse radios.

When [MON] Key Long Press is enabled, a long press of the 
monitor key activates the squelch override function. This can 
be useful where there is activity in marginal areas and the sig-
nal is too weak to be reliably heard. 

If squelch override is already active when the monitor key is 
pressed, then squelch override is deactivated and monitor is 
activated.

Audio Noise Reduction
The Audio Noise Reduction field applies only to Orca 5010, 
Orca 5015 and Orca 5020 radios.

When the Audio Noise Reduction field is checked, weak 
signals such as background noise are reduced when the mute 
is open and nobody is talking on the channel. This applies to 
all channels. 

squelch override

Squelch override allows the user to dis-
able the radio’s squelch and so hear all 
activity on a channel, including noise.
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Transmitter Setup Form

Transmitter options are set in the Transmitter Setup form. 
The Transmitter Setup form is shown below. 

Transmit Timer Duration
The Transmit Timer Duration field sets the duration of the 
transmit timer. Enter a value between 1 and 250 seconds in 
steps of 1 second, or 0 to disable the transmit timer. How-
ever, it is recommended that you do not disable the transmit 
timer as frequent lengthy transmissions, whether intentional 
or accidental, could damage the radio’s transmitter and can 
be a nuisance to others. The recommended value is 60 sec-
onds.

Once the transmit timer expires, the radio may be prevented 
from transmitting for the duration of the transmit lockout 
timer, which is set in the Transmit Lockout Duration field.

Transmit Lockout Duration
The Transmit Lockout Duration field sets the duration of the 
transmit lockout timer. Enter a value between 1 and 250 sec-
onds in steps of 1 second, or 0 to disable the transmit lockout 
timer. The recommended value is 10 seconds for the Tait 
Radio Modem, and 30 seconds for all other radios.

Tx Inhibit
The Tx Inhibit field sets the transmit inhibit conditions. 
There are three options:

transmit timer

The transmit timer determines the long-
est continuous transmission permitted 
by a radio. When the transmit timer 
expires, the radio emits a series of warn-
ing tones before returning to the receive 
state.

transmit lockout

The transmit lockout feature prevents 
the radio from transmitting once the 
transmit timer has expired.

transmit inhibit

The transmit inhibit feature determines 
under what conditions a press of the 
PTT results in the radio not transmit-
ting.
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� None: The radio always transmits when the PTT is 
pressed, even when there is traffic on the channel.

� Busy: The radio does not transmit when the PTT is 
pressed if there is activity on the channel, whether it is 
valid or invalid.

� Mute: The radio does not transmit when the PTT is 
pressed, unless there is valid activity on the channel. If 
monitor has been activated, the radio transmits regardless 
of valid or invalid activity.

If Selcall muting has been enabled (Selcall Tone Options tab) 
for the channel’s Selcall system, then the radio user cannot 
initiate a call by pressing the PTT, regardless of the setting of 
Tx Inhibit. A Selcall call initiation (via the press of a function 
key or the call key) follows the conditions set in Tx Inhibit.

Repeater Talk Around
When the Repeater Talk Around field is enabled, a long 
press of the channel key (Orca 5015, Orca Excel and Orca 
Eclipse radios) activates repeater talkaround. This field must 
be enabled before Repeater Talk Around can be assigned to 
a function key setting (Key Settings I tab).

Selcall muting

When Selcall muting is enabled, the 
radio only unmutes when a valid Selcall 
sequence is received. The radio user 
cannot initiate calls using the PTT 
unless monitor is active, but can only 
make Selcall calls.

repeater talkaround

Repeater talk around allows the radio 
user to bypass repeater operation and so 
communicate directly with other radios. 
While repeater talk around is active, all 
transmissions are made on the receive 
frequency programmed for the channel.
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Part 3: Setting Up Channels and 
Scan Groups
This part contains detailed information on setting up channels and 
scan groups.

Forms

� Channels Form

� Channel Selection form

� Birdie Channels Form

� Scan Groups Form

� Channel Signalling Presets Form
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Channels Form

The main settings for channels are set up in the Channels 
form. The Channels form is shown below.

The Channels form contains default values for one channel. 
Select the Add button or press the F2 key to add a new chan-
nel at the end of the list, or the Insert button to insert a new 
channel then reorder all rows by ID number. Select the 
Delete button or press the F3 key to delete the currently 
selected channel, or select the Repeat button to duplicate the 
current channels settings, except for the Channel ID and 
Name. 

NOTE: You can also Copy and Paste data between the 
Channels form and a spreadsheet or text editor.

The number of channels permitted depends on the Model as 
follows:

� Orca Elan: up to 16 channels

� Orca 5010: up to 75 channels can be added, 16 of which 
can be assigned to the 16-way selector and accessed on 
the radio

� Orca Excel/Orca 5015: up to 100 channels

� Orca Eclipse/Orca 5020: up to 510 channels

The maximum number of channels possible is affected by the 
number of Selcall systems programmed. 

For more information on channels, see:

� “Squelch and Signalling: Filtering Out Unwanted Noise 
and Traffic” on page 145

channel

A channel is a pair of radio frequen-
cies, one used for transmitting and one 
used for receiving.
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Channel ID
The Chan ID field sets the channel number, which must be 
unique. Because channels and scan groups are both accessed 
the same way, no channel or group can share the same iden-
tity number. Set a Channel ID between 1 and 510.

For Orca Elan, Orca Excel, Orca 5010 and Orca 5020 radios, 
channels numbered from 1 to 16 are accessible from the 16-
way selector.

Channel Name
This field sets the channel name, which appears on the dis-
play for Orca Excel, Orca Eclipse and Orca 5020 radios, 
when the radio is in channel entry mode.

Enter a name of up to 8 characters from:

A to Z 0 to 9 ! # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , . _ 
" ’ space

Ensure that you do not allocate the same name for different 
channels or scan groups since both are accessed in the same 
way. A default name is generated from the channel ID. For 
example, the first channel defaults to CHAN1. 

Rx and Tx Frequencies
The Rx Freq (MHz) field sets the receive frequency for the 
channel, and the Tx Freq (MHz) field sets the transmit fre-
quency.

For each channel, enter a frequency within the radio’s fre-
quency band that is a multiple of either 5 kHz or 6.25 kHz. 
The letter in the fourth position (first after the hyphen) in the 
product code (see the Specifications form or the back of the 
radio) indicates the radio’s frequency band as outlined in the 
table below. 

Note that the range of frequencies permitted for bands J and 
K are different for Rx Freq (MHz) and Tx Freq (MHz).

Rx and Tx Signalling
The CTCSS/DCS Rx field sets the subaudible signalling the 
radio must receive before the activity is regarded as valid and 
the mute opened. The CTCSS/DCS Tx field sets the subau-
dible signalling that accompanies each transmission made on 
the channel.

For both fields, select the required CTCSS frequency or 
DCS code from the drop-down list. Note that when you 
select a signal from the list for CTCSS/DCS Rx, the 
CTCSS/DCS Tx field is changed to match CTCSS/DCS 
Rx. If you wish to use different transmit signalling, select the 
signal from the list. 

channel entry mode

In channel entry mode, or channel 
selection mode, the user can change to 
a different channel or scan group. 
Channel entry mode is automatically 
available on all radios.
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Leave these fields set to NONE if no subaudible signalling is 
used on the channel.

If once subaudible signalling has been assigned for a channel 
you wish to change the signalling type, first set either Rx or 
Tx Signalling to NONE, then selected the required type of 
signalling.

The tables on page 147 show the CTCSS frequencies and 
DCS codes Tait Orca radios support.

Transmit Deviation
The Tx Deviation field sets the transmitter deviation. It can 
be set to:

� Wide: maximum deviation 5 kHz

� Medium: maximum deviation 4 kHz

� Narrow: maximum deviation 2.5 kHz. This option is 
only available if the channel spacing has been set to Uni-
versal Band (see below).

Set Tx Deviation according to the system channel spacing. 
Channel spacing is indicated in the number in the fifth posi-
tion (second after the hyphen) in the product code (see the 
Specifications form or the back of the radio). 

� 1 (Wide Band): The radio can be programmed for oper-
ation on 20 and 25 kHz channels only (select a Tx Devi-
ation of Wide or Medium).

� 2 (Universal Band): The radio can be programmed for 
operation on 12.5, 20 and 25 kHz channels (select a Tx 
Deviation of Wide, Medium or Narrow).

Band
Receive Frequency 

(MHz)
Transmit Frequency 

(MHz)

A 66-88 66-88

B 136-174 136-174

C 174-225 174-225

D  220-270  220-270

E 270-310 270-310

F 290-340 290-340

G 336-400 336-400

H 400-470 400-470

I 450-530 450-530

J  851-870  806-870

K 935-941 896-941
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Power Level
The Power Level field sets the transmit power level. Select a 
power level setting within the limits permitted for the region 
in which the radio operates. 

� Off (O): When set to off, the radio cannot transmit on 
that channel.

� Low (L): 1 watt VHF, UHF, 800/900 MHz

� Medium (M): 2.5 watts VHF, UHF, 2 watts 800/900 
MHz

� High (H): 5 watts VHF, 4 watts UHF, 3 watts 800/900 
MHz

The transmit power can be temporarily reduced by use of the 
low power transmit feature, which is a way of conserving 
battery life. When low power transmit is active, all transmis-
sions are made at the low power level rather than at the pro-
grammed power level. When low power transmit is deacti-
vated, transmissions are made at the programmed power 
level.

See “Function Key Option: Low Power” on page 126 for 
more information.

Squelch Level
The Squelch Level field sets the squelch threshold. There are 
two options:

� Country: 12 dB SINAD

� City: 16 dB SINAD

Selcall System
The Selcall System field sets the Selcall system the channel 
uses. Selcall systems are set up in the Selcall Identity and 
Setup form and the number of a particular system is indicated 
by the field in the bottom lefthand corner of the Selcall Iden-
tity and Setup form. See “Selcall Identity and Setup Form” 
on page 63 for more information.

Setting Selcall ID to NONE disables Selcall for this channel.

DTMF ID
The DTMF ID field sets the DTMF preset associated with a 
particular channel. DTMF presets are defined in the DTMF 
form. Enter the DTMF ID from the DTMF Presets tab for 
the preset call string you wish to be associated with this chan-
nel. Enter NONE if you do not wish to associate any DTMF 
call string with this channel.

If a channel has a DTMF preset assigned to it, the preset can 
be transmitted by pressing an assigned function key (on all 

squelch threshold

The squelch threshold is the level the 
signal must reach before it is regarded 
as intelligible and the radio’s mute is 
opened. Tait Orca radios can operate 
at two different squelch thresholds: 
city and country squelch.

Selcall system

A Selcall system is the call sequence 
formats and tone options the radios on 
that system must use to communicate 
with one another.

DTMF preset

A DTMF preset is a string of DTMF 
tone pairs defined for a radio at pro-
gramming time.
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radios) or by pressing the DTMF key (Orca Excel and Orca 
Eclipse radios).
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Channel Selection form

The Channel Selection form determines 16-way selector 
options, such as what mode the 16-way selector will operate 
in. This form is available for Orca 5010, Orca 5015 and Orca 
5020 radios only. The Channel Selection form is shown 
below.

16-way Selector Mode
The 16-way Selector Mode field determines what action is 
assigned to the 16-way selector. There are five options. 

� Normal: Channel ID 1 is assigned to position 1 on the 
16-way selector, Channel ID 2 to position 2 and so on. 

� Disabled (Orca 5015/5020 only): The radio user cannot 
select channels using the 16-way selector. 

� Reassign: The Selector Position and Channel ID fields 
are enabled, allowing any channel to be assigned to any 
position on the 16-way selector.

� Banking - Channel Selection (Orca 5020 only): the 16-
way selector is assigned to the channel banking feature. 
Position 1 will correspond to the first channel in the cur-
rently selected bank, position 2 to the second channel and 
so on. If this option is selected, you must also enable the 
SELECT BANK user defined menu option.

� Banking - Bank Selection (Orca 5020 only): the 16-way 
selector is assigned to the channel banking feature. Posi-
tion 1 will correspond to bank 1, position 2 to bank 2 and 

channel banking

Channel banking is a feature in Orca 
5020 radios, that enables a large 
number of channels to be managed by 
dividing them into banks. How chan-
nels are assigned to banks is dependant 
on the 16-way Selector Mode setting.
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so on. Channels within a bank can be selected using the 
keypad.

Selector Position and Channel ID
This array is only available when the 16-way Selector Mode 
field is set to Reassign. The Selector Position field is a fixed 
list of each position on the 16-way selector (1 to 16). The 
Channel ID field lists all the channels defined in the Channels 
form. To assign a channel to a position on the 16-way selec-
tor, select a different channel next to that position from the 
Channel ID combo box.
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Birdie Channels Form

Birdies are identified in the Birdie Channels form. The 
Birdie Channels form is shown below.

A birdie channel is a channel on which the receiver sensitiv-
ity is degraded by internal interference. This interference 
usually manifests itself as a hum or whistle (a birdie). A birdie 
killer is the internal circuitry that when enabled eliminates 
the birdie.

To set a birdie killer for a channel:

1. Select the Add button or press the F2 key.

2. Enter the afflicted channel’s channel ID in the Channel 
ID box.

To delete a birdie, select the Delete button or press the F3 
key.

If a channel the radio software identifies as having a birdie is 
added to the birdie channels list, the birdie killer is disabled 
for that channel.
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Scan Groups Form

Scanning and voting groups are set up in the Scan Groups 
form. The Scan Groups form is divided into three tabs:

� Set general scanning and voting rules in the Scan Groups 
tab.

� Set up scanning and voting groups in the Scan Group 
Members tab.

� Set a Flexiscan scan group in the Flexiscan tab (Orca 
5010/5015/5020 radios only).

For more information on scanning and voting groups, see:

� “Introduction to Scan Groups” on page 148

Scan Groups Tab
Set general scanning and voting rules in the Scan Groups tab. 
The Scan Groups tab is shown below.

Hidden Channels
Scan groups contain anywhere from 2 to 16 channels, and 
normally these channels can also be accessed individually. 

When the Hidden Channels field is enabled, channels that 
are assigned to a scan group are hidden from the user and so 
cannot be selected individually. This setting has the effect of 
making a group of channels appear as one channel. If you 
wish to access channels via groups and individually, disable 
the Hidden Channels field.

flexiscan

When Flexiscan scanning is turned 
on, a group of channels in a prepro-
grammed Flexiscan scan group is 
scanned for valid activity, while the 
radio user is able to communicate on 
an unrelated channel.
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Fast CTCSS Decode Override
When this field is enabled, the radio overrides fast CTCSS 
decoding. Fast CTCSS decode override should only be ena-
bled when a channel containing an incorrect subaudible fre-
quency is being captured by the radio.

PTT Release Voting Request
When the PTT Release Voting Request field is enabled, the 
voting sequence is initiated whenever the PTT key is 
released.

Group Hold Time
The Group Hold Time field specifies the pause before scan-
ning resumes once valid channel activity has ceased. 

Enter a time between 0 and 25,000 ms in steps of 100 ms. If 
set to 0, the hold timer is disabled regardless of channel activ-
ity and scanning resumes immediately after a channel 
becomes invalid, which would not allow for any pauses in a 
conversation.

Voting Lead In Delay
The Voting Lead In Delay field sets the delay between the 
radio detecting activity on a channel in a voting group and 
voting taking place. The voting lead in delay gives the 
repeaters in the system time to come to full power.

Enter a value between 0 and 2550 ms in steps of 10 ms.

Voting Polling Interval
The Voting Polling Interval field sets the time between votes 
when channels are carrying invalid activity. Enter a value 
between 1 and 250 seconds in steps of 1 second.

Priority Sample Timers
The priority sample timers determine how often a priority 
channel is scanned in preference to other channels in a scan 
group.

� Non-Captured Priority Sample Timer: Applies when no 
channel has been captured.

� Captured Priority Sample Timer: Applies when a chan-
nel has been captured.

For both timers, set a value from 500 to 5000 ms in steps of 
100 ms. 

In some systems, setting the priority sample timers too low 
interferes with Selcall decoding and in such cases you should 
not set these timers lower than the default values of 3000 ms 
(Captured) and 1500 ms (Non-Captured).

voting

Voting is the systematic sampling of a 
group of channels (a scan group) for the 
channel with the greatest signal 
strength. There are three variations of 
normal voting: voting with signalling, 
double voting and double voting with 
signalling.
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Scan Group Members Tab
Scanning and voting groups are set up in the Scan Group 
Members tab. The Scan Group Members tab is shown 
below.

Select the Add button or press the F2 key to add a scan 
group, select the Delete button or press the F3 key to delete 
the currently selected scan group, or select the Repeat button 
to duplicate the current scan group’s Group Type and User 
fields and the Group Membership List. 

� On Orca Elan and Orca 5010 radios, up to 16 scan groups 
can be defined. 

� On Orca Excel, Orca Eclipse, Orca 5015 and Orca 5020 
radios, up to 20 scan groups can be defined.

When a scan group is added, group members 1 and 2 are set 
to NONE.

Group ID
The ID field sets the group number, which must be unique. 
Because channels and scan groups are both accessed the same 
way, no channel or group can share the same identity 
number. Set an ID between 1 and 510.

For Orca Elan, Orca Excel, Orca 5010, Orca 5015 and Orca 
5020 radios, groups numbered from 1 to 16 are accessible 
from the 16-way selector.

Group Name
The Name field cannot be edited for Orca Elan and Orca 
5010 radios. 
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This field sets the group name, which is displayed when the 
radio is in channel entry mode. Enter a name of up to 8 char-
acters from:

A to Z 0 to 9 ! # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , . _ 
" ’ space

Ensure that you do not allocate the same name for different 
channels or scan groups since both are accessed in the same 
way. A default name is generated from the group ID. For 
example, if three channels are defined, then the first scan 
group defaults to GROUP4. 

Group Type
The Type field sets the type of scanning/voting used for the 
group. The options available are:

� Scanning (S)

� Priority Scanning (PS)

� Dual Priority Scanning (DPS)

� Voting (V)

� Voting With Signalling (VS)

� Double Voting (DV)

� Double Voting With Signalling (DVS).

See pages 149 and 151 for descriptions of the different group 
types.

User
The User field applies only to Orca Eclipse and Orca 5020 
radios and determines whether the scan group can be repro-
grammed by the radio user. 

� Yes: The radio user can reprogram the group.

� No: The scan group can only be changed by reprogram-
ming the radio.

Group Membership List
Member channels are added to scan groups in the group 
membership list.

Enter a valid channel ID. There must be at least two and no 
more than 16 entries for each scan group, and a channel can 
appear in a particular scan group only once. There can be no 
gaps in the list of member channels.

If you have used the DOS-based Programming System for 
Tait Orca Radios, note that it is not necessary to press the F4 
key to add a new member channel; simply enter the chan-
nel’s channel ID.

For scanning groups (Group Type S, PS or DPS), the first 
channel in the group membership list is the home channel. 
For priority scanning (PS), the first channel is the priority 



© Copyright Tait Electronics Ltd, 2004  Scan Groups Form 55

channel. For dual priority scanning (DPS), the first and sec-
ond channels are the priority channels, and the first channel 
listed has higher priority than the second.

For voting groups (V, VS, DV and DVS), the first channel in 
the group membership list is the home channel if no other 
channel has been voted as the home channel.

Flexiscan Tab
Set Flexiscan options in the Flexiscan tab (Orca 5010/5015/
5020 radios only). The Flexiscan tab is shown below.

Flexiscan Type
The Type field sets the type of scanning used for the 
Flexiscan group. The options available are:

� Non-Priority Scan: There is no priority scan channel.

� Priority Scan: The first member channel is designated the 
priority channel, which is scanned more often than the 
other member channels.

� Dual Priority Scan: The first member channel is desig-
nated the first priority channel and the second member 
channel is designated the secondary priority channel. 
These priority channels are scanned more frequently than 
the other member channels.

Flexiscan Tx Channel Select
The Flexiscan Tx Channel Select field determines the trans-
mission channel.

� Selected: The radio transmits on the channel that was 
selected prior to Flexiscan being activated.
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� Scanned: The radio transmits on the channel that it last 
received on, prior to valid activity being detected on a 
Flexiscan member channel and before the Group Hold 
Time has expired.

Scan After PTT
Orca 5015/5020 radios only.

The Scan After PTT field determines the behaviour of the 
radio when Flexiscan is active and the PTT key is pressed.

� Checked: Scanning stops when the PTT key is pressed 
but resumes once the PTT key is released and the Group 
Hold Time expires.

� Unchecked: A press of the PTT disables Flexiscan.

User Programmable Flexiscan
Orca 5015/5020 radios only.

When User Programmable is checked, the scan group can be 
reprogrammed by the radio user. Flexiscan programming 
mode is activated by one of the radio function keys, assigned 
in the Key Settings form.

Scan With Subaudible signalling
The Scan With Subaudible signalling field determines the 
behaviour of the radio when activity is detected on a member 
channel.

� Checked: Scanning only halts on a channel if there is 
valid subaudible signaling present on the channel. Once 
this field is enabled, the Scan Priority Channels With 
Subaudible signalling field becomes accessible.

� Unchecked: Scanning halts on any member channel, 
whether valid subaudible signalling is present or not.

Scan Priority Channels With Subaudible 
signalling
The Scan Priority Channels With Subaudible signalling field 
determines the behaviour of the radio when activity is 
detected on a priority channel.

� Checked: Scanning only halts on the priority channel if 
there is valid subaudible signaling present. If the subaudi-
ble signalling is invalid, scanning resumes.

� Unchecked: Scanning halts on a priority channel when 
there is activity, but the radio remains muted unless there 
is valid subaudible signalling present.

This field is only available if the Scan With Subaudible sig-
nalling field is checked.
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Priority Scan Count
The Priority Scan Count field determines the priority chan-
nel sample time intervals. The priority scan count is used to 
modify the times set in the Priority Sample Timers fields. 
Enter a number between 1.00 and 4.00 in steps of 0.25.

This field is only available if the Scan Priority Channels With 
Subaudible signalling field is checked.

Flexiscan Member Channels
Member channels are added to the Flexiscan scan group in 
the Member Channels fields. Enter at least two valid channel 
identities in these fields. A channel can only be entered once 
and there can be no gaps in the member channels list.

If the Flexiscan Type field is set to Priority Scan or Dual Pri-
ority Scan, then the first member channel is the highest pri-
ority channel (P1). If Dual Priority Scan is selected, then the 
second member channel is the next highest priority channel 
(P2).
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Channel Signalling Presets Form

The Channel Signalling Presets form defines the signalling 
pairs the radio user selects from when using the programma-
ble channel signalling feature. Programmable channel signal-
ling is available only on Orca Eclipse and Orca 5020 radios. 
The Channel Signalling Presets form is shown below.

Select the Add button or press the F2 key to add a new sig-
nalling pair, select the Delete button or press the F3 key to 
delete the currently selected signalling pair, or select the 
Repeat button to duplicate the current signalling pair’s 
receive and transmit signalling.

Up to 20 signalling pairs can be defined.

Preset Label
The Preset Label field sets an alphanumeric name to label 
each pair of Tx/Rx signalling codes. Each label must be 
unique. Enter a name of up to 8 characters from: 

A to Z 0 to 9 ! # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , . _ 
" ’ space

Rx/Tx Signalling
The Rx and Tx Signalling fields set the subaudible signalling 
that is associated with a channel when the signal pair is 
selected.

The Rx Signalling field sets the subaudible signalling the 
radio must receive before the activity is regarded as valid and 
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the mute opened. The Tx Signalling field sets the subaudible 
signalling that accompanies each transmission made on this 
channel.

For both fields, select the required CTCSS frequency or 
DCS code from the drop-down list. Note that when you 
select a signal from the list for Rx Signalling, the Tx Signal-
ling field is changed to match Rx Signalling. If you wish to 
use different transmit signalling, select the signal from the list. 
However, you cannot mix CTCSS and DCS on a channel.

Leave these fields set to NONE if no subaudible signalling is 
used. 

If once subaudible signalling has been assigned for a signalling 
pair you wish to change the signalling type, first set either Rx 
or Tx Signalling to NONE, then selected the required type 
of signalling.

The tables on page 147 show the CTCSS frequencies and 
DCS codes Tait Orca radios support.
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Part 4: Setting Up Selcall
This part contains detailed information on setting up Selcall.

Forms

� Selcall Identity and Setup Form

� Selcall Features Form

� Selcall Emergency Setup Form

� Selcall Rx Decode Setup Form

� Selcall Control Status Definitions Form

� Custom Selcall Tone Set Form
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Selcall Identity and Setup Form

Selcall systems are set up in the Selcall Identity and Setup 
form, which is divided into three tabs:

� Selcall Identity (Rx) tab

� Selcall Sequences (Tx) tab

� Selcall Tone Options tab

The Selcall Identity and Setup form is shown below, with the 
Selcall Identity (Rx) tab selected. 

In addition to the standard set of buttons at the bottom of 
each form, there is an additional row of buttons. The func-
tions of these buttons are as follows:

� <<: Switches to the first Selcall system

� <: Switches to the previous Selcall system

(Number of current Selcall system)

� >: Switches to the next Selcall system

� >>: Switches to the last Selcall system

� Add: Adds a new Selcall system with default values

� Repeat: Duplicates the settings of the current Selcall sys-
tem (all Selcall Identity and Setup form fields)

� Delete: Deletes the current Selcall system

For more information on Selcall, see:

� “Selcall Systems: Transmit and Receive Formats” on 
page 154

� “Selcall Tone Transmission” on page 157
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Selcall Identity (Rx) Tab
The transmit and receive formats are defined in the Selcall 
Identity (Rx) tab, together with sequences the radio responds 
to. The Selcall Identity (Rx) tab is shown below.

Enable Selcall
The Enable Selcall field must be enabled before any Selcall 
systems can be defined. Until this field is enabled, only one 
form is listed under Selcall and Status in the forms tree.

Tx Format
The Tx Format field defines the transmit format. Five char-
acters are used to define the transmit format.

� B: repeater identity (optional)

� R: receiver identity (required)

� C: caller identity (optional)

� S: status (optional)

� -: gap (optional)

Each burst can consist of up to eight tones and tone bursts 
should be separated by a gap burst. There can be no more 
than eight gaps in any one gap burst, and the sequence cannot 
start or end with a gap burst. If defined, each element (e.g. 
receiver identity) should be defined sequentially.

If the repeater identity is defined, it must come first in the 
sequence. If status is defined, it must be last in the sequence 
and can only contain one or two characters. Some systems 
require at least two gaps before status if a single status digit is 
used.

transmit (Tx) format

The transmit format defines the format 
all outgoing Selcall sequences must fol-
low in order to be correctly decoded by 
other radios using the same Selcall sys-
tem. The transmit format should be 
the same for all radios using a particu-
lar Selcall system. 

burst

A burst is a series of tones (a tone 
burst) or gaps (a gap burst) in a Selcall 
sequence. 
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See “The Transmit Format” on page 154 for more informa-
tion on defining a transmit format.

Rx Format
The Rx Format field defines the receive format. Four char-
acters are used to define the receive format.

� R: receiver identity (required)

� C: caller identity (optional)

� S: status (optional)

� -: gap (optional)

Each burst can consist of up to eight tones and tone bursts 
should be separated by a gap burst. There can be no more 
than eight gaps in any one gap burst, and the sequence cannot 
start or end with a gap burst. If defined, each element (e.g. 
receiver identity) should be defined sequentially.

If status is defined, it must match the status burst in the trans-
mit format (see “Tx Format” on page 64).

See “The Receive Format” on page 155 for more informa-
tion on defining a receive format.

Rx Decode Sequences
Two Rx decode sequences can be defined for each Selcall 
system the radio operates on. At least one of the Rx Decode 
Sequence fields must be set, and the sequence entered must 
match the R burst (receiver identity) in the Selcall system’s 
receive format (Rx Format field).

Use characters 0 to 9, A to D, F and V. V acts as a wildcard 
tone and so is equivalent to all other tones. If the second Rx 
decode sequence is not required, set it to NONE.

See “Defining the Radio’s Identity” on page 157 for more 
information.

RMR Sequence
The RMR Sequence field sets the Selcall sequence that, 
when received, deactivates monitor and squelch override, 
and clears down emergency cycling.

If defined, the sequence entered must match the R burst 
(receiver identity) in the Selcall system’s receive format (Rx 
Format field). Use characters 0 to 9, A to D, F and V or set 
the sequence to NONE. V acts as a wildcard tone and so is 
equivalent to all other tones. 

Normally the remote monitor reset sequence’s R burst 
should not match either of the Rx decode sequences.

Selcall Muting
The Selcall Muting field enables the Selcall signalling mute. 

receive (Rx) format

The receive format defines the format 
all incoming Selcall sequences must 
follow in order to be correctly decoded 
by the receiving radio. The receive for-
mat should be the same for all radios 
using a particular Selcall system. 

Rx decode sequence

The Rx decode sequence is the radio’s 
unique identity on a Selcall system. 
When the radio’s Rx decode sequence 
is decoded as the receiver identity in an 
incoming Selcall sequence, the radio 
recognises the sequence as intended for 
it and responds appropriately. 

monitor

Monitor allows the radio user to over-
ride a channel’s signalling and so hear 
all traffic on a channel. 
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� Enabled: The radio remains quiet until a valid Selcall 
sequence is received and the radio user cannot initiate 
calls using the PTT without first disabling the Selcall 
mute by activating monitor. The radio user can still make 
Selcall calls via a function key or the call key.

� Disabled: The radio user hears all Selcall activity on the 
channel regardless of whether monitor is active or inac-
tive.

If Selcall muting is enabled, presses of the PTT do not result 
in the radio transmitting unless monitor has been activated 
and the Selcall mute disabled. For this reason, if Selcall mut-
ing is enabled, it is important to also enable the Monitor with 
Call Setup field (Receive Monitoring form). When Monitor 
with Call Setup is enabled, the radio user is able to initiate a 
call via a function key or the call key and monitor is automat-
ically activated.

Selcall Sequences (Tx) Tab
Common transmitted Selcall sequences are set in the Selcall 
Sequences (Tx) tab. The Selcall Identity (Tx) tab is shown 
below.

Fixed Call Sequence
If the fixed call sequence is defined, an R burst (TxCall field) 
must be set and the S, B and C bursts are optional. The fixed 
call sequence must match the Selcall system’s Tx Format.

The following rules apply.

� R (receiver) burst: The TxCall field sets the receiver 
identity and must be the same length as the R burst in Tx 
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Format. Use characters 0 to 9, A to D and F. Settings 
TxCall to NONE disables the fixed call sequence feature.

� S (status) burst: The Status field sets the status and is set 
according to the S burst in Tx Format. If Tx Format has 
one S, set Status to any status digit from 0 to 15. If Tx 
Format has two Ss, then set Status to any status digit from 
0 to 99. On Orca Eclipse and Orca 5020 radios a variable 
status can be sent as part of the fixed call sequence, and so 
Status can also be set to V.

� B (repeater) burst: The Repeater field sets the repeater 
identity and must be the same length as the B burst in Tx 
Format. Use characters 0 to 9 and A to F.

� C (caller identity) burst: The CallerID field sets the caller 
identity and must be the same length as the C burst in Tx 
Format. Use characters 0 to 9, A to D and F, or, if you 
wish to use one of the radio’s Rx decode sequences as the 
caller identity, select one of the Copy Rx Decode ID 
buttons.

If any of characters entered for the R, B and C bursts corre-
sponds to the group tone (Group Tone ‘G’ in the Selcall 
Tone Options tab), a G is automatically substituted for that 
character.

Variable Call Sequence
The Variable Call Sequence fields apply to Orca Excel, Orca 
Eclipse, Orca 5015 and Orca 5020 radios.

If the variable call sequence is defined, an R burst (TxCall 
field) must be set and the S, B and C bursts are optional. The 
variable call sequence must match the Selcall system’s Tx 
Format. Up to three tones can be set to V for Orca Excel 
radios, and up to eight tones can be set to V for Orca Eclipse 
and Orca 5020 radios, plus status.

The following rules apply.

� R (receiver) burst: The TxCall field sets the receiver 
identity and must be the same length as the R burst in Tx 
Format. Use characters 0 to 9, A to D, F and V. Settings 
TxCall to NONE disables the variable call sequence fea-
ture.

� S (status) burst: The Status field sets the status and is set 
according to the S burst in Tx Format. If Tx Format has 
one S, set Status to any status digit from 0 to 15. If Tx 
Format has two Ss, then set Status to any status digit from 
0 to 99. On Orca Eclipse and Orca 5020 radios a variable 
status can be sent as part of the variable call sequence, and 
so Status can also be set to V. Note that the V is not a 
number the radio user dials.

� B (repeater) burst: The Repeater field sets the repeater 
identity and must be the same length as the B burst in Tx 
Format. Use characters 0 to 9, A to F and V.

fixed call sequence

The fixed call sequence is a Selcall 
sequence that is defined at radio pro-
gramming time and that can be trans-
mitted by a long press of the call key 
on Orca 5015, Orca Excel and 
Eclipse radios. The fixed call sequence 
is also used when an alpha symbol 
that is a Selcall call is executed. If the 
signalling sequence defined for the 
alpha symbol is fewer tones than the 
fixed call sequence, the missing tones 
are substituted from the fixed call 
sequence.

variable status

The S burst of a Selcall sequence can 
be programmed with a V. When the 
sequence is transmitted, the status 
digit included is the one the user last 
selected in status entry mode. 

variable call sequence

The variable call sequence is a Selcall 
sequence that is defined as part of the 
Selcall dialling feature. In the variable 
call sequence, one or more tones are set 
to V. The V tones represent the tones 
the radio user keys in. When the var-
iable call sequence is transmitted, the 
tones the user has keyed in are substi-
tuted for the Vs in the variable call 
sequence. 

Selcall dialling

Using Selcall dialling, the user can 
dial Selcall sequences using the key-
pad. 



68 Selcall Identity and Setup Form   © Copyright Tait Electronics Ltd, 2004

� C (caller identity) burst: The CallerID field sets the caller 
identity and must be the same length as the C burst in Tx 
Format. Use characters 0 to 9, A to D, F and V, or, if you 
wish to use one of the radio’s Rx decode sequences as the 
caller identity, select one of the Copy Rx Decode ID 
buttons.

If any of the characters entered for the R, B and C bursts cor-
responds to the group tone (Group Tone ‘G’ in the Selcall 
Tone Options tab), a G is automatically substituted for that 
character.

Function Key Preset Calls
Tait Orca radios can have two function key preset Selcall 
calls defined at radio programming time. See “Programming 
Per Channel Selcall Calls” on page 158 for more informa-
tion.

The function key preset calls are free-form sequences. Each 
burst can consist of up to eight tones and should be separated 
by a gap burst of up to eight gaps.

� R (receiver) burst: If the sequence is defined, the receiver 
identity must be set. Use characters 0 to 9, A to D and F.

� B (repeater) burst: The repeater identity is optional. Use 
characters 0 to 9 and A to F.  If the repeater burst is set, 
it must come first in the sequence.

� C (caller identity) burst: The caller identity is optional. 
Use characters 0 to 9, A to D and F.

� S (status) burst: The status burst is optional. The status 
burst can be any valid status digit and must come last in 
the sequence. For Orca Eclipse and Orca 5020 radios it 
can be set to V, in which case the current status is trans-
mitted.

If any of the characters entered for the R, B and C bursts cor-
responds to the group tone (Group Tone ‘G’ in the Selcall 
Tone Options tab), a G is automatically substituted for that 
character. 

If either of the function key presets calls contain a repeater 
burst, enable the B Burst? field for that call. See “First Tone-
Period Multiplier” on page 74 for more information.

Auto Acknowledge Sequence
The auto acknowledge sequence is the sequence transmitted 
whenever an auto acknowledge is required. 

There are three options for the auto acknowledge sequence:

� NONE: No auto acknowledge is sent.

� BEEP: The auto acknowledge is in the form of a single 
beep, which is tone 6 of the Selcall system’s tone set, 
transmitted for 500 ms.

free-form sequence

A free-form sequence is a Selcall 
sequence that does not have to conform 
to the Selcall system’s transmit (Tx) 
format. 
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� Define the sequence: See “Defining the Auto Acknowl-
edge Sequence” below.

The amount of time between when a radio receives a Selcall 
sequence that matches its radio identity and when it transmits 
an auto acknowledge is set in the Auto Acknowledge Delay 
Time field (Selcall Features form). 

The number of times a radio resends a Selcall sequence when 
no auto acknowledge is received is set in the Number of ’No 
Acknowledge’ Retries field (Selcall Features form). How 
long a radio waits before resending a Selcall sequence for 
which no auto acknowledge has been received is set in the 
Wait For Acknowledgement field (Selcall Features form), 
which only applies if the Number of ’No Acknowledge’ 
Retries field is set to a value other than zero. When a calling 
radio is waiting for an auto acknowledge (the Wait For 
Acknowledgment time has not expired), the radio assumes 
any incoming Selcall sequence that does not match one of its 
Rx decode sequences is the auto acknowledge it is waiting 
for.

Defining the Auto Acknowledge Sequence
The auto acknowledge sequence is a free-form sequence. 
Each burst can consist of up to eight tones and should be sep-
arated by a gap burst of up to eight gaps. The following rules 
apply.

� R (receiver) burst: If the sequence is defined, the receiver 
identity must be set. Use characters 0 to 9, A to D and F.

� B (repeater) burst: The repeater identity is optional. Use 
characters 0 to 9 and A to F. If the repeater burst is set, it 
must come first in the sequence.

� C (caller identity) burst: The caller identity is optional. 
Use characters 0 to 9, A to D and F.

� S (status) burst: The status burst is optional. The status 
burst can be any valid status digit and must come last in 
the sequence. For Orca Eclipse and Orca 5020 radios it 
can be set to V, in which case the current status is trans-
mitted.

If any of the characters entered for the R, B and C bursts cor-
responds to the group tone (Group Tone ‘G’ in the Selcall 
Tone Options tab), a G is automatically substituted for that 
character. 

If the auto acknowledge sequence contains a repeater burst, 
enable the B Burst? field. See “First Tone-Period Multiplier” 
on page 74 for more information.

ANI Sequence
The ANI sequence is the sequence transmitted whenever the 
PTT is pressed, according to the ANI encoding properties set 
in the Selcall Features form. 
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There are four options for the ANI sequence.

� NONE: No ANI sequence is sent, even if ANI encoding 
is enabled for that Selcall system.

� BEEP: The ANI sequence is in the form of a single beep, 
which is tone 6 of the Selcall system’s tone set, transmit-
ted for 500 ms.

� REPEATER ACCESS TONE: The ANI sequence is 
the repeater access tone set for that Selcall system (Selcall 
Tone Options tab).

� Define the sequence: See “Defining the ANI Sequence” 
below.

Four fields in the Selcall Features form set ANI encoding 
properties for all Selcall systems. The ANI Suppression Time 
field determines the amount of time between successive 
transmissions of the ANI sequence, and the Leading ANI, 
Random ANI and Trailing ANI fields determine at what 
point after the PTT has been pressed the ANI sequence is 
transmitted.

In all instances, the ANI sequence is only transmitted if the 
ANI suppression time has expired.

At least one of Leading ANI, Random ANI and Trailing 
ANI must be enabled if ANI transmission is to be enabled. If 
the ANI sequence is the repeater access tone, only Leading 
ANI should be enabled.

Defining the ANI Sequence
Each burst can consist of up to eight tones and should be sep-
arated by a gap burst of up to eight gaps.

� R (receiver) burst: If the sequence is defined, the receiver 
identity must be set. Use characters 0 to 9, A to D and F. 
On Orca Eclipse and Orca 5020 radios set up to decode 
ANI, the ANI sequence is not displayed unless it matches 
the R burst in the transmit format.

� B (repeater) burst: The repeater identity is optional. Use 
characters 0 to 9 and A to F. If the repeater burst is set, it 
must come first in the sequence.

� C (caller identity) burst: The caller identity is optional. 
Use characters 0 to 9, A to D and F.

� S (status) burst: The status burst is optional. The status 
burst can be any valid status digit and must come last in 
the sequence. For Orca Eclipse and Orca 5020 radios it 
can be set to V, in which case the current status is trans-
mitted.

If any of the characters entered for the R, B and C bursts cor-
responds to the group tone (Group Tone ‘G’ in the Selcall 
Tone Options tab), a G is automatically substituted for that 
character. 
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If the ANI sequence contains a repeater burst, enable the B 
Burst? field. See “First Tone-Period Multiplier” on page 74 
for more information.

Selcall Tone Options Tab
How Selcall sequences are transmitted is set in the Selcall 
Tone Options tab.The Selcall Tone Options tab is shown 
below.

Tone Set
The Tone Set field specifies the tone set a Selcall system 
operates on.

The radio can operate with any of the tone sets supported by 
the radio software, and a different tone set can be assigned for 
each Selcall system. The available tone sets are described in 
Table 2 on page 72. You can create your own tone set or 
reorder an existing tone set in the Custom Selcall Tone Set 
form. You must set the Tone Set field to User Defined to use 
the custom tone set.

Tone Period
The Tone Period field sets the duration of each tone in a 
Selcall sequence. Set the tone period to 20, 33, 40, 50, 60, 70 
or 100 ms.

Gap Period
The Gap Period field sets the duration of each gap in a Selcall 
sequence. Set the gap period from 1 to 150 ms in steps of 1 
ms.

tone set

The tone set is the set of frequencies 
represented by the characters 0-9 and 
A-F used to make up Selcall 
sequences. There are a number of 
internationally accepted standard tone 
sets available. There is a finite number 
of frequencies available to represent the 
various characters in a Selcall 
sequence; it is the frequencies used and 
their order that distinguishes one tone 
set from another.

gap

A gap is a pause in the transmission of 
tones in a Selcall sequence. When con-
structing Selcall sequences, a gap is 
represented by a hyphen (-). A series 
of gaps makes up a gap burst.
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If a gap is defined in Rx Format, (Selcall Identity (Rx) tab), 
ensure that the total gap period is equal to or longer than one 
tone period. Otherwise Selcall sequences will not be 
decoded properly.

Group Tone ‘G’
The Group Tone ’G’ field sets a group tone for each Selcall 
system. This is the tone that is substituted when G is used in 
any outgoing Selcall sequences and that identify incoming 
Selcall sequences as group calls. It can be set to any of the 
tones 0 to 9 and A to F in the current Selcall system, except 
the repeat tone (E).

The Group Dialling field (Selcall Features form) must be ena-
bled if the radio user is dialling group calls from the radio’s 
keypad.

Group Format
The Group Format field sets the group format used for group 
calling. The format selected depends on the system in use. 
There are two options.

Table 2: Selcall tone sets and frequencies (Hz). Note: E is the repeat tone.

Tone CCIR EIA EEA ZVEI-I ZVEI-II ZVEI-III PZVEI NATEL DZVEI

0 1981 600 1981 2400 2400 2400 2400 1633 2200

1 1124 741 1124 1060 1060 1060 1060 631 970

2 1197 882 1197 1160 1160 1160 1160 697 1060

3 1275 1023 1275 1270 1270 1270 1270 770 1160

4 1358 1164 1358 1400 1400 1400 1400 852 1270

5 1446 1305 1446 1530 1530 1530 1530 941 1400

6 1540 1446 1540 1670 1670 1670 1670 1040 1530

7 1640 1587 1640 1830 1830 1830 1830 1209 1670

8 1747 1728 1747 2000 2000 2000 2000 1336 1830

9 1860 1869 1860 2200 2200 2200 2200 1477 2000

A 2400 2151 1055 2800 885 885 970 1995 825

B 930 2433 930 810 825 810 810 571 740

C 2247 2010 2400 970 740 2800 2800 2205 2600

D 991 2292 991 885 680 680 885 2437 885

E 2110 459 2110 2600 970 970 2600 1805 2400

F 1055 1091 2247 680 2600 2600 680 2694 680

group call

A Selcall call can be made to a group 
of radios by including a group tone in 
the Selcall sequence.
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� International: The first tone in the sequence defined can-
not be a group tone. Any of the subsequent tones can be 
the group tone.

� Sigtec: The first tone in the sequence defined cannot be 
a group tone. All following the first group tone must also 
be a group tone.

All radios operating on the Selcall system should use the same 
format.

Repeater Access Tone
The Repeater Access Tone field sets the repeater access tone, 
which can be sent before a voice or data transmission. Set the 
repeater access tone to any of the valid tones in the current 
tone set (0-9, A-F). If no repeater access tone is required, 
then the value this field is set to has no effect on radio oper-
ation.

The repeater access tone is transmitted for the Repeater 
Access Tone Duration when a function key is pressed to 
which the Repeater Access Tone option has been assigned. 
See “Function Key Option: Repeater Access Tone” on page 
129 for more information.

Repeater Access Tone Duration
The Repeater Access Tone Duration field sets the length of 
time the repeater access tone is transmitted, when required.

Select a value from 0 to 5100 ms in steps of 20 ms.

The repeater access tone is transmitted when a function key 
is pressed to which the Repeater Access Tone option has 
been assigned.

Lead In Tone
The Lead In Tone field sets the lead-in tone, which is sent 
during the lead-in delay before any Selcall sequences. It can 
be used to halt scanning on a called radio before critical tones 
are sent or to allow the called radio time to come out of 
economy mode. Set this tone to any of the valid tones in the 
current tone set (0-9, A-F) or NONE.

If a lead in tone is specified (set to a value other than 
NONE), the lead in tone is transmitted for the duration of 
the Lead In Delay for all outgoing Selcall sequences except 
for random and trailing ANI. A two-tone period gap follows 
a lead in tone transmission.

An alternative to using a lead-in tone is to extend the amount 
of time the first tone in the Selcall sequence is transmitted. 
See “First Tone-Period Multiplier” on page 74 for more 
information.

repeater access tone

A repeater access tone is a single tone 
that is transmitted before a voice or 
data transmission. The repeater access 
tone is used to key up the repeater 
before a transmission is sent so that no 
information is lost at the beginning of 
the transmission.
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Lead In Delay
The Lead In Delay field sets duration of the lead-in tone 
before all Selcall sequence transmissions, except random and 
trailing ANI. Set the lead in delay to 0 to 5100 ms in steps of 
20 ms.

If both Selcall and economy mode are enabled (Selcall Iden-
tity (Rx) tab and Power Save Features form) for other radios 
in the fleet, the lead in delay needs to be set to at least 100 ms 
longer than the economy duty cycle (Power Save Features 
form). For example, for a duty cycle setting of Medium, the 
Lead In Delay should be set to no less than 600 ms. Other-
wise the incoming Selcall sequence may not be detected reli-
ably.

If Selcall is being used with scanning, then the lead-in delay 
should be set to a value equivalent to the time it takes for a 
scan group to do one complete scan of all channels. See 
“Scanning” on page 148 for more information.

If Selcall is being used on a repeater system, add an additional 
200 ms to the lead-in delay.

First Tone-Period Multiplier
An alternative to having a lead in delay is to extend the dura-
tion of the first tone in a Selcall sequence. The tone-period 
multiplier is applied to the first burst of the transmitted 
sequence, unless the first burst is a repeater burst. In this case, 
the tone-period multiplier is applied to the first tone of the 
second burst.

If the tone-period multiplier option is enabled, it is important 
to specify whether free-form sequences have a repeater (B) 
burst. Note that when using the tone-period multiplier for 
free-format sequences, ensure that any repeater burst is sepa-
rated from the second burst by a gap, as the tone-period mul-
tiplier is applied to the first burst after a gap burst. 

The First Tone-Period Multiplier field determines the length 
of time the first tone in a Selcall sequence is transmitted and 
can be set as an alternative to having a lead-in tone. 

Set a value from 1 to 70, where the tone period for the first 
tone is multiplied by this number. For example, if the tone 
period is 20 ms and the tone-period multiplier is 10, the first 
tone of a Selcall sequence is transmitted for 200 ms.

If any of the sequences Function Key Preset Calls, ANI 
Sequence, Auto Acknowledge Sequence (Selcall Sequences 
(Tx) tab) and Selcall Sequence (Selcall Emergency Setup 
form) contain a repeater burst and you specify a first tone-
period multiplier greater than one, you must also specify 
whether these sequences have a repeater burst (B Burst? 
fields, Selcall Identity (Rx) tab). 
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Selcall Features Form

Various advanced Selcall features are enabled and disabled in 
the Selcall Features form. Once a feature in this form is ena-
bled, it is enabled for all Selcall systems. The Selcall Features 
form is shown below.

Deferred Calling
The Deferred Calling field enables the deferred calling 
option for all Selcall systems. The Tx Inhibit field in the 
Transmitter Setup form must be set to Busy or Mute before 
deferred calling can be enabled.

If Tx Inhibit is set to Busy or Mute and deferred calling is dis-
abled, the radio gives an invalid keypress whenever a call is 
attempted on a busy channel.

Third Tone Monitor Reset
The Third Tone Monitor Reset field enables the third tone 
monitor reset option for all Selcall systems. 

The third tone monitor reset option is only valid for a par-
ticular Selcall system if there are more than three Rs in the 
Rx Format (Selcall Identity (Rx) tab).

Appended C Tone Monitor Reset
The Appended C Tone Monitor Reset field enables the 
appended C tone monitor reset option for all Selcall systems. 

deferred calling

When the transmit inhibit conditions 
are Busy or Mute, a Selcall call can-
not be transmitted on a busy channel. 
When the deferred calling feature is 
enabled, the call is stored and sent at 
a random time between 1 and 10 sec-
onds after the channel becomes free.

third tone monitor reset

The monitor and squelch override are 
deactivated when the first three tones 
of the receiver identity for an incoming 
Selcall sequence match the first three 
tones of one of the radio’s Rx decode 
sequences.

appended C tone monitor reset

The monitor is deactivated when an 
incoming Selcall sequence that con-
tains the radio’s identity has a C tone 
appended to the end of a burst. Emer-
gency cycling (see Emergency mode) is 
also deactivated.
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Selcall Sidetones
The Selcall Sidetones field enables the generation of 
sidetones for all outgoing Selcall sequences except for the 
auto acknowledge sequence and the emergency sequence. 
The radio user is able to hear the Selcall tones in an outgoing 
sequence as they are transmitted. If Selcall sidetones are disa-
bled, the only indicator the radio user has for an outgoing 
Selcall call is the valid keypress indicator.

ANI Decoding
The ANI Decoding field applies only to Orca Eclipse and 
Orca 5020 radios.

The ANI Decoding field enables ANI decoding for all Selcall 
systems. When ANI decoding is enabled, a radio can display 
the ANI sequence transmitted by radios using the channel 
the listening radio is currently tuned to. The ANI sequence 
must match the decoding radio’s receive format (Selcall 
Identity (Rx) tab) in order for the caller identity burst of that 
sequence to be displayed.

Group Dialling
The Group Dialling field does not apply to Orca Elan and 
Orca 5010 radios.

The Group Dialling field enables the group dialling option 
for all Selcall systems. When enabled, the radio user can dial 
group calls.

The group tone used for group calling is assigned in the 
Selcall Tone Options tab. Each Selcall system can be assigned 
a different group tone.

Automatic Caller Identification
The Automatic Caller Identification field does not apply to 
Orca Elan and Orca 5010 radios.

When an incoming call is received, the caller identity is dis-
played so the radio user can identify the caller before 
responding. The caller identity is displayed as a number or as 
a label, depending on the radio type and how it was pro-
grammed.

The Automatic Caller Identification field sets the automatic 
caller identification option for all Selcall systems. Automatic 
caller identification only operates on Selcall systems that have 
a caller identity burst in the receive (Rx) format. Automatic 
caller identification can be enabled in the Selcall Features 
form once a C burst has been included in at least one receive 
format.

How the caller identity is displayed depends on the type of 
radio. On Orca Excel, Orca Eclipse, Orca 5015 and Orca 

sidetones

Sidetones are the tones heard when a 
DTMF string or Selcall sequence is 
transmitted and they indicate to the 
radio user that a call has been trans-
mitted. The radio can be programmed 
to not generate sidetones when a 
Selcall sequence is transmitted (Selcall 
Features form).

ANI

ANI stands for “automatic number 
identification”. A Selcall or DTMF 
system can be set up so that each radio 
automatically transmits its identity at 
regular intervals throughout the dura-
tion of a call. Each radio’s identity is 
transmitted on each exchange of trans-
missions (each press of the PTT) 
unless the ANI suppression time has 
not expired. ANI makes it possible to 
set up a log of a radio’s channel activ-
ity.

group call

A Selcall call can be made to a group 
of radios by including a group tone in 
the Selcall sequence.

automatic caller identification

When an incoming call is received, the 
caller identity is displayed so the radio 
user can identify the caller before 
responding.
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5020 radios, the caller identity is displayed as a number, 
which is the C burst in the received Selcall sequence.

On Orca Eclipse and Orca 5020 radios, the caller identity can 
be displayed as a label if the incoming C burst (the caller’s 
identity) matches one of the Signalling Numbers (receiver 
identities) in the radio’s Selcall alpha symbols (Alpha Symbols 
form). The label displayed is that for the matching alpha sym-
bol.

The received call sequence only displays properly if it 
matches the receive format. Free-form sequences may not 
display properly.

Received Call Queuing
The Received Call Queuing field does not apply to Orca 
Elan, Orca Excel, Orca 5010 and Orca 5015 radios.

The Received Call Queuing field enables call queuing on all 
Selcall systems.

When enabled, this field sets a queue for holding unanswered 
Selcall calls for all Selcall systems. Call queuing can only be 
enabled when Automatic Caller Identification (Selcall Fea-
tures form) is enabled.

Rx Call Sub-sequence Decoding
The Rx Call Sub-sequence Decoding field applies to all 
Selcall systems.

When Rx Call Sub-sequence Decoding is enabled, the 
detection and validation of incoming Selcall sequences 
depends only on the receiver identity, and so if the caller 
identity and status are absent from the incoming sequence, 
the call is still detected as valid. This feature is useful in areas 
of marginal signal strength where some of the bursts may be 
missing or corrupted.

Number of ’No Acknowledge’ 
Retries
The Number of ’No Acknowledge’ Retries field sets the 
number of times the radio automatically resends a call when 
no auto acknowledge response is received from the called 
radio. How long the radio waits for an auto acknowledge to 
be returned is set in the Wait For Acknowledgement field 
(Selcall Features form).

Set a value from 0 to 15.

Wait For Acknowledgement
The Wait For Acknowledgement field sets the delay 
between when the radio first sends a call and when it resends 
the call when no auto acknowledge is received.

call queuing

If the radio user is unable to answer 
calls immediately, they can be stored 
in the call queue so that the user can 
call back later. Up to 15 calls can be 
stored.

auto acknowledge

When a radio receives a Selcall 
sequence that contains its identity, it 
can be programmed to transmit an 
auto acknowledge sequence.
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Set a value from 1 to 20 seconds in steps of 1 second.

Selcall Tx Tolerance Factor
The Selcall Tx Tolerance Factor field determines how long 
the radio continues transmitting once the last tone in a Selcall 
sequence has been transmitted. This extra tail time ensures 
that the called radio is able to decode the Selcall sequence and 
should be set to at least one tone period in length.

Set a value from 0 to 2550 in steps of 10.

Called Unit Status Display
The Called Unit Status Display field does not apply to Orca 
Elan, Orca Excel, Orca 5010 and Orca 5015 radios.

The Called Unit Status Display field sets the called unit status 
display option for all Selcall systems. Called unit status display 
only operates on Selcall systems that have a status burst 
assigned in the receive (Rx) format (Selcall Identity (Rx) 
tab).

Auto Acknowledge Delay Time
The Auto Acknowledge Delay Time field sets the delay 
between when an incoming Selcall sequence is received and 
when an auto acknowledge is sent. Set a value from 100 to 
12,000 ms in steps of 100 ms.

Remote Monitor Reset 
Acknowledge
When the Remote Monitor Reset Acknowledge field is ena-
bled, an auto acknowledge is sent when a valid remote mon-
itor reset sequence is received.

The Remote Monitor Reset Acknowledge field applies to all 
Selcall systems. If no auto acknowledge sequence is defined 
for a particular Selcall system (Selcall Sequences (Tx) tab), 
then no auto acknowledge is sent when a valid remote mon-
itor reset sequence is received.

Remote Monitor Reset Alert
When the Remote Monitor Reset Alert field is enabled, the 
radio activates an audible alert when a valid remote monitor 
reset sequence is received. If the radio is in emergency mode, 
it does not give an alert.

Remote Monitor Reset Call Clear
When the Remote Monitor Reset Call Clear field is ena-
bled, the radio clears any active incoming call when a valid 
remote monitor reset sequence is received.

called unit status display

When a called radio responds with an 
auto acknowledge that contains status 
digit, the auto acknowledge sequence 
is displayed on the calling radio, 
together with any attached status mes-
sage.

remote monitor reset

A remote monitor reset sequence can 
be assigned for each Selcall system a 
radio operates on. When the radio 
receives this sequence and the remote 
monitor reset function has been ena-
bled, the radio deactivates monitor,  
squelch override and/or emergency 
cycling, if they are active.
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ANI Suppression Time
The ANI Suppression Time field sets the amount of time 
between the end of the transmission of the ANI sequence 
and when it is next transmitted, if the PTT has been pressed. 
Set this field to between 0 and 120 seconds in steps of 1 sec-
ond.

Leading ANI
The Leading ANI field determines if the ANI sequence is 
sent whenever the PTT is pressed. There are three options.

� Enabled: The ANI sequence is sent when the PTT is 
pressed, if the ANI suppression time has expired.

� Suppress on Busy: The ANI sequence is sent at the start 
of a transmission initiated by the PTT key if the ANI sup-
pression time has expired.

� Disabled: The ANI sequence is not sent when the PTT 
is pressed.

The ANI sequence is set in the Selcall Sequences (Tx) tab. If 
the ANI sequence is the repeater access tone, then Leading 
ANI should be the only ANI transmit option enabled.

Random ANI
If the Random ANI field is enabled, the ANI sequence is 
sent during the transmission at some random time (0 to 15 
seconds) after the PTT is pressed. There is no lead-in delay 
for random ANI transmissions.

If the transmission is terminated (PTT released or transmit 
timeout) before the first random ANI has been sent and trail-
ing ANI is disabled, then the ANI sequence is sent in the 
trailing position, subject to the expiry of the ANI suppression 
time.

The ANI sequence is set in the Selcall Sequences (Tx) tab. 

Trailing ANI
If the Trailing ANI field is enabled, the ANI sequence is sent 
at the end of the transmission, subject to the expiry of the 
ANI suppression time. The ANI sequence is sent after release 
of the PTT but before any subaudible signalling termination 
sequence (i.e. CTCSS reverse tone burst, DCS stop code). 
There is no lead-in delay for trailing ANI transmissions.

The ANI sequence is set in the Selcall Sequences (Tx) tab. 

Call Diversion
The call diversion feature is not available on Tait Orca radios, 
but Orca Eclipse and Orca 5020 radios recognise and 
respond to call divert messages. The Call Diversion field ena-
bles the recognition of call divert messages.

call diversion

Call diversion allows the radio user to 
divert received calls to another chan-
nel, and although it is not available 
on Tait Orca radios, Orca Eclipse 
and Orca 5020 radios recognise a call 
diversion message from another radio 
and switch to the designated channel.
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Diversion Channel
The Diversion Channel field sets the channel the radio 
switches to so that communication can be established when 
a called radio is in call diversion mode. Enter a valid channel 
ID or set the field to NONE. When set to NONE, the radio 
selects the current channel as the diversion channel.

The call diversion channel should be the same for all radios 
in a system.

Diversion Status
The Diversion Status field sets the status digit that identifies 
that a radio is in call diversion mode. Enter the status digit 
from the Auto Acknowledge Sequence. This will be from 0 
to 15 if the Rx Format defines a single status digit, or 0 to 99 
the Rx Format defines a double status digit. Enter NONE to 
disable. 

Tone Blanking
The Tone Blanking field enables tone blanking for received 
Selcall sequences on all Selcall systems. Tone blanking blanks 
out the tones of a received Selcall sequence so that the user 
does not hear them. The user may, however, hear the first 
few tones.

The Tone Blanking field has no other effect on Selcall oper-
ation.

Number of Tones to Activate
Orca 5010/5015/5020 radios only.

The Number of Tones to Activate field sets the number of 
tones that must be received consecutively to start tone blank-
ing. This eliminates the risk of certain speech tones being 
blanked out during a call. Enter a range from 2 to 5. 2 or 3 
tones is recommended.

Deactivation Timer
Orca 5010/5015/5020 radios only.

The Deactivation Timer field will turn off tone blanking 
after the programmed number of tone periods have elapsed 
since the carrier was detected. This eliminates the risk of cer-
tain speech tones being blanked out during a call. Enter 0 to 
disable the deactivation timer on tone blanking.

If the deactivation timer is enabled, Random ANI and Trail-
ing ANI will not be blanked. If using Random ANI or Trail-
ing ANI, or receiving on a system that uses a repeater, con-
sider using the Number of Tones to Activate field to 
eliminate blanking on speech tones. 
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Selcall Emergency Setup Form

Each radio can have a Selcall emergency call programmed, 
which is assigned to a function key setting. When the emer-
gency call is transmitted, the radio goes into emergency 
mode. The emergency call is configured in the Selcall Emer-
gency Setup form, which is shown below.

All fields in the Selcall Emergency Setup form are greyed out 
until the Selcall Sequence field is set. 

Switch-to Channel
The Switch-to Channel field determines the channel the 
radio switches to when the Selcall emergency call is made. 
The Switch-to Channel field is greyed out until a Selcall 
Sequence is defined (Selcall Emergency Setup form).

Set a valid channel ID or NONE for no channel. If a channel 
ID is set, it should have a Selcall system assigned. It is highly 
recommended that a channel be assigned as the emergency 
call sequence transmitted must match the receive format of 
the radio decoding the sequence. If a switch-to channel is not 
assigned, the radio operates as follows when the emergency 
call is made:

� If the current channel has a Selcall system assigned, the 
emergency call is made on that channel. 

� If the current channel does not have a Selcall system, 
assigned, no channel is specified and the emergency call 
is made while the radio is on a channel that does not have 
a Selcall system assigned, the radio searches for the first 

emergency mode

When in emergency mode, the radio 
cycles between receiving and transmit-
ting so that the called party can hear 
activity near the radio and so decide 
how to respond. The radio can be pro-
grammed so that all indicators remain 
unchanged while in emergency mode.

receive (Rx) format

The receive format defines the format 
all incoming Selcall sequences must 
follow in order to be correctly decoded 
by the receiving radio. The receive for-
mat should be the same for all radios 
using a particular Selcall system.
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channel that has a Selcall system and transmit the call on 
that channel.

Confusion may arise if the emergency Selcall sequence does 
not match the receive format of the Selcall system assigned to 
that channel.

Selcall Sequence
The Selcall Sequence field sets the Selcall sequence that is 
transmitted when the emergency call is sent. All other fields 
in the Selcall Emergency Setup form are greyed out until the 
Selcall Sequence is set.

The Selcall sequence is a free-form sequence; however, in 
most cases it should follow the transmit format of the Selcall 
system assigned to the switch-to channel.

Each burst can consist of up to eight tones and should be sep-
arated by a gap burst of up to eight gaps.

� R (receiver) burst: If the sequence is defined, the receiver 
identity must be set. Use characters 0 to 9, A to D and F.

� B (repeater) burst: The repeater identity is optional. Use 
characters 0 to 9 and A to F.  If the repeater burst is set, 
it must come first in the sequence.

� C (caller identity) burst: The caller identity is optional. 
Use characters 0 to 9, A to D and F.

� S (status) burst: The status burst is optional. The status 
burst can be any valid status digit and must come last in 
the sequence. 

For Orca Eclipse and Orca 5020 radios, status can be set to 
V, in which case the current status is transmitted. However, 
it is recommended that a specific emergency status be 
assigned (in the Status Labels tab).

If any of the characters entered for the R, B and C bursts cor-
responds to the group tone (Group Tone ‘G’ in the Selcall 
Tone Options tab), a G is automatically substituted for that 
character. 

Repeater Burst In Sequence
The Repeater Burst In Sequence specifies whether there is a 
repeater burst in the emergency Selcall Sequence. If the 
emergency Selcall Sequence contains a repeater burst, enable 
the Repeater Burst In Sequence field. See “First Tone-
Period Multiplier” on page 74 for more information.

Double Keypress Activation
When the Double Keypress Activation field is enabled, the 
radio user must press the function key twice before the radio 
goes into emergency mode. If the emergency call is assigned 
to a short keypress, the two keypresses must be made within 
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3 seconds. If the emergency call is assigned to a long keypress, 
the two keypresses must come within 5 seconds.

When the Double Keypress Activation field is disabled and 
the Emergency option is assigned to a long keypress, the 
radio user must press the function key for 2 seconds or more 
in order to activate emergency mode. A keypress of less than 
2 seconds is regarded as a short keypress.

Emergency Indicator
When the Emergency Indicator field is enabled, the radio 
gives an audible alert when the radio enters emergency 
mode.

Forced Audio Mute
When the Forced Audio Mute field is enabled, the radio’s 
receive audio remains muted while in emergency mode and 
so the radio does not broadcast noise that may draw attention 
in an emergency situation. If disabled, the mute state in 
emergency mode obeys the standard muting operation.

Emergency Call-out
The setting of the Emergency Call-out field determines how 
the emergency call is sent. There are two options.

� Repeat Until Acknowledged: The radio resends the 
emergency Selcall sequence every 8 seconds until a call is 
received that matches one of the radio’s Rx decode 
sequences and does not contain a control status. When an 
acknowledgement is received, the radio enters emer-
gency mode, if enabled (Tx/Rx Cycling fields set to val-
ues other than 0). If emergency cycling is not enabled, 
then upon receiving the acknowledgement the radio 
exits emergency mode and resumes normal operation.

� Single Call-out Only: The emergency Selcall sequence is 
sent only once. The radio then enters emergency mode 
(if enabled) or resumes normal operation.

Selcall Emergency ANI
The Selcall Emergency ANI field determines whether the 
ANI Sequence will be sent while the radio is in emergency 
mode. If this field is enabled, the ANI sequence will be trans-
mitted at the start of every transmit cycle while in emergency 
mode. Note that if this field is enabled, the ANI Suppression 
Time (Selcall Features form) will have no effect while the 
radio is in emergency mode.

Tx/Rx Cycling
The Tx/Rx Cycling fields set the amount of time the radio 
transmits and receives while in emergency mode.
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For the Tx Cycling field, set a value from 0 to 30 seconds in 
steps of 1 second. For the Rx Cycling field, set a value from 
1 to 30 seconds in steps of 1 second. Setting Rx Cycling to 
0 disables emergency cycling, and if Rx Cycling is set to 0, 
Tx Cycling is automatically set to 0.

If the radio is in receive mode and receives a call that matches 
the RMR Sequence or has a C tone appended (see 
“Appended C Tone Monitor Reset” on page 75), then 
emergency cycling will end.

Auto Radio Reset
When the Auto Radio Reset field is enabled, the radio exits 
emergency mode after 30 Tx/Rx cycles. The duration of 
each transmit/receive cycle is set in the Tx/Rx Cycling fields 
(Selcall Emergency Setup form).
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Selcall Rx Decode Setup Form

The Conventional Programming Application provides a 
default set of options for how the radio responds to incoming 
calls that match the radio’s unique identity. These are the 
ringing pattern the radio gives, how long the radio rings and 
whether or not an auto acknowledge is sent. These options 
can be customised in the Selcall Rx Decode Setup form. The 
Selcall Rx Decode form is shown below. 

For each call type, the following options can be customised:

� the ringing pattern (Alert/Ring Pattern field)

� how long the radio rings (Internal Alert Duration field)

� whether an auto acknowledge is sent (Auto Acknowl-
edge field)

See page 86 for instructions on setting each field.

Rx Decode Global Settings
The Rx Decode Global Settings fields determine the radio’s 
response to receiving a Selcall call that matches one of the 
radio’s Rx decode sequences, which are defined in the Selcall 
Identity (Rx) tab.

For each Rx decode sequence, set an Alert/Ring Pattern, an 
Internal Alert Duration and enable or disable Auto Acknowl-
edge.

Rx decode sequence

The Rx decode sequence is the radio’s 
unique identity on a Selcall system. 
When the radio’s Rx decode sequence 
is decoded as the receiver identity in an 
incoming Selcall sequence, the radio 
recognises the sequence as intended for 
it and responds appropriately. 
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Priority Call Decode
The Priority Call Decode fields determine the radio’s 
response to receiving a call that has the priority call control 
status in the S burst.

Set an Alert/Ring Pattern, an Internal Alert Duration and 
enable or disable Auto Acknowledge priority calls.

Group Call Decode
The Group Call Decode fields determines the radio’s 
response to receiving a group call.

Set an Alert/Ring Pattern, an Internal Alert Duration and 
enable or disable Auto Acknowledge for group calls.

Enabling Auto Acknowledge is not recommended for group 
calls.

Alert/Ring Pattern
The Alert/Ring Pattern field determines the pattern of the 
caller alert the radio gives when the call type is received. 

Enter an 8-digit code using 1s and 0s, where a 1 indicates a 
tone and a 0 indicates a gap. For example, the code 11110000 
would sound as one long ring followed by a pause of equal 
length, and the code 11001100 would sound as a short ring 
followed by a pause, then another short ring and another 
pause.

This alert/ring pattern for each type of call should be distinct 
from the alert/ring pattern for other calls.

Internal Alert Duration
The Internal Alert Duration field sets the time the call type 
remains unanswered before the radio enters the unanswered 
call state. Set a value from 0 to 250 seconds in steps of 1 sec-
ond. If set to 0, the radio rings until answered.

Auto Acknowledge
The Auto Acknowledge field determines whether an auto 
acknowledge is sent when the call type is received. If this 
field is enabled, the auto acknowledge sequence defined for 
the current Selcall system (Selcall Sequences (Tx) tab) is sent. 
If no sequence is defined, no auto acknowledge is sent.

priority call

A priority call is a Selcall sequence 
that has a priority control status 
appended. When the receiving radio 
decodes the priority status digit, it 
alerts the user that a priority call has 
been received and clears down any call 
in progress that is not a priority call. 

control status

A control status is a status digit that 
when received, initiate a particular 
radio operation. For example, when a 
radio receives a quiet interrogation sta-
tus digit, it transmits its auto 
acknowledge sequence with its current 
status appended without activating 
the call received indicator. 

group call

A Selcall call can be made to a group 
of radios by including a group tone in 
the Selcall sequence. 

auto acknowledge

When a radio receives a Selcall 
sequence that contains its identity, it 
can be programmed to transmit an 
auto acknowledge sequence. 
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Selcall Control Status Definitions Form

An additional one or two tones can be added to a Selcall 
sequence to indicate the caller’s present activity, or status. A 
Selcall sequence can also include a status that initiates a par-
ticular radio operation, called a control status. Status messages 
and control status are set up in the Selcall Control Status Def-
initions form. 

The Selcall Control Status Definitions form has two tabs.

� Set control status in the Control Status tab.

� Set status messages in the Status Labels tab.

For more information on control status and status labels, see:

� “Status Messages and Control Status” on page 160

Control Status Tab
Control status are set in the Control Status tab. The Control 
Status tab is shown below.

The Control Status tab provides for special control status. Set 
each control status to a valid status digit. If the receive format 
has one S, then there are 16 possible status digits, numbered 
0 to 15. If the receive format has two Ss, there are 100 pos-
sible status digits, numbered from 0 to 99. 

If a radio is operating on Selcall systems that have a mix of no 
status or one-tone (0 to 15) and two-tone (0 to 99) status 
bursts:

� no status digits are valid on systems that do not include 
status in the receive format
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� status digits 16 to 99 are not valid on systems that have 
only one status tone.

Each control status should be set to the same value for all 
radios in a fleet.

Priority Call Control Status
The Priority Call Control Status field sets the status digit that 
when received identifies a call as a priority call. The radio 
activates the alert specified for priority calls in the Selcall Rx 
Decode Setup form.

Quiet Interrogation Control Status
The Quiet Interrogation Control Status field sets the status 
digit that when received causes the radio to transmit the auto 
acknowledge sequence for the current Selcall system without 
alerting the radio user to the receipt of the Selcall sequence.

Activate Stun Control Status
The Activate Stun Control Status field sets the status digit 
that when received causes the radio to cease normal opera-
tion. The radio resumes normal operation when the Deacti-
vate Stun Control Status is received.

Deactivate Stun Control Status
The Deactivate Stun Control Status field sets the status digit 
that when received causes a stunned radio to resume normal 
operation. 

Data Control Status
The Data Control Status field sets the status digit that when 
received causes the radio to deactivate Selcall decoding and 
activate data decoding. This allows data to be received over 
the air on Selcall channels.
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Status Labels Tab
Status messages are available on Orca Eclipse and Orca 5020 
radios and are set in the Status Labels tab. The Status Labels 
tab is shown below.

Select the Add button or press the F2 key to add a status mes-
sage, select the Delete button or press the F3 key to delete 
the currently selected status message, or select the Repeat 
button to duplicate the current status message’s label. Up to 
100 status messages can be defined.

Digit
The Digit field sets the status digit that is transmitted. Enter 
a value from 0 to 99.

Label
The Label field sets the status label associated with the status 
digit). 

Enter a name of up to 8 characters from:

A to Z 0 to 9 ! # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , . _ 
" ’ space
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Custom Selcall Tone Set Form

There are a number of internationally accepted standard tone 
sets available that determine the frequencies used for each of 
the 16 tones used to make up Selcall sequences. The Con-
ventional Programming Application offers nine of these 
standard tone sets. If, however, you wish to create your own 
tone set or reorder an existing tone set, that custom tone set 
can be configured in the Custom Selcall Tone Set form. The 
Custom Selcall Tone Set form is shown below.

For more information on tone sets, see:

� “Selcall Tone Transmission” on page 157

There are two ways you can define your own tone set, and 
the option chosen affects how you use this form. You can:

� reorder the frequency values of an existing tone set or

� enter your own values.

You must set the Tone Set field (Selcall Tone Options tab) 
to User Defined to make use of the custom tone set. Only 
one custom tone set is available on each radio.

Reordering a Tone Set
If you wish to reorder an existing tone set, choose the name 
of that tone set from the Tone Set to Define field. In the 
right-hand column, enter the tone (0 to 9, A to F) you wish 
to correspond to the frequency displayed. Use each tone only 
once. You cannot change the values in the left-hand column.

tone set

The tone set is the set of frequencies 
represented by the characters 0-9 and 
A-F used to make up Selcall 
sequences.
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Defining a Custom Tone Set
If you wish to define your own tone set, choose Non Stand-
ard from the Tone Set to Define field. The values in the left-
hand column are set to default values, and you cannot change 
the values in the right-hand column. 

In the left-hand column, enter the frequency you wish to 
correspond to the tone displayed. Each tone should be a dif-
ferent frequency, chosen from the Tone column of the Cus-
tom Selcall Tone Set Tone Frequencies and Their Tolerance 
Ranges table. 

The frequencies available for the custom tone set are limited, 
so if you wish to use a frequency that is not available (e.g. 
1500 to 1700 Hz), consider reordering an existing tone set as 
described in “Reordering a Tone Set” on page 90.

In the Tone Set field of the Selcall Tone Options tab, you 
need to select Custom Selcall Tone Set in order to use the 
tone set defined in this form.

Custom Selcall Tone Set Tone Frequencies 
and Their Tolerance Ranges
In the table below, Tone is the frequency used when the 
radio transmits a Selcall sequence. Tolerance is the lower and 
upper limit of the range of frequencies that Tait Orca radios 
decode as the stated tone in received Selcall sequences. For 
this reason, the Tolerance for defined tones cannot overlap.

Tone Tolerance Tone Tolerance Tone Tolerance Tone Tolerance

571 540-589 941 922-960 1275 1257-1298 1995 1950-2036

600 570-618 970 951-989 1305 1287-1328 2000 1955-2041

631 603-649 991 973-1010 1336 1318-1360 2010 1965-2052

680 654-698 1023 1005-1043 1358 1339-1382 2110 2057-2155

697 671-715 1040 1022-1060 1400 1381-1425 2151 2095-2198

740 716-758 1055 1037-1075 1446 1426-1472 2200 2140-2249

741 717-759 1060 1042-1080 1477 1456-1504 2205 2145-2254

770  747-788 1091 1074-1111 1728 1698-1761 2247 2183-2298

810 788-828 1124 1107-1145 1747 1716-1780 2292 2224-2345

825 803-843 1160 1143-1181 1805 1772-1840 2400 2322-2457

852 831-870 1164 1147-1185 1830 1795-1866 2433 2352-2492

882 862-901 1197 1180-1219 1860 1824-1897 2437 2356-2496

885 865-904 1209 1192-1231 1869 1832-1906 2600 2501-2667

930 911-949 1270 1252-1293 1981 1937-2022
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Part 5: Special Features
This part contains detailed information on setting up special features 
such as economy mode, DTMF, alpha symbols and data operation.

Forms

� Power Save Features Form

� DTMF Form

� Alpha Symbols Form

� Data Parameters Form
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Power Save Features Form

Economy mode is set up in the Power Save Features form. 
The Power Save Features form is shown below.

For more information, see:

� “Reducing Power Consumption on Tait Orca Radios” 
on page 166

� “Economy Mode” on page 166

� “Backlighting” on page 168

Economy Mode Timer
The Economy Mode Timer field sets the duration of the 
economy mode timer. Enter a value between 1 and 240 sec-
onds in steps of 1 second. Setting this field to 0 disables econ-
omy mode.

If economy mode is enabled and the radio has not been pro-
grammed to turn economy mode on and off (function key 
setting, or through user function menu entry mode on Orca 
Eclipse and Orca 5020 radios), then it is recommended to set 
Economy Mode Control (in the User Selectable Parameters 
form) to On.

Economy Duty Cycle
The Economy Duty Cycle field sets the amount of time the 
radio is in standby mode before sampling activity on a chan-
nel. 

� Low: 200 ms standby

economy mode

Economy mode reduces the radio’s 
power consumption when it is idle. 
When economy mode is active, and 
there has been no valid activity on a 
channel for the duration of the econ-
omy mode timer, the radio begins 
economy cycling. 
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� Medium: 500 ms standby

� High: 800 ms standby.

If both Selcall and economy mode are enabled, the Lead In 
Delay field (Selcall Tone Options tab) for other radios in the 
fleet needs to be set to at least 100 ms longer than that of the 
duty cycle, e.g. for a duty cycle setting of Medium, the Lead 
In Delay on other radios should be set to no less than 600 ms. 
Otherwise the incoming Selcall sequence may not be 
detected reliably.

If Selcall is being used on a repeater system, Economy Duty 
Cycle should not be set to High. See “Using Economy Mode 
with Selcall” on page 167 for more information.

Backlighting Timer
The Backlighting Timer field sets the duration of the back-
lighting timer. Enter a value between 1 and 10 seconds in 
steps of 1 second. 

See “Backlighting” on page 168 for more information.

repeater

A repeater receives a radio signal and 
retransmits it. Use of a repeater 
increases the coverage area of a two-
way radio system and ensures more 
reliable performance in areas where sig-
nals are reflected or attenuated by 
buildings or terrain. 

backlighting

The radio’s LCD lights up when 
there is activity on the radio, such as 
when a key is pressed or when a call is 
received.

backlighting timer

The backlighting timer determines 
how long backlighting remains on once 
it is activated. There are two ways 
backlighting can be activated, and how 
it was activated affects how the back-
lighting timer operates. 
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DTMF Form

DTMF options are set in the DTMF form. The DTMF form 
has three tabs.

� DTMF features, including how DTMF tones are 
encoded, are set in the DTMF Dialling tab. 

� DTMF ANI and emergency options are set in the DTMF 
ANI tab (Orca 5010/5015/5020 radios only). 

� DTMF preset calls are defined in the DTMF Presets tab.

For more information on DTMF, see:

� “Introduction to DTMF” on page 162

� “DTMF Presets” on page 163

� “DTMF Dialling” on page 164

DTMF Dialling Tab
How DTMF tones are encoded and DTMF dialling features 
are set in the DTMF Dialling tab. The DTMF Dialling tab is 
shown below.

Manual DTMF Dialling
The Manual DTMF Dialling field does not apply to Orca 
Elan and Orca 5010 radios.

� Enabled: DTMF calls can be made from the numeric 
keypad. 

� Disabled: The radio can only send preset DTMF num-
bers, if programmed to do so. 

DTMF

DTMF (dual tone multiple fre-
quency) is the tone-based system used 
for the world’s telephone networks. A 
DTMF “tone” actually consists of a 
pair of tones. DTMF tones are some-
times referred to as “touch tones”.
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DTMF Dialling Type Buffered
The DTMF Dialling Type Buffered field does not apply to 
Orca Elan and Orca 5010 radios.

The DTMF Dialling Type Buffered field determines 
whether the dialling type is normal dialling or buffered dial-
ling. If this field is ticked, then the dialling type is buffered.

PTT as Shift Key
The PTT as Shift Key field does not apply to Orca Elan and 
Orca 5010 radios.

If the user wishes to dial tones A to D or a pause, the PTT 
can be used as a shift key in conjunction with the numeric 
keypad. For example, on the Orca Excel:

PTT +  = A

PTT +  = B

PTT +  = C

PTT +  = D

PTT +  = pause

So pressing the PTT key, holding it, then pressing the   
key enters tone A in the DTMF string. Pressing the PTT, 
holding it, and then pressing the  key enters a pause in 
the string. A hyphen is entered in the display to indicate the 
pause.

Enable PTT as Shift Key if the user will need to dial tones A 
to D and pauses.

DTMF Redial Transmission
The DTMF Redial Transmission field does not apply to 
Orca Elan and Orca 5010 radios.

When DTMF Redial Transmission is enabled, the user can 
retransmit the last DTMF call by pressing the enter/accept 
key when in DTMF dialling mode.

When the radio enters DTMF dialling mode and this func-
tion is enabled, the DTMF string transmitted when the radio 
was last in DTMF dialling mode is displayed. If this is the 
string the user wishes to transmit, they only have to press the 
enter/accept key to transmit the string again.

DTMF Mode Selcall ANI Transmission
The DTMF Mode Selcall ANI Transmission field does not 
apply to Orca Elan and Orca 5010 radios.

If DTMF Mode Selcall ANI Transmission is enabled, the 
Selcall ANI sequence for the current channel can still be sent 
when a DTMF call is made. Some systems may experience 
interference if an ANI sequence is sent during a DTMF 
transmission, and in this case this field should be disabled.
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Transmit Key Up Delay
The Transmit Key Up Delay field sets a delay for the start of 
tone transmissions so that a repeater has time to stabilise. 
Enter a value from 10 to 2550 ms in steps of 10 ms.

Interdigit Tx Hold Time
The Interdigit Tx Hold Time field does not apply to Orca 
Elan and Orca 5010 radios.

The Interdigit Tx Hold Time field determines how long the 
radio keeps transmitting between the encoding of each tone. 
This provides a delay for the user to dial the next digit with-
out transmission stopping and restarting again. Some systems 
require continuous transmission between DTMF tones and 
therefore a long hold time.

Enter a value between 10 and 2550 ms, in steps of 10 ms.

Minimum Tone Duration (0-9, A-D)
The Minimum Tone Duration (0-9, A-D) field sets the min-
imum amount of time tones 0 to 9 and A to D are encoded. 
Enter a value from 10 to 1020 ms in steps of 10 ms.

Minimum Tone Duration (*, #)
The Minimum Tone Duration (*, #) field sets the minimum 
amount of time tones * and # are encoded. Enter a value 
from 10 to 1020 ms in steps of 10 ms.

Minimum Intertone Gap
The Minimum Intertone Gap field sets the minimum 
amount of time between encoded tones. Enter a value from 
10 to 500 ms in steps of 10 ms.
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DTMF ANI Tab
DTMF ANI options and emergency options are set in the 
DTMF ANI tab (Orca 5010/5015/5020 radios only).The 
DTMF ANI tab is shown below.

Leading ANI
The Leading ANI field determines if the corresponding 
DTMF preset is sent whenever the PTT is pressed. If 
checked, the ANI sequence is sent when the PTT is pressed, 
if the Suppression Timer has expired. If unchecked, the ANI 
sequence is not sent when the PTT is pressed. 

The preset will only be sent if the current channel has a 
DTMF ID and does not have a Selcall System associated with 
it.

Trailing ANI
The Trailing ANI field determines if the corresponding 
DTMF preset is sent whenever the PTT is released. If 
checked, the ANI sequence is sent when the PTT is released, 
if the Suppression Timer has expired. If unchecked, the ANI 
sequence is not sent when the PTT is released.

The preset will only be sent if the current channel has a 
DTMF ID and does not have a Selcall System associated with 
it.

Suppression Timer
The Suppression Timer field sets the amount of time 
between the end of the transmission of the ANI sequence 
and when it is next transmitted, if the PTT has been pressed. 



© Copyright Tait Electronics Ltd, 2004 DTMF Form 101

Set this field to between 0 and 120 seconds in steps of 1 sec-
ond.

Emergency Sequence
Emergency Sequence defines the DTMF sequence that will 
be sent when an emergency call is requested (either automat-
ically or via a function key). The sequence must be between 
2 and 32 digits.

Emergency Channel
Emergency Channel sets the channel that the DTMF Emer-
gency Sequence will be sent on. If no channel is selected then 
the sequence will be sent on the current channel if DTMF is 
enabled on it, otherwise the radio will change to the first 
channel that it is able to transmit DTMF.

Double Keypress Activation
When the Double Keypress Activation field is enabled, the 
radio user must press the function key twice before the radio 
goes into emergency mode. If the emergency call is assigned 
to a short keypress, the two keypresses must be made within 
3 seconds. If the emergency call is assigned to a long keypress, 
the two keypresses must come within 5 seconds. When the 
Double Keypress Activation field is disabled and the Emer-
gency option is assigned to a long keypress, the radio user 
must press the function key for 2 seconds or more in order 
to activate emergency mode. A keypress of less than 2 sec-
onds is regarded as a short keypress.

Retries
The Retries field sets how many times the DTMF Emer-
gency Sequence is sent. Select a number of retries between 1 
and 25. Enter 0 for the radio to continue to send the emer-
gency sequence until it is reset. The delay between each 
emergency sequence transmission is set in the Retry Interval 
field.

Retry Interval
The Retry Interval sets the time between each DTMF emer-
gency sequence transmission. Enter a time between 5 and 
255 seconds, in steps of 5 seconds. The number of times the 
emergency sequence is sent is set in the Retries field.
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DTMF Presets Tab
DTMF presets are defined in the DTMF Presets tab. The 
DTMF Presets tab is shown below.

Select the Add button or press the F2 key to add a new pre-
set, select the Delete button or press the F3 key to delete the 
currently selected preset, or select the Repeat button to 
duplicate the current preset’s call string.

Up to 20 presets can be defined. These calls can be made by 
pressing an assigned function key (on all radios) or by press-
ing the DTMF key (on Orca 5015, Orca Excel and Orca 
Eclipse radios).

If DTMF ANI is enabled and the DTMF ID is associated 
with the current channel, then the Preset Call String will be 
sent each time the PTT is pressed or released.

Each preset must have a:

� DTMF ID

� Preset Call String

DTMF ID
The DTMF ID field sets the preset ID number a DTMF call 
string is associated with. Enter a number from 1 to 20. To 
assign a DTMF preset to a particular channel, enter this 
DTMF ID in the DTMF ID field in the Channels form.

Preset Call String
The Preset Call String field sets the preset’s DTMF string. A 
valid string consists of between 1 and 32 characters from 0 to 
9, A to D, # or *. You can also enter a space, which is trans-
mitted as a pause.
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Alpha Symbols Form

Alpha symbols are defined in the Alpha Symbols form. The 
Alpha Symbols form is shown below.

For Orca Elan, Orca Excel, Orca 5010 and Orca 5015 radios, 
only one alpha symbol can be defined. This alpha symbol can 
be assigned as a function key call by selecting One Touch for 
one of the function key settings (Key Settings I tab). For 
Orca Eclipse and Orca 5020 radios, up to 20 alpha symbols 
can be defined.

Select the Add button or press the F2 key to add a new alpha 
symbol, select the Delete button or press the F3 key to delete 
the currently selected alpha symbol, or select the Repeat but-
ton to duplicate the current alpha symbol’s New Channel, 
New Status. Signalling Type, and Signalling Number.

Symbol Name
The Symbol Name field can only be set for Orca Eclipse and 
Orca 5020 radios and sets the symbol’s name, which can be 
up to 8 characters from:

A to Z 0 to 9 -

Because the user must be able to spell out the symbol name 
using the radio keypad, the characters allowed for Symbol 
Name are different than for other labels. The symbol name 
must be unique. 

The radio user selects alpha symbols in one of two ways.

� Selecting the required alpha symbol from the list of those 
available: The user scrolls through the list of sequences 
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until the required sequence is shown. Alpha symbols 
appear in the list in the order in which they are pro-
grammed in the Alpha Symbols form and so it may be 
useful to add alpha symbols to the list in alphabetical 
order. Consider, however, that only the first symbol in 
the list can be assigned to a function key setting as the one 
touch call.

� Searching for a specific alpha symbol by entering its label 
via the keypad: The user spells out the required alpha 
symbol’s label. An example of the searching process is 
shown below. 

If the radio cannot uniquely identify a label, it displays a 
question mark for each character entered. Once the user has 
entered enough characters to uniquely identify the label, the 
radio displays that label. If the label cannot be identified, the 
display shows a series of question marks. Because each alpha-
numeric key corresponds to more than one character, care 
should be taken in selecting the names of alpha symbols. 
Characters are grouped together as follows.

Table 3: Searching for a specific alpha symbol (BASE) in 
alphanumeric entry mode

Press 
Key

Display 
Reads

Explanation

CHARLIE Enter alphanumeric entry mode. The last 
symbol invoked (CHARLIE) is displayed.

? 2 represents 2, A, B and C. The radio 
cannot yet determine a unique label so 
displays ?

?? The radio cannot yet determine a unique 
label.

BASE The unique label has been identified 
upon a press of the key corresponding 
to the letter S.

BASE The command sequence associated with 
the alpha symbol BASE is carried out.

1 - 2 A B C 3 D E F

4 G H I 5 J K L 6 M N O

7 P Q R S 8 T U V 9 W X Y Z

* 0 #
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New Channel
The New Channel field sets the channel or group number 
(Channels and Scan Groups forms) to be selected when the 
alpha symbol is selected. Enter a valid channel or group ID 
or NONE if the channel is not to be changed when the alpha 
symbol is selected. On Orca Elan and Orca 5010 radios, this 
field must be set to NONE.

New Status
The New Status field applies only to Orca Eclipse and Orca 
5020 radios.

The New Status field sets the status to be selected when the 
alpha symbol is selected. Enter NONE for no new status, or 
the status digit of an existing status message.

If no New Channel is set (the field is set to NONE), New 
Status can be set to NONE or the digit of any existing status 
label; however, the new status is not necessarily valid on all 
channels. For example, if New Status is set to 78 and the 
channel selected when the symbol key is pressed is permitted 
only 16 status messages, the status is changed but it is not 
transmitted.

Signalling Type
The Signalling Type field sets a call signalling type for the 
alpha symbol, which determines the signalling sequence used 
when the symbol is activated. Enter Selcall, DTMF or 
NONE.

If the New Channel field is set to NONE and Signalling 
Type is set to Selcall, then Selcall must be enabled (Selcall 
Identity (Rx) tab) or the Selcall call assigned to the symbol is 
not transmitted. If New Channel is set to a specific channel, 
then a Selcall system must be assigned to that channel or the 
Selcall call assigned to the symbol will not be transmitted.

Note that for alpha symbols set as Selcall calls, the label for 
that symbol can be displayed when a call from that party is 
received. Automatic Caller Identification must be enabled 
(Selcall Features form) for this feature to operate correctly. 
When the C burst (caller identity) for an incoming call 
matches the C burst for the call string set as Signalling 
Number for an alpha symbol, that symbol’s label is displayed 
for the caller identity.

Signalling Number
The Signalling Number field sets the Selcall sequence or 
DTMF string that is transmitted when the alpha symbol is 
selected. The Signalling Type field must be set to Selcall or 
DTMF before the Signalling Number can be set.
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If Signalling Type is Selcall, enter a valid Selcall sequence 
from 1 to 8 tones long using characters 0 to 9, A to D and F. 
This sequence should be the receiver identity. The repeater 
identity, caller identity and status should not be included as 
they are read from the fixed call sequence for the Selcall sys-
tem associated with the channel the radio is on when the 
alpha symbol is selected or the channel the radio switches to 
as part of the alpha symbol command sequence. For this rea-
son, the Fixed Call Sequence field in the Selcall Identity (Rx) 
tab should be set for the Selcall system the call is made on. If 
the sequence entered for Signalling Number is fewer digits 
than the fixed call sequence, the remaining digits are substi-
tuted from the fixed call sequence when the alpha symbol is 
executed.

If Signalling Type is DTMF, enter a valid DTMF string. See 
“Introduction to DTMF” on page 162 for more informa-
tion.
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Data Parameters Form

The computer controlled data interface (CCDI) provides a 
means of controlling Tait Orca radios from some form of 
computer equipment. The CCDI allows for the implemen-
tation of semi- and fully-automatic communications systems 
such as computerised despatch terminals, remote outstations 
and data radio terminals. The Data Parameters form is shown 
below. 

Data Option
The Data Option field enables data operation via the com-
puter controlled data interface.

Transparent Mode Auto Start
The Transparent Mode Auto Start field applies to Orca 5010 
and Orca 5020 radios.

When the Transparent Mode Auto Start field is enabled, the 
radio will power up in transparent mode. In transparent 
mode, the radio acts as a modem, automatically retransmit-
ting data it receives.

Transparent Mode Baud Rate
The Transparent Mode Baud Rate field applies to Orca 5010 
and Orca 5020 radios.

The Transparent Mode Baud Rate field determines the data 
transfer rate while the radio is in transparent mode.

computer controlled data 
interface

The computer controlled data interface 
(CCDI) provides a means of control-
ling Tait Orca conventional radios 
from some form of computer equip-
ment. The CCDI allows for the 
implementation of semi- and fully-
automatic communications systems 
such as short data messaging 
(SDMs), computerised despatch ter-
minals, remote outstations and data 
radio terminals.
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Disable Transparent Mode Auto 
Escape Sequence
The Disable Transparent Mode Escape Sequence field 
applies to Orca 5010 and Orca 5020 radios.

When the Disable Transparent Mode Escape Sequence field 
is selected, the radio will ignore any incoming escape 
sequence instructing it to exit transparent mode.

XON/OFF Character
Handshaking allows control over the flow of data being sent 
and prevents data from being lost between the radio and the 
computer equipment communicating with it in CCDI 
mode. Two fields must be set, XON Character and XOFF 
Character.

XON Character sets the character that indicates the start of a 
flow of data, and XOFF Character sets the character that 
indicates the end of a flow of data.

Set both fields to a hexadecimal number between 0 and FF.

Inhibit RTS Signal
The Inhibit RTS Signal field applies to the Tait Radio 
Modem only. 

Request to Send (RTS) and Clear to Send (CTS) are serial 
communication handshaking signals and are only operational 
when the radio operates in transparent mode. In transparent 
mode, the radio acts as a modem, automatically retransmit-
ting data it receives. RTS (high at PC end) is an input signal 
to the Tait Radio Modem for manual activation of transmis-
sion.

The data modem can be used with or without the RTS sig-
nal. RTS is used to give greater control of when the radio 
transmits by reducing the data delay. When RTS is not used, 
the radio only starts to transmit when it has received at least 
one serial input data byte.

If RTS is detected (high at PC end), the radio starts transmit-
ting. 

If RTS is detected and input buffer is empty, the radio will 
keep transmitting (carrier + signalling only).

If RTS is detected and input buffer is not empty, the radio 
sends the received data in a block format.

If RTS is off (low at PC end) and input buffer is not empty, 
the radio will send data until the input buffer becomes 
empty. Once empty, the radio will stop transmitting after 
approximately 20ms.

NOTE: If the option "Inhibit RTS Signal" is ticked, then 
when RTS is on without any input serial data, the radio does 
not start transmitting. 
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Inhibit CTS Signal
The Inhibit CTS Signal field applies to the Tait Radio 
Modem only.

Clear to Send (CTS) and Request to Send (RTS) are serial 
communication handshaking signals and are only operational 
when the radio operates in transparent mode. In transparent 
mode, the radio acts as a modem, automatically retransmit-
ting data it receives. CTS is an output signal from the Tait 
Radio Modem, indicating that no further serial data should 
be sent to the radio.

When the Tait Radio Modem cannot receive any more serial 
data, the CTS signal from the Tait Radio Modem switches 
off (low at PC end).

CTS switches off (low at PC end) if the channel becomes 
BUSY, during the Data Lead In Delay, or if the input buffer 
exceeds 40 bytes from a total 60 byte buffer.

If the PC application software continues to send data while 
the CTS line is off, the data will continue to be stored until 
the 60 byte maximum. After that time incoming data will be 
ignored until there is room in the input buffer. CTS will turn 
on again when the buffer gets back to below 40 bytes.

At all other times the CTS is on (high at PC end).

NOTE: If the option "Inhibit CTS Signal" is ticked, then 
CTS will always be on, regardless of the above conditions for 
CTS-OFF.

SDM Option
When the SDM Option field is enabled, the radio can send 
and receive short data messages (SDMs).

All radios can send and receive SDMs while connected to 
some form of computer equipment. Orca Excel, Orca 
Eclipse and Orca 5020 radios can display received SDMs on 
the radio display. On Orca Eclipse and Orca 5020 radios, 
SDMs can also be entered via the radio keypad.

SDM Auto Acknowledge
When the SDM Auto Acknowledge field is enabled, the 
radio sends an auto acknowledge when it receives a short 
data message (SDM).

SDM Auto Acknowledge Delay
The SDM Auto Acknowledge Delay field sets the delay 
between receiving a short data message (SDM) and sending 
an auto acknowledge.

Set a value from 100 to 12,000 ms in steps of 100 ms.

auto acknowledge

When a radio receives a Selcall 
sequence that contains its identity, it 
can be programmed to transmit an 
auto acknowledge sequence.



© Copyright Tait Electronics Ltd, 2004  Data Parameters Form 111

SDM Wait For Acknowledgement
The SDM Wait For Acknowledgement field sets the delay  
before the radio indicates that transmission of the short data 
message (SDM) has failed, if no auto acknowledge response 
is received.

Set a value from 1 to 20 seconds in steps of 1 second.

Data Identity
The Data Identity field sets the radio’s identity for operation 
in CCDI mode.

The data identity must be 8 characters in length. Enter an 
identity using characters from A to Z, 0 to 9 and *

Data Lead In Delay
The Data Lead In Delay field sets duration of the lead-in 
delay for all CCDI mode transmissions.

Set a value from 40 to 5100 ms in steps of 20 ms.

Ignore Subaudible Signalling
The Ignore Subaudible Signalling field determines whether 
the radio requires valid subaudible signalling before process-
ing a data transmission. 

� Enabled: All incoming data transmissions are processed 
regardless of subaudible signalling.

� Disabled: The radio only processes incoming data trans-
missions for which the subaudible signalling is valid.

subaudible signalling

Subaudible signalling is signalling 
that is at the bottom end of the range 
of audible frequencies. Tait Orca 
radios support CTCSS and DCS 
subaudible signalling.
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Part 6: Radio Interface Options
This part contains detailed information setting radio interface options, 
such as function key settings and user menu options.

Forms

� User Defined Menu Form

� Key Settings Form

� User Selectable Parameters Form

� General Options form
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User Defined Menu Form

Items that appear in the user menu of Orca 5020 radios are 
set in the User Defined Menu form. The User Defined 
Menu form is shown below.The information displayed is the 

information that will appear in the radio’s user function 
menu. Ticking a top-level menu (for example, USER SET-
TINGS) will enable all of that menu’s submenu functions, 
and unticking a top-level menu will disable all submenu 
functions.

Enable All/Disable All
Click the Enable All button to enable all menu items, or the 
Disable All button to disable all menu items.

Menu Labels
You can edit the menu labels by entering a password in the 
box at the top of the form. If you do not have a password, 
contact your local Tait office. 

Restore Default Text
If menu labels have been changed and you wish to use the 
default text, click the Restore Default Text menu button. 

Save as Default Text
If you wish to save a different set of menu labels as the 
default, click the Save as Default Text button.
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Restore Factory Settings
To restore the radio’s factory settings, click the Restore Fac-
tory Settings button.

Menu Options
The availability of some items depends on the value of fields 
in other forms. The functions available are outlined below:

Menu Option: QUEUED CALLS

Description:
The QUEUED CALLS: menu option accesses the call 
queue. The radio only displays this option when at least one 
call has been queued.

This menu option is available when the field Received Call 
Queuing (Selcall Features form) is enabled. 

Menu Option: SELECT CHANNEL

Description:
The SELECT CHANNEL menu option allows the user to 
view and select from the list of channels.

Alternatives:
Channels numbered 1 to 16 are automatically accessible from 
the 16-way selector.

Menu Option: SELECT BANK

Description:
The SELECT BANK menu option allows the user to select 
a new channel bank. Channels can be accessed within the 
bank using the scroll keys, or the 16-way selector. This 
option must be enabled when the 16-way Selector Mode is 
set to Channel Selection.

Menu Option: DIAL SELCALL

Description:
The DIAL SELCALL menu option accesses Selcall dialling 
in which the user can dial a Selcall sequence. The Variable 
Call Sequence (Selcall Sequences (Tx) tab) must be defined 
before Selcall dialling is enabled.
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Menu Option: SELECT STATUS

Description:
The SELECT STATUS menu option allows the user to 
view and select from a list of status labels. The selected status 
label’s status digit will be transmitted the next time a Selcall 
call is made that includes variable status. 

Menu Option: SEND DTMF

Description:
The SEND DTMF menu option accesses DTMF dialling 
mode where the user can make DTMF calls.

Menu Option: ALPHA SYMBOLS

Description:
The ALPHA SYMBOLS menu option allows the user to 
select from the list of alpha symbols programmed for the 
radio. To select this option, an alpha symbol must first be 
defined in the Alpha Symbols form.

Menu Option: SEND SDM

Description:
The SEND SDM menu option accesses SDM entry mode in 
which the user can enter and send a short data message 
(SDM). To select this option, short data messaging must be 
enabled in the Data Parameters form.

Menu Option: HANDSET

Description:
The HANDSET menu option turns handset operation on 
and off.

Handset mode automatically turns off after the handset inac-
tivity timer expires. The handset inactivity timer is set in the 
Key Settings II tab.

Menu Option: LOW PWR

Description:
The LOW PWR menu option allows the user to turn the 
low power transmit feature on and off. Low power transmit 
overrides the power level setting programmed for the chan-

handset operation

Tait Orca radios can be operated as a 
normal radio where the user holds the 
radio with the microphone about 15 
cm away from the mouth or it can be 
operated like a telephone handset. 
Handset mode is useful in noisy envi-
ronments, when privacy is required or 
in quiet environments when the lowest 
volume setting seems too loud.
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nel in the Channels form so that the radio transmits at low 
power. 

Alternatives:
Channels can be programmed to always transmit at low 
power (Power Level field, Channels form). 

Menu Option: KEYLOCK

Description:
The KEYLOCK menu option allows the user to lock the 
keypad so the keys cannot be activated accidentally. Which 
keys are locked depends on how the radio was programmed 
(Keypad Lock Disables, Key Settings II tab).

A long press of the clear key ( ) turns off keypad lock. 

Menu Option: DTMF

Description:
The DTMF menu option allows the user to change the 
DTMF dialling type, which can be normal dialling or buff-
ered dialling.

Menu Option: ECONOMY

Description:
The ECONOMY menu option allows the user to turn 
economy mode on and off.

Menu Option: SQUELCH

Description:
The SQUELCH menu option allows the user to change the 
squelch threshold, which can be city squelch or country 
squelch.

Menu Option: MONITOR

Description:
The MONITOR menu option allows the user to turn mon-
itor on and off.

Menu Option: SQ OVRD

Description:
The SQ OVRD menu option allows the user to turn squelch 
override on and off.

monitor

Monitor allows the radio user to over-
ride a channel’s signalling and so hear 
all traffic on a channel.squelch

The squelch feature ensures that the 
radio’s speaker only unmutes when 
an intelligible signal is received. A sig-
nal is considered intelligible when it is 
strong enough to exceed a predeter-
mined squelch threshold.
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Menu Option: TONES

Description:
The TONES menu option allows the user to turn audible 
indicators on and off.

Menu Option: LEVEL

Description:
The LEVEL menu option allows the user to change the level 
of audible indicators. There are two options: HIGH and 
LOW.

Menu Option: KEYTONE

Description:
The KEYTONE menu option allows the user to turn key-
press confidence tones on and off.

Menu Option: NIGHT

Description:
The NIGHT menu option allows the user to turn night use 
on and off.

Menu Option: RSSI

Description:
The RSSI menu option allows the user to turn the display of 
the RSSI indicator on and off.

Menu Option: ADJUST CONTRAST

Description:
The ADJUST CONTRAST menu option allows the user to 
adjust the contrast of the LCD display.

Menu Option: PROGRAM GROUP

Description:
The PROGRAM GROUP menu option allows the user to 
access the programmable scanning and voting groups feature.

keypress confidence tones

Keypress confidence tones are a confi-
dence indicator that tells the radio user 
whether or not an action is permitted 
whenever a keypad key or function 
key is pressed.

night use

When the night use feature is on, the 
radio’s backlighting activates when-
ever valid activity is detected, a key on 
the radio is pressed or when the radio 
receives a call. Backlighting remains 
on for the duration of the backlighting 
timer unless further activity is 
detected.
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Menu Option: PROGRAM SIGNAL

Description:
The PROGRAM SIGNAL menu option allows the user to 
access the programmable channel signalling feature.

Menu Option: FW VER

Description:
The FW VER menu option allows the user to view the radio 
firmware version number.

Menu Option: HW VER

Description:
The HW VER menu option allows the user to view the 
radio hardware version number.

Menu Option: MAIN DB

Description:
The MAIN DB menu option allows the user to view the 
programming software database version number.

Menu Option: CAL DB

Description:
The CAL DB menu option allows the user to view the cali-
bration database version number.
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Key Settings Form

Function key, handset mode and keypad lock options are set 
in the Key Settings form.

The Key Settings form is divided into two tabs.

� Set function key options, including external function 
keys, in the Key Settings I tab.

� Set handset mode and keypad lock options in the Key 
Settings II tab.

Key Settings I Tab
Set function key options, including handset mode options, in 
the Key Settings I tab. The Key Settings I tab is shown 
below.

Function Key Settings
Each radio has two function keys above the PTT key. Orca 
5020 radios have a third function key, which is the leftmost 
key in the row of four keys underneath the LCD display. 

These radio function keys can have functions assigned to 
both short and long keypresses. A short keypress is less than 
one second. The radio user may need to experiment to 
become familiar with the duration of short and long key-
presses.

The third function key on Orca 5020 radios can also be oper-
ated as a “shortcut” to up to three user function menu 
options. The shortcut menu is a wrap around menu, with 
one press of the third function key accessing the option that 
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was last selected, and each subsequent press selecting the next 
option in a continuous loop. The user function menu 
options that will appear in the drop-down lists are those that 
are ticked in the User Defined Menu form.

Some radio accessories also have function keys, and most of 
the options available for the radio function keys are also avail-
able for external function keys.

Function Key Option: Audible Indicators

Description:
Pressing the function key turns audible indicators on and off. 
Whether audible indicators are on or off when the radio 
powers up is determined by the Initial Setting for the Audible 
Indicators field (User Selectable Parameters form).

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Eclipse and Orca 5020 radios, audible indicators 
can be turned on and off from the user function menu.

Function Key Option: Backlighting On/Off

Description:
Pressing the function key activates display backlighting. 
Backlighting deactivates when the backlighting timer 
expires.

Applies To:
✘ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✘ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
When the night use feature is on, the radio’s backlighting is 
activated whenever valid activity is detected, a key on the 
radio is pressed or when the radio receives a call.
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Function Key Option: Channel’s DTMF Preset

Description:
Pressing the function key transmits the DTMF preset call 
assigned to the current channel.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Excel and Eclipse radios, a long press of the DTMF 
key transmits the DTMF preset call assigned to the channel 
the radio is currently on.

Function Key Option: Contrast

Description:
Pressing the function key allows the radio user to adjust the 
display contrast using the scroll key(s). The radio automati-
cally returns to its previous mode of operation after a few sec-
onds of inactivity. The contrast can be reset to the default by 
pressing and holding Function Key 2 while turning the radio 
on.

Applies To:
✘ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✘ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Eclipse and Orca 5020 radios, the contrast adjust 
feature is available from the user function menu. For the 
Orca Eclipse, to allow the radio user to adjust contrast via the 
user function menu, tick the In User Menu? box for the 
Contrast Adjustment field (User Selectable Parameters form). 
For the Orca 5020, select the ADJUST CONTRAST 
option from the User Defined Menu Form.
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Function Key Option: Disable Monitor

Description:
Pressing the function key deactivates monitor, if it is active.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Excel and Eclipse radios, a short press of the mon-
itor key (Orca Excel: , Orca Eclipse: ) disables monitor. 
On Orca 5020 radios, monitor can be disabled via the user 
function menu.

The radio can be programmed so that monitor is deactivated 
upon the receipt of some Selcall sequences.

Function Key Option: Economy Mode Control

Description:
Pressing the function key turns economy mode on and off. 
Whether economy mode is on or off when the radio powers 
up is determined by the Initial Setting for the Economy 
Mode Control field (User Selectable Parameters form).

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Eclipse and Orca 5020 radios, economy mode can 
be turned on and off via the user function menu.

Function Key Option: Emergency - Selcall

Description:
Pressing the function key transmits the Selcall emergency call 
sequence defined in the Selcall Emergency Setup form and 
puts the radio into emergency mode.

monitor

Monitor allows the radio user to over-
ride a channel’s signalling and so hear 
all traffic on a channel.

emergency mode

When in emergency mode, the radio 
cycles between receiving and transmit-
ting so that the called party can hear 
activity near the radio and so decide 
how to respond. The radio can be pro-
grammed so that all indicators remain 
unchanged while in emergency mode.
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The duration of keypresses for the Emergency option is dif-
ferent than for other function key options and depends on 
the setting of the Double Keypress Activation (Selcall Emer-
gency Setup form). See “Double Keypress Activation” on 
page 80 for more information.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Function Key Option: Emergency - DTMF

Description:
Pressing the function key transmits the DTMF emergency 
call sequence defined in the DTMF ANI tab.

Applies To:
✘ Orca Elan
✘ Orca Excel
✘ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Function Key Option: Fixed Selcall Sequence

Description:
Pressing the function key transmits the fixed call sequence 
defined in the Selcall Sequences (Tx) tab.

Applies To:
✘ Orca Elan
✘ Orca Excel
✘ Orca Eclipse
✔ Orca 5010
✘ Orca 5015
✔ Orca 5020

Function Key Option: Handset Mode

Description:
Pressing the function key turns handset operation on and off.

handset operation

Tait Orca radios can be operated as a 
normal radio where the user holds the 
radio with the microphone about 15 
cm away from the mouth or it can be 
operated like a telephone handset. 
Handset mode is useful in noisy envi-
ronments, when privacy is required or 
in quiet environments when the lowest 
volume setting seems too loud.
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Handset mode automatically turns off after the handset inac-
tivity timer expires. The handset inactivity timer is set in the 
Key Settings II tab.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Eclipse and Orca 5020 radios, handset mode can be 
turned on and off via the user function menu.

Function Key Option: Keypad Lock

Description:
Pressing the function key locks the keypad so the keys cannot 
be activated accidentally. Which keys are locked depends on 
how the radio was programmed (Keypad Lock Disables, Key 
Settings II tab).

On Orca Excel and Orca 5020 radios, a long press of the 
clear key ( ) turns off keypad lock. On Orca Eclipse radios, 
a short press of the on/off/clear key ( / ) turns off keypad 
lock.

Applies To:
✘ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✘ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Eclipse and Orca 5020 radios, keypad lock can be 
activated via the user function menu.

Function Key Option: Low Power

Description:
Pressing the function key overrides the power level setting 
programmed for the channel in the Channels form so that the 
radio transmits at low power. Pressing the function key again 
returns the transmit power to the preprogrammed level. 
Whether low power transmit is on or off when the radio 
powers up is determined by the initial setting for the Set Low 



© Copyright Tait Electronics Ltd, 2004  Key Settings Form 127

Power On All Channels field (User Selectable Parameters 
form).

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
Channels can be programmed to always transmit at low 
power (Power Level field, Channels form). On Orca Eclipse 
and Orca 5020 radios, low power transmit can be activated 
via the user function menu. 

Function Key Option: Night Use

Description:
Pressing the function key turns the night use feature on and 
off. Whether night use is on or off when the radio first pow-
ers up is determined by the Initial Setting for the Night 
Operation Backlighting Level field (User Selectable Parame-
ters form).

Applies To:
✘ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✘ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Eclipse and Orca 5020 radios, night use can be 
turned on and off via the user function menu. 

Function Key Option: Nuisance Delete

Description:
When the radio is scanning and a channel has been captured, 
pressing the function key temporarily deletes the captured 
channel from the scanning regime. When the scan group is 
selected again, the deleted channel is again a member of the 
scan group.

Nuisance delete does not work for voting groups. If no scan 
group is selected when the nuisance delete function key is 
pressed, the radio gives an invalid keypress beep.

night use

When the night use feature is on, the 
radio’s backlighting activates when-
ever valid activity is detected, a key on 
the radio is pressed or when the radio 
receives a call. Backlighting remains 
on for the duration of the backlighting 
timer unless further activity is 
detected.
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Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Function Key Option: One Touch

Description:
Pressing the function key carries out the set of commands 
specified by the first alpha symbol defined in the Alpha Sym-
bols form.

A one touch call can be useful when, for example, Radio A 
regularly calls Radio B via a preset Selcall call, which is 
assigned to a short press of function key 1. Radio A must first 
be switched to the correct channel in order for the call to be 
made. If the call is assigned as the one touch call, the radio 
automatically switches the radio to the correct channel and 
transmits the call after a single keypress. The advantage of 
using the one touch call is that the user does not need to 
remember which channel has the correct Selcall system 
assigned. However, for that function key setting, the one 
touch call is the only call available, whereas if the preset call 
function key option were used, a different call could be 
assigned to different channels.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Eclipse and Orca 5020 radios, an alpha symbol can 
be selected via alphanumeric entry mode. 

Function Key Option: Preset Call

Description:
Pressing the function key transmits the preset Selcall call 
assigned to the current channel. The Selcall sequence trans-
mitted is that defined for the selected Function Key Preset 
Call (Selcall Sequences (Tx) tab).

There are two function key preset calls available on each 
channel.

alpha symbol

An alpha symbol is a sequence of 
commands that, depending on the 
radio type, can change to a specific 
channel, dial a Selcall or DTMF call, 
change the radio’s status or any com-
bination of these three tasks.
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Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
On Orca Excel and Eclipse radios, per channel Selcall calls 
can also be transmitted by a long press of the call key. The 
call transmitted is the Fixed Call Sequence (Selcall Sequences 
(Tx) tab) for the Selcall system assigned to the current chan-
nel.

Function Key Option: Repeater Access Tone

Description:
Pressing the function key transmits the repeater access tone 
for the current Selcall system to key up the repeater. If the 
Repeater Access Tone Duration for the current Selcall sys-
tem is set to 0, then pressing the function key has no effect.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
Selcall systems can be programmed so that the repeater access 
tone is transmitted whenever the PTT is pressed during a 
Selcall call.

Function Key Option: Repeater Talk Around

Description:
Pressing the function key allows the radio user to bypass nor-
mal repeater operation and communicate directly with 
another radio. Pressing the function key again or changing to 
another channel turns off repeater talk around. The Repeater 
Talk Around field (Transmitter Setup form) must be enabled 
before the repeater talk around option can be assigned to a 
function key.

repeater talkaround

Repeater talk around allows the radio 
user to bypass repeater operation and 
so communicate directly with other 
radios. While repeater talk around is 
active, all transmissions are made on 
the receive frequency programmed for 
the channel.
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Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
Orca Excel and Eclipse radios can be preprogrammed so that 
a long press of the channel key turns repeater talk around on 
and off. 

Function Key Option: Squelch Override

Description:
Pressing the function key turns squelch override on and off 
so the user can hear all activity on a channel, including noise.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
Orca Excel and Eclipse radios can be programmed so that a 
long press of the monitor key (Orca Excel: , Orca Eclipse: 

) turns squelch override on and off ([MON] Key Long 
Press field, Receive Monitoring form) On Orca 5020 radios, 
squelch override can be turned on and off via the user func-
tion menu.

Function Key Option: Toggle Monitor

Description:
Pressing the function key turns monitor on and off.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

squelch

The squelch feature ensures that the 
radio’s speaker only unmutes when 
an intelligible signal is received. A sig-
nal is considered intelligible when it is 
strong enough to exceed a predeter-
mined squelch threshold.
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Alternatives:
Orca Excel and Eclipse radios can be programmed so that a 
short press of the monitor key (Orca Excel: , Orca Eclipse: 

) turns monitor on and off ([MON] Key Short Press field, 
Receive Monitoring form). On Orca 5020 radios, monitor 
can be turned on and off via the user function menu.

 

Function Key Option: Increase Volume/Decrease Volume

Description:
Allows the volume to be adjusted using the external function 
keys.

Applies To:
✔ External Funtion Key 1 and 2
✘ Orca Elan
✘ Orca Excel
✔ Orca Eclipse
✘ Orca 5010
✘ Orca 5015
✘ Orca 5020

Function Key Option: Program Flexiscan

Description:
Pressing the function key allows the user to enter Flexiscan 
programming mode. In Flexiscan programming mode,  
group membership can be changed. Flexiscan group mem-
bers are defined in the Scan Groups form (Flexiscan tab).

Applies To:
✘ Orca Elan
✘ Orca Excel
✘ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Function Key Option: Toggle Flexiscan

Description:
Pressing the function key turns Flexiscan on and off.

flexiscan

When Flexiscan scanning is turned 
on, a group of channels in a prepro-
grammed Flexiscan scan group is 
scanned for valid activity, while the 
radio user is able to communicate on 
an unrelated channel.
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Applies To:
✘ Orca Elan
✘ Orca Excel
✘ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020

Alternatives:
Orca 5020 radios can be programmed so that Flexiscan is 
turned off when the PTT key is released (the Scan After PTT 
field is checked, Flexiscan tab).

Function Key Option: Lone Worker

Description:
Pressing the function key activates the lone worker feature 
and begins the Inactivity Timer.

Applies To:
✘ Orca Elan
✘ Orca Excel
✘ Orca Eclipse
✔ Orca 5010
✔ Orca 5015
✔ Orca 5020
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Key Settings II Tab
Set function key options, including handset mode options, in 
the Key Settings II tab. The Key Settings II tab is shown 
below.

Handset Volume Override
The radio can be programmed to use the function keys as 
volume keys while the radio is in handset mode. The volume 
increase and volume decrease settings can be assigned to short 
or long presses of function key 1 and function key 2. The 
programmed settings for the selected keypresses are overrid-
den for use as volume keys while handset mode is active. 
Note that if a function key is set to turn handset mode on and 
off, the application does not allow you to select that function 
key setting for controlling volume in handset mode.

For Orca Eclipse radios, the volume keys used during normal 
operation can also be used while operating the radio in hand-
set mode.

Handset Inactivity Timer
The field Handset Inactivity Timer sets the amount of time 
the radio remains in handset mode if no transmissions are 
made.

Set a value from 0 to 240 seconds in steps of 1 second. If set 
to 0, the timer is disabled and the radio remains in handset 
mode until the user disables it.

Note that when a call is received and handset mode is active, 
the ringing volume is also reduced. While handset mode is 
active, the user may not hear received calls due to the low 
ringing volume. You may wish to set Handset Inactivity 
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Timer to a value other than 0 in order to minimise the 
chances of missing calls because handset mode is active.

Keypad Lock Disables
Keypad lock is available on Orca 5015, Orca Excel, Orca 
Eclipse and Orca 5020 radios. 

The Keypad Lock Disables fields determine what keys the 
keypad lock disables when it is activated. Keys that can be 
disabled are:

� PTT key

� function keys

� numeric and alphanumeric keys

� < and > keys (Orca Eclipse only)

NOTE: < and > keys for the Orca 5020 are locked using 
the menu/mode keys option.

� an external PTT key, e.g. on a lapel microphone

� external function keys

� menu/mode keys

� volume keys (Orca Eclipse only)

Tick the box for each of the keys you wish to be disabled 
when the keypad lock is activated.

The power on/off and monitor keys can never be locked.

keypad lock

The keypad lock prevents accidental 
operation of the radio by locking the 
keypad so that only a certain set of 
keys can be used.
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User Selectable Parameters Form

Initial settings for various radio features and options for the 
Orca Eclipse’s user function menu are set in the User 
Selectable Parameters form. The User Selectable Parameters 
form is shown below:.

NOTE: For each parameter, the Initial Setting field is the 
value the field is set to when the radio is programmed.

On Orca Eclipse radios, the value of all parameters in the 
User Selectable Parameters form can be changed via the user 
function menu. To place a feature in the user function menu, 
tick the In User Menu? box for the required feature.

The options available and how to add them to the user menu 
are outlined in the table below.

Table 4: Adding options to the user menu of Orca Eclipse radios

Display Settings Description To Add Option to User Menu:

KEYTONE ON/OFF Turns keypress confidence 
tones on and off.

User Selectable Parameters form: Tick 
the In User Menu? box for Keypress 
Confidence Tones.

SOUND ON/OFF Turns audible indicators, 
including keypress confidence 
tones, on and off.

User Selectable Parameters form: Tick 
the In User Menu? box for Audible Indi-
cators.

SOUND HIGH/LOW Changes the level of audible 
indicators, including keypress 
confidence tones.

User Selectable Parameters form: Tick 
the In User Menu? box for Audible Indi-
cators Level.
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 Keypress Confidence Tones
The Keypress Confidence Tones field enables and disables 
keypress confidence tones. Tick the Initial Setting box to 
enable keypress confidence tones.

DTMF NORMAL/
BUFFERED

Switches the DTMF dialling 
type between NORMAL and 
BUFFERED.

User Selectable Parameters form: Tick 
the In User Menu? box for DTMF Dial-
ling Type.

ECONOMY ON/OFF Turns economy mode on and 
off (requires Power Save Fea-
tures to be enabled by setting 
an Economy Mode Timer).

User Selectable Parameters form: Tick 
the In User Menu? box for Economy 
Mode Control.

SQUELCH COUNTRY/
CITY

Switches the squelch settings 
for all channels between 
COUNTRY and CITY. Note that 
the use of this option switches 
all channels to the setting 
selected, regardless of the pro-
grammed squelch level.

User Selectable Parameters form: Tick 
the In User Menu? box for Squelch Set-
ting Control.

RSSI ON/OFF Turns the RSSI indicator on and 
off.

User Selectable Parameters form: Tick 
the In User Menu? box for RSSI Indica-
tor.

HANDSET ON/OFF Turns handset mode on and 
off.

User Selectable Parameters form: Tick 
the In User Menu? box for Handset 
Mode Switch.

LIGHT ON/OFF Turns night use on and off. User Selectable Parameters form: Tick 
the In User Menu? box for Night Opera-
tion Backlighting Level.

LOW PWR ON/OFF Turns low power transmit on 
and off.

User Selectable Parameters form: Tick 
the In User Menu? box for Low Power 
Transmit Control.

KEYPAD LOCKED/
UNLOCKED

Turns keypad lock on and off. User Selectable Parameters form: Tick 
the In User Menu? box for Keypad Lock 
Control.

CALL QUEUE Accesses 
sub-menu

Accesses the call queue. This 
option is only available when at 
least one call has been queued.

Selcall Features form: Enable Automatic 
Caller Identification and Received Call 
Queuing.

PROGRAM 
GROUP

Accesses 
sub-menu

Accesses the programmable 
scanning and voting groups 
feature.

Scan Group Members tab: Specify at 
least one scan group as User Yes.

PROGRAM 
SIGNAL

Accesses 
sub-menu

Accesses the programmable 
channel signalling feature.

Channel Signalling Presets form: Define 
at least one programmable channel sig-
nalling preset pair.

CONTRST 
ADJUST

Access mode Access the contrast adjust-
ment feature.

User Selectable Parameters form: Tick In 
User Menu? box for Contrast Adjust.

Table 4: Adding options to the user menu of Orca Eclipse radios

Display Settings Description To Add Option to User Menu:

keypress confidence tones

Keypress confidence tones are a confi-
dence indicator that tells the radio user 
whether or not an action is permitted 
whenever a keypad key or function 
key is pressed.
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Note that if the Audible Indicators Initial Setting field is not 
ticked, keypress confidence tones are disabled, regardless of 
the setting of Keypress Confidence Tones.

The volume of keypress confidence tones is set in the Audi-
ble Indicator Level field.

Audible Indicators
The Audible Indicators field enables and disables audible 
indicators such as keypress confidence tones and other warn-
ings. This field does not affect DTMF and Selcall sidetones. 
Tick the Initial Setting box to enable audible indicators.

The setting of this field overrides that of the Keypress Con-
fidence Tones field.

Audible Indicator Level
The Audible Indicator Level field sets the volume of the 
radio’s audible indicators. Select High or Low. If the field 
Audible Indicators is disabled, then the setting of this field has 
no effect.

DTMF Dialling Type
If for Orca Eclipse radios you wish the radio user to be able 
to change the DTMF dialling type, tick the In User Menu? 
box for DTMF Dialling Type. The default DTMF dialling 
type is set in the DTMF form.

Economy Mode Control
The Economy Mode Control field determines whether or 
not economy mode is enabled when the radio first powers 
up. Economy mode is set up in the Power Save Features 
form. Tick the Initial Setting box to enable economy mode 
when the radio powers up.

Squelch Setting Control
If for Orca Eclipse radios you wish the radio user to be able 
to change the squelch setting, tick the In User Menu? box for 
Squelch Setting Control. The initial squelch setting for each 
channel is set in the Channels form.

RSSI Indicator
The RSSI Indicator field applies only to Orca Excel, Orca 
Eclipse, Orca 5015 and Orca 5020 radios and enables and 
disables the RSSI indicator. Tick the Initial Setting box to 
enable the RSSI indicator.

audible indicators

Audible indicators include keypress 
confidence tones, received call signals, 
low battery and high temperature 
warnings, transmit timer and unan-
swered call signals.

DTMF dialling type

When a DTMF string is dialled, the 
string is either transmitted as each 
individual key is pressed (normal 
dialling) or in its entirety once the 
enter key is pressed (buffered dialling).

economy mode

Economy mode reduces the radio’s 
power consumption when it is idle. 
When economy mode is active, and 
there has been no valid activity on a 
channel for the duration of the econ-
omy mode timer, the radio begins 
economy cycling.
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Handset Mode Switch
If for Orca Eclipse radios you wish the radio user to be able 
to enable and disable handset operation via the user function 
menu, tick the In User Menu? box.

Night Operation Backlighting Level
The Night Operation Backlighting Level field enables the 
night use feature. Tick the Initial Setting box to enable night 
use. 

For more information, see:

� “Reducing Power Consumption on Tait Orca Radios” 
on page 164

� “Economy Mode” on page 164

� “Backlighting” on page 166

Contrast Adjustment
If for Orca Eclipse radios you wish the radio user to be able 
to adjust contrast via the user function menu, tick the In User 
Menu? box.

A function key can also be programmed to access the contrast 
adjustment function.

Set Low Power On All Channels
The Set Low Power On All Channels field determines 
whether all transmissions are made at low power or at the 
power level programmed for a channel. Tick the Set Low 
Power On All Channels box if all transmissions are to made 
at low power by default when the radio first powers up.

For Orca Eclipse radios, select the In User Menu? box to add 
LOW PWR to the user function menu. Orca 5020 radios 
can enable or disable low power transmit via the user func-
tion menu on the User Defined Menu Form, by ticking the 
LOW PWR box.

All radios can enable or disable low power via a function key. 
This is defined by using the Low Power option on the Key 
Settings I Tab.

Keypad Lock Control
If for Orca Eclipse radios you wish the radio user to be able 
to enable and disable the keypad lock via the user menu, tick 
the in User Menu? box.

Which keys are disabled when keypad lock is on is set in the 
Key Settings II tab.

handset operation

Tait Orca radios can be operated as a 
normal radio where the user holds the 
radio with the microphone about 15 
cm away from the mouth or it can be 
operated like a telephone handset. 
Handset mode is useful in noisy envi-
ronments, when privacy is required or 
in quiet environments when the lowest 
volume setting seems too loud.

contrast adjustment

The contrast adjustment feature 
allows the radio user to adjust the dis-
play contrast. Once activated, the 
radio user adjusts contrast using the 
scroll keys. The radio returns to its 
previous mode of operation after a few 
seconds of inactivity.

keypad lock

The keypad lock prevents accidental 
operation of the radio by locking the 
keypad so that only a certain set of 
keys can be used.
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Flexiscan
Orca 5010/5015/5020 radios only.

The Flexiscan field determines whether Flexiscan is enabled 
when the radio is first switched on.

flexiscan

When Flexiscan scanning is turned 
on, a group of channels in a prepro-
grammed Flexiscan scan group is 
scanned for valid activity, while the 
radio user is able to communicate on 
an unrelated channel.
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General Options form

Set options that apply to both Selcall and DTMF, as well as 
other radio options, in the General Options form (Orca 
5010/5015/5020 radios only). The General Options form is 
shown below.

Call Type
Call Type is part of the lone worker feature, and sets the type 
of emergency action that will be initiated after both the inac-
tivity and warning timers have expired. Select DTMF to ini-
tiate a DTMF emergency call defined in the DTMF ANI 
Tab, or Selcall to initiate a Selcall emergency call defined in 
the Selcall Emergency Setup Form.

Inactivity Timer
The Inactivity Timer is part of the lone worker feature, and 
sets the time from when the radio user presses the function 
key, to when the Warning Timer starts. Pressing any key 
during this time will restart the timer. Enter a time from 1 to 
60 minutes.

Warning Timer
The Warning Timer is part of the lone worker feature, and 
sets the time from when the Inactivity Timer has timed out, 
to when the radio calls the sequence indicated by the Call 
Type field. An audible alert will sound for the duration of the 
warning timer. Pressing any key during this time will cancel 

lone worker

Lone worker is a feature in Orca 
5010, Orca 5015 and Orca 5020 
radios. When activated, the radio 
begins a pre-programmed inactivity 
timer. Once this time has counted 
down with no keypress (or motion 
detected if programmed), an audible 
alert will sound for the length of the 
warning timer. If no key is pressed in 
this time (or motion detected), then 
either a Selcall or DTMF emergency 
call is made. 
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the Warning Timer and restart the Inactivity Timer. Enter a 
time between 15 and 240 seconds.

Man Down Accessory Connected
The Man Down Accessory Connected field determines how 
user activity is monitored by the radio after lone worker has 
been activated. User activity resets the Inactivity Timer or 
Warning Timer. If the box is ticked, the inactivity or warn-
ing timers will be reset if motion is detected or a key is 
pressed.

NOTE: A man down motion sensor accessory must be fitted 
to the radio for this option to be valid.
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Part 7: Reference
This part outlines basic concepts related to the Conventional Pro-
gramming Application.

Appendices

� Appendix A: Introduction to Channels and Scan Groups

� Appendix B: Introduction to Selcall

� Appendix C: Introduction to DTMF

� Appendix D: Reducing Power Consumption on Tait Orca Radios

� Appendix E: What’s New - Orca 5000 Series
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Appendix A: Introduction to Channels and 
Scan Groups

This section contains basic concepts related to channels and 
scan groups. 

Squelch and Signalling: Filtering Out 
Unwanted Noise and Traffic
Without some mechanism for filtering what the radio broad-
casts to the user, the radio’s speaker would operate continu-
ously and the user would hear not only any speech on a chan-
nel, but also all noise. This would be annoying for the radio 
user and so the radio filters out unwanted signals using vari-
ous methods.

Squelch
At the most basic level, the squelch feature ensures that the 
speaker only unmutes when an intelligible signal is received. 
A signal is considered intelligible when it is strong enough to 
exceed a predetermined squelch threshold.

Tait Orca radios can operate at two different squelch thresh-
olds, city squelch and country squelch. The specific values of 
city and country squelch are set at radio calibration time, but 
are generally:

� country: 12 dB SINAD

� city: 16 dB SINAD

The squelch threshold for city squelch is higher than that for 
country squelch so that the radio is effectively less sensitive 
on channels programmed with city squelch than on channels 
programmed with country squelch. City squelch is intended 
for use in environments where signal strength is likely to be 
strong throughout the area where the radio is operating and 
where a high level of background noise could cause the 
speaker to unmute for unintelligible signals were it set to a 
lower squelch threshold. Country squelch is intended for use 
in lower signal strength areas.

Programming Squelch Thresholds
At radio programming time, channels are programmed for 
either city or country squelch in the Channels form. A radio 
can have a mix of city and country squelch channels, which 
can be useful if a radio is going to be used in both high and 
low signal strength areas.

For example, two channels could be set up with the same 
transmit and receive frequencies and subaudible signalling 
but with different squelch levels. Both channels would have 
the same traffic and the radio operator could tune in to the 



146 Introduction to Channels and Scan Groups   © Copyright Tait Electronics Ltd, 2004

city channel while they were close to the repeater. If the sig-
nal started to become less intelligible as the user started to 
move away from the repeater, they could switch to the 
country channel. If the signal became too weak to be intelli-
gible on the country channel, they could then use squelch 
override. See “Squelch Override” below for more informa-
tion.

Squelch Override
Squelch override allows the user to disable the radio’s squelch 
and so hear all traffic on a channel, including noise.

Squelch override is useful in areas where signal strength is too 
weak to continually exceed the preprogrammed squelch 
threshold and so activate the speaker. If radio users are regu-
larly operating in environments where the signal received at 
the country squelch level regularly cuts out, consider pro-
gramming the radio for squelch override.

Mutes
A mute, or squelch, controls the circumstances under which 
a received signal is passed to the radio’s speaker. When a 
mute is active, the radio’s speaker only unmutes under cer-
tain conditions, determined by the type of signalling operat-
ing on a channel. On Tait Orca radios, there are two types 
of mute.

� Subaudible signalling mute/squelch: The radio unmutes 
when a signal is received that has subaudible (CTCSS and 
DCS) signalling the radio recognises. See “CTCSS and 
DCS” below for more information.

� Selcall signalling mute/squelch: The radio unmutes when 
a signal is received that matches the radio’s Selcall iden-
tity. See “Selcall” on page 148 for more information.

Signalling
Squelch ensures that the radio user only hears intelligible sig-
nals, but the user hears all traffic on a channel. This could 
become a nuisance, particularly if several companies are using 
the same channel. Signalling provides a way of isolating 
groups of users so they only hear traffic intended for that 
group. It does not provide privacy since anyone tuning to a 
channel can hear its traffic if they wish, but it does minimise 
the possibility of radio users hearing nuisance traffic.

Signalling is non-voice coding on a channel for the purpose 
of identifying parties and/or segregating user groups. If a 
radio receives signalling that matches that programmed for 
the radio, the signalling is said to be valid and the radio’s 
mute opens. Otherwise, the transmission is ignored and the 
radio remains silent, although the radio’s channel busy indi-
cator is activated.
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The types of signalling available for Tait Orca radios are 
CTCSS, DCS and Selcall. Each channel can be programmed 
with different types of signalling, and subaudible signalling 
and Selcall signalling can be used on the same channel.

CTCSS and DCS
CTCSS and DCS use subaudible signalling to segregate 
groups of users by transmitting additional information with 
normal speech.

For CTCSS the additional information is transmitted in the 
form of subaudible tones in the frequency band 67 to 250.3 
Hz. For DCS the additional information is transmitted as 
digital data using frequencies between 10 and 134 Hz.

Subaudible signalling is assigned on a per channel basis (in the 
Channels form), and each channel can have different receive 
and transmit signalling. 

Tables 5, 6 and 7 show the CTCSS frequencies and DCS 
codes Tait Orca radios support.

CTCSS

continuous tone controlled squelch sys-
tem

DCS

digitally coded squelch

Table 5: CTCSS Tone Frequencies Supported by Tait Orca Radios

67.0 77.0 88.5 100.0 114.8 131.8 151.4 173.8 203.5 233.6

69.3 79.7 91.5 103.5 118.8 136.5 156.7 179.9 210.7 241.8

71.9 82.5 94.8 107.2 123.0 141.3 162.2 186.2 218.1 250.3

74.4 85.4 97.4 110.9 127.3 146.2 167.9 192.8 225.7

Table 6: Standard DCS Codes and Their Inverses

Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv

023 : 047 073 : 506 156 : 265 261 : 732 365 : 125 503 : 162 654 : 743

025 : 244 074 : 174 162 : 503 263 : 205 371 : 734 506 : 073 662 : 466

026 : 464 114 : 712 165 : 251 265 : 156 411 : 226 516 : 432 664 : 311

031 : 627 115 : 152 172 : 036 271 : 065 412 : 143 532 : 343 703 : 565

032 : 051 116 : 754 174 : 074 306 : 071 413 : 054 546 : 132 712 : 114

043 : 445 125 : 365 205 : 263 311 : 664 423 : 315 565 : 703 723 : 431

047 : 023 131 : 364 223 : 134 315 : 423 431 : 723 606 : 631 731 : 155

051 : 032 132 : 546 226 : 411 331 : 654 432 : 516 612 : 346 732 : 261

054 : 413 134 : 223 243 : 351 343 : 532 445 : 043 624 : 632 734 : 371

065 : 271 143 : 412 244 : 025 346 : 612 464 : 026 627 : 031 743 : 654

071 : 306 152 : 115 245 : 072 351 : 243 465 : 331 631 : 606 754 : 116

072 : 245 155 : 731 251 : 165 364 : 131 466 : 662 632 : 624
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Selcall
Selcall (selective calling) uses sequences of audible tones to 
isolate calls in a manner similar to CTCSS and DCS. How-
ever, Selcall also allows individual radios to have a unique 
identity and so calls can be directed to specific individuals 
within a group of radio users.

Selcall systems are assigned on a per channel basis (in the 
Channels form). Selcall systems are set up in the Selcall Iden-
tity and Setup form, and various Selcall functions are set up 
in the Selcall Features, Selcall Emergency Setup, Selcall Rx 
Decode Setup, Selcall Control Status Definitions and Cus-
tom Selcall Tone Set forms. More detailed information on 
Selcall starts on page 153.

Monitor: Listening In On Channel 
Traffic
Monitor allows the radio user to override a channel’s signal-
ling mutes and so hear all traffic on a channel. 

When monitor is active, the mute is said to be open, or 
unmuted. When monitor is inactive, the radio is said to be in 
the quiet state, or muted.

Which mutes (subaudible signalling mute, Selcall signalling 
mute) monitor disables is set in the Monitor Function Disa-
bles field (Receive Monitoring form). 

Introduction to Scan Groups
A scan group is a group of two to 16 channels. Each channel 
that belongs to a scan group is called a member channel. Each 
member channel in a scan group is routinely sampled for 
valid activity (scanning) or greatest signal strength (voting).

There are three types of scanning and four types of voting 
available on Tait Orca radios. See “Scanning” below and 
“Voting” on page 150 for more information.

Scanning
In scanning, a group of channels is systematically sampled for 
activity. The member channels are scanned in the order in 

Table 7: Commonly Used DCS Codes and Their Inverses

Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv

017 : 050 122 : 225 246 : 523 274 : 145 446 : 255 462 : 252

036 : 172 145 : 274 252 : 462 325 : 526 452 : 053 523 : 246

050 : 017 212 : 356 255 : 446 332 : 455 454 : 266 526 : 325

053 : 452 225 : 122 266 : 454 356 : 212 455 : 332

Selcall system

A Selcall system is the call sequence 
formats and tone options the radios on 
that system must use to communicate 
with one another.

valid activity

Valid activity is traffic on a channel 
that carries signalling that matches 
that programmed for the receiving 
radio. The radio’s mute opens upon 
detecting valid activity.
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which they are assigned to the scan group (Scan Group 
Members tab).

The main benefit of scanning is that all channels of interest 
can be sampled for activity in a regular sequence. However, 
scanning takes a finite time (120 ms per channel, plus up to 
350 ms for channels with subaudible signalling) to sample 
each member channel and so a short call could be missed 
within a large multi-member group.

Each scan group has a limited number of channels. Coverage 
of a large number of channels can be accomplished using sev-
eral scan groups.

Types of Scanning
There are three types of scanning available, and the type of 
scanning for a particular group is set in the Group Type field 
of the Scan Group Members tab. The three types of scanning 
are:

� Scanning (S)

� Priority Scanning (PS)

� Dual Priority Scanning (DPS)

Scanning (S)
When Group Type is S (scanning), the radio scans all mem-
ber channels to find a channel that is busy and has valid sig-
nalling. When valid activity is found, that channel is made 
the captured channel. No further scanning takes place until 
there is no longer activity on the captured channel.

Priority Scanning (PS)
When Group Type is PS (priority scanning), the group’s pri-
ority channel is scanned more frequently than other chan-
nels. If another channel is captured, the radio continues to 
scan the priority channel at regular intervals.

The first member channel assigned to a priority scanning 
group is the highest priority, or P1, channel that is scanned 
in preference to all other channels.

Dual Priority Scanning (DPS)
When Group Type is DPS (dual priority scanning), the radio 
behaves as for Priority Scanning (PS), but there are two 
channels that are given higher priority. If the first priority 
channel is captured, no further scanning takes place. If the 
second priority channel is captured, the first channel contin-
ues to be scanned at regular intervals. If a non-priority chan-
nel is captured, the two priority channels are scanned period-
ically (when the captured sample timer expires).

The first member channel assigned to a dual priority scanning 
group is the highest priority, or P1, channel that is scanned 
in preference to all other channels. The second member 

captured channel

When the radio is scanning a group of 
channels and valid activity is found on 
one of those channels, the radio 
remains on that channel until the 
activity is no longer valid and the 
group hold time has expired or until 
valid activity is found on a higher pri-
ority channel. While the radio is 
stopped on that channel, the channel is 
said to be captured, and transmissions 
are on the captured channel rather 
than on the home channel.

group hold time

The group hold time is the pause 
between when valid activity on a scan 
group member channel ceases and 
when scanning resumes.
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assigned to the group is the next highest priority, or P2, 
channel.

Scanning Regime
The amount of time each channel is sampled depends on 
whether there is signalling on the channel, and on what type 
of signalling it is. When valid activity is found on a channel 
in the scan group, the channel is said to be captured and the 
radio stays on that channel until the activity ceases or is no 
longer valid. When activity is no longer valid, the radio stays 
on the last captured channel for the period of time specified 
by the Group Hold Time field (Scan Groups tab). Scanning 
then resumes.

If one or two priority channels have been assigned (see 
“Types of Scanning” on page 149) and the captured channel 
is not a priority channel (P1 or P2), the radio periodically 
leaves the captured channel to sample the priority channel(s) 
for activity. The user may notice the signal blanking out 
while the priority channel is sampled. If activity is found on 
a higher priority channel, the radio switches to that channel.

If for dual priority scanning the P2 channel is captured, the 
P1 channel continues to be scanned. If the P1 channel is cap-
tured, no further scanning takes place until the activity on the 
P1 channel is no longer valid.

How often priority channels are scanned is determined by 
two fields in the Scan Groups form. 

� Non-Captured Priority Sample Timer: This timer applies 
when no channel has been captured. Whenever this 
timer expires, the radio finishes sampling the channel it is 
currently on and then samples the priority channel(s). If 
there is no activity on the priority channel(s), the scan-
ning regime resumes from the point at which it was inter-
rupted.

� Captured Priority Sample Timer: This timer applies 
when a channel has been captured. Whenever this timer 
expires, the radio samples any channels of a higher prior-
ity than the captured channel. If activity is found on a pri-
ority channel, the radio will switch to that channel.

Transmitting While Scanning
While a scanning group is selected, all transmissions are made 
on the home channel, unless a channel is captured. While a 
channel is captured, all transmissions are made on that chan-
nel.

The home channel is the first channel defined as a group 
member in the Scan Groups Members tab.

Voting
In voting, a group of channels all carrying the same traffic 
(e.g. via linked repeaters) is systematically sampled (“polled”) 
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for greatest signal strength. Voting provides wide area cover-
age and ensures that the strongest channel is always available 
for a call.

The member channels are polled in the order in which they 
are assigned to the scan group (Scan Group Members tab) 
until valid activity is found on one of the channels. After a 
delay specified by the Voting Lead In Delay field (Scan 
Groups tab), the received signal strength is measured for each 
channel. The strongest channel is then “voted” as the home 
channel on which all transmissions are made.

Initiating Polling
Voting polling is initiated whenever:

� valid activity is detected on a channel or

� upon each release of the PTT (enable the PTT Release 
Voting Request field in the Scan Groups tab) or

� at a regular interval (the Voting Polling Interval, Scan 
Groups tab).

Types of Voting
There are four types of voting available, and the type of vot-
ing for a particular group is set in the Group Type field of the 
Scan Group Members tab. The four types of voting are:

� Voting (V)

� Voting With Signalling (VS)

� Double Voting (DV)

� Double Voting With Signalling (DVS)

Voting (V)
When Group Type is V (voting), the radio polls all member 
channels to find a busy channel. The radio then measures the 
signal strength of all channels and makes the channel with the 
strongest signal the home channel on which transmissions are 
made.

Voting With Signalling (VS)
When Group Type is VS (voting with signalling), the radio 
behaves as for Voting (V), but a channel must have valid sig-
nalling if it is to made the home channel.

Double Voting (DV)
When Group Type is DV (double voting), the radio behaves 
as for Voting (V) but the signal strength of each channel is 
measured twice.

Double Voting With Signalling (DVS)
When Group Type is DVS (double voting with signalling), 
the radio behaves as for Voting With Signalling (VS), but the 
signal strength of each channel is measured twice.
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Transmitting While Voting
While a voting group is selected, all transmissions are made 
on the home channel. The home channel is the channel 
determined to have the strongest signal. If no channel has 
been selected as the strongest channel, the home channel is 
the first channel defined as a group member in the Scan 
Groups Members tab.

Per Channel DTMF and Selcall Calls
Each channel can have different Selcall sequences and 
DTMF strings associated with it (e.g. different function key 
preset calls for different Selcall systems).

For scanning groups, the sequence or string transmitted for 
such calls depends on whether or not a channel has been cap-
tured. If no channel has been captured, then the sequence or 
string transmitted is that for the home channel. If a channel 
has been captured, then the sequence or string transmitted is 
that for the captured channel. See “Transmitting While 
Scanning” on page 150.

For voting groups, the sequence or string transmitted for per 
channel DTMF or Selcall calls is that of the home channel. 
See “Transmitting While Voting” on page 152.
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Appendix B: Introduction to Selcall

Selcall stands for selective calling, a signalling system that uses 
sequences of audible tones to isolate calls in a manner similar 
to CTCSS and DCS. Unlike CTCSS and DCS, however, 
Selcall allows individual radios to have a unique identity and 
so calls can be directed to specific individuals within a group 
of radio users.

A Selcall sequence is a series of tones and gaps that for a sim-
ple Selcall system represents the identity of a radio. A Selcall 
sequence can also contain information such as repeater iden-
tity, caller identity and status.

In order for radios to recognise their identity in received 
Selcall sequences, all radios operating on a particular Selcall 
system must use the same set of tones and call sequence for-
mats. The common set of tone options and call sequence for-
mats radios use to communicate with one another is referred 
to as a Selcall system.

Programming Selcall
The Tait Orca Selcall feature has been designed to be highly 
flexible and is set up in the group of forms listed under Selcall 
and Status. Until Selcall is enabled, only one form is listed, 
Selcall Identity and Setup. Select this form to begin setting up 
a Selcall system.

The Selcall Identity and Setup form contains three tabs:

� Selcall Identity (Rx)

� Selcall Sequences (Tx)

� Selcall Tone Options

If Selcall has not previously been enabled, all fields on these 
tabs are greyed out except Enable Selcall. When you tick the 
box for Enable Selcall, additional Selcall fields and forms 
become visible.

Setting Up a Basic Selcall System
A basic Selcall system can be set up using only the fields in 
the three tabs of the Selcall Identity and Setup form. The 
radio can be configured for advanced Selcall features using 
the other forms.

� Various advanced Selcall features are enabled and disabled 
in the Selcall Features form. Once a feature in this form 
is enabled, it is enabled for all Selcall systems.

� If an emergency call is required, it is configured in the 
Selcall Emergency Setup form and assigned to a function 
key setting in the Key Settings I tab. Only one Selcall 
emergency call can be programmed for a radio.

status

Status is the current activity of the 
radio user, which can be represented by 
a status message. Another type of sta-
tus is control status, which when 
received, initiate a particular radio 
operation.
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� The Conventional Programming Application provides a 
default set of options for how the radio responds to 
incoming calls that match the radio’s unique identity. 
These are the pattern of the call alert, how long the radio 
rings and whether or not an auto acknowledge is sent. 
These options can be customised in the Selcall Rx 
Decode Setup form.

� There are a number of internationally accepted standard 
tone sets available that determine the frequencies used for 
each of the 16 tones used to make up Selcall sequences. 
The Conventional Programming Application supports 
nine of these standard tone sets. However, if you wish to 
create your own tone set or reorder an existing one, that 
tone set can be configured in the Custom Selcall Tone 
Set form.

� An additional one or two tones can be added to a Selcall 
sequence to indicate the caller’s present activity (status). 
A Selcall sequence can also include a status that initiates a 
particular radio operation (a control status). If you wish 
to make use of this feature, the call sequence formats must 
be configured to support status (Selcall ID (Rx) tab). Sta-
tus messages and control status are defined in the Selcall 
Control Status Definitions form.

Important Considerations
When setting up a Selcall system for a group of radios, ensure 
that all radios in the group:

� use the same transmit format and receive format (see 
“Selcall Systems: Transmit and Receive Formats” below)

� use the same tone parameters (see “Selcall Tone Trans-
mission” on page 157)

Selcall Systems: Transmit and 
Receive Formats
All radios operating on a Selcall system must use the same call 
format for most transmitted and received Selcall sequences. 
Exceptions are the free-form sequences. Free-form 
sequences may not follow the transmit format if the system is 
set up to support some special need, but should otherwise 
follow the transmit format. See “Free-form Sequences” on 
page 156 for more information.

The first step in setting up a Selcall system is defining the 
transmit and receive formats. See “The Transmit Format” on 
page 154 and “The Receive Format” on page 155.

The Transmit Format
For each Selcall system, the transmit format (or Tx format) 
defines the format all outgoing Selcall sequences must follow 
in order to be correctly decoded by other radios using the 

auto acknowledge

When a radio receives a Selcall 
sequence that contains its identity, it 
can be programmed to transmit an 
auto acknowledge sequence.

gap

A gap is a pause in the transmission 
of tones in a Selcall sequence. When 
constructing Selcall sequences, a gap is 
represented by a hyphen (-). A series 
of gaps makes up a gap burst.



© Copyright Tait Electronics Ltd, 2004  Introduction to Selcall 155

same Selcall system. A sample transmit format is shown 
below.

The transmit format consists of a series of tones and gaps. A 
series of tones is called a tone burst and a series of gaps is 
called a gap burst. A tone burst can correspond to one or 
more pieces of information, such as the receiver identity and 
the repeater identity. Tone bursts can be up to eight tones 
long and can be separated by gaps. Gap bursts can be up to 
eight gaps long and cannot begin or end a Selcall sequence.

See “Selcall Tone Transmission” on page 157 for more 
information on the frequencies used for each tone and how 
they are transmitted.

In the example above:

� the B burst is the repeater identity, and is made up of 
three tones

� the R burst is the receiver identity, and is made up of five 
tones

� the C burst is the caller identity, and is made up of five 
tones

� the S burst is the status, and is made up of two tones, 
which means status digits 0 to 99 can be transmitted

In the example, the B, R, C and S bursts are separated by gap 
bursts. This is not compulsory and the transmit format could 
be BBBRRRRR--CCCCC--SS and still be valid since the 
first tone burst is not greater than eight tones long. If a single 
status tone is included, however, it should be separated from 
the other tone bursts by at least two gaps.

A simple Selcall system may require that only the receiver 
identity be transmitted. The other tone bursts are optional 
for the transmit format.

Table 8 on page 156 shows examples of valid and invalid 
transmit formats. 

The transmit format for each Selcall system is set in the Selcall 
Sequences (Tx) tab.

The Receive Format
The receive format defines the format all incoming Selcall 
sequences must follow in order to be correctly decoded by 
the receiving radio. The receive format should be the same 

B burst (repeater identity

gap burst

R burst (receiver identity)

C burst (caller identity)

S burst (status)

BBB--RRRRR--CCCCC--SS
repeater identity

In a Selcall sequence, the repeater 
identity is the part of the sequence that 
the radio transmits so that the repeater 
recognises the radio as having access to 
the repeater. In the transmit (Tx) for-
mat, the repeater identity is repre-
sented by the character B, and so this 
part of a sequence is known as the B 
burst. If the transmit format includes 
a repeater burst, it must come before 
all other bursts.

receiver identity

In a Selcall sequence, the receiver 
identity is the part of the sequence that 
identifies the radio the sequence is 
intended for. In the transmit (Tx) for-
mat and receive (Rx) format, the 
receiver identity is represented by the 
character R, and so this part of a 
sequence is known as the R burst.

caller identity

In a Selcall sequence, the caller iden-
tity is the part of the sequence that 
identifies the radio transmitting the 
sequence. In the transmit (Tx) format 
and receive (Rx) format, the caller 
identity is represented by the character 
C, and so this part of a sequence is 
known as the C burst.

status digit

In a Selcall sequence, the status digit 
is the part of the sequence that identi-
fies the current activity (status) of the 
radio transmitting the sequence. In the 
transmit (Tx) format and receive (Rx) 
format, the status digit is represented 
by the character S, and so this part of 
a sequence is known as the S burst.
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for all radios using a particular Selcall system. A sample 
receive format is shown below.

Like the transmit format, tone bursts can be up to eight tones 
long, separated by a gap burst. Gap bursts can be up to eight 
gaps long and cannot begin or end the sequence.

Unlike the transmit format, the receive format cannot have a 
repeater burst. The other bursts do not have to match those 
in the transmit format, except for status. If the receive format 
has a status burst, it must match that for the transmit format. 
However, it is recommended that the other bursts match the 
transmit format bursts if Selcall sequences are to be correctly 
decoded. 

The receive format for each Selcall system is set in the Selcall 
Sequences (Tx) tab.

Free-form Sequences
Free-form Selcall sequences do not have to conform to the 
Selcall system’s transmit format. However, unless the system 
is set up to support some special feature, the free-form 
sequences should follow the transmit format.

Function key preset calls, the ANI sequence, the auto 
acknowledge sequence and the emergency sequence are 
free-form sequences.

R burst (receiver identity)

gap burst

C burst (caller identity)

S burst (status)

RRR--CCC--SS

Table 8: Examples of valid and invalid Selcall transmit formats

Tx Format Explanation Tx Format Explanation

RRRRRCCCCC The transmit format is invalid 
because the tone burst is more 
than 8 tones long.

RRR--BBB--CCC The transmit format is invalid 
because the repeater identity is 
not defined first.

RRRRR--CCCCC The transmit format is valid 
because no tone burst is more 
than 8 tones long.

BBB--RRR--CCC The transmit format is valid 
because each tone and gap 
burst is not more than 8 tones 
long and the repeater identity 
is defined first.

RRR--CCC--RRR The transmit format is invalid 
because the receiver identity is 
defined twice.

BBRRRCCC The transmit format is valid 
because the tone burst is not 
more than 8 tones long, and 
none of repeater identity, 
receiver identity or caller iden-
tity is defined more than once.
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Because the free-form sequences do not have to follow the 
transmit format, it is necessary to specify whether or not a 
repeater burst is included in the sequence if the first tone-
period multiplier feature is enabled. If you are going to use 
the tone-period multiplier feature with a repeater burst, you 
should ensure that the repeater burst is followed by a gap 
burst as the tone-period multiplier is applied to the first burst 
after a gap burst. 

Defining the Radio’s Identity
A radio operating on a Selcall system must have at least one 
Rx decode sequence defined. The Rx decode sequence is 
the radio’s unique identity on a Selcall system. When the 
radio’s Rx decode sequence is decoded as the receiver iden-
tity in an incoming Selcall sequence, the radio recognises the 
sequence as intended for it and respond appropriately.

Each radio operating on a Selcall system can have one or two 
Rx decode sequences assigned. The Rx decode sequences 
must match the R burst in the receive format. In addition to 
tones 0 to 9, A to D and F, a V can be used in the Rx decode 
sequence. If the radio’s Rx decode sequence contains one or 
more Vs, it will respond to a range of receiver identities. For 
example, a radio that has an Rx decode sequence of 456VV 
responds to all call sequences with a receiver identity five 
tones long starting with 456.

The radio’s Rx decode sequences are defined in the Selcall 
Identity (Rx) tab.

Selcall Tone Transmission
How the tones in a Selcall sequence are transmitted is deter-
mined by timing parameters programmed in the Selcall Tone 
Options tab.

The actual frequencies used for each of tones 0 to 9 and A to 
F is defined by the tone set. You can define a custom tone 
set in the Custom Selcall Tone Set form by reordering an 
existing tone set or by defining the frequencies of each indi-
vidual tone. However, the frequencies available for the cus-
tom tone set are limited, so if you wish to use a frequency 
that is not available (e.g. 1500 to 1700 Hz), consider reorder-
ing an existing tone set.

How long each tone is transmitted is determined by the tone 
period parameter. The length of each pause in a gap burst is 
determined by the gap period parameter.

There may be a lag between when transmission is initiated 
and when the first tone in a Selcall sequence is transmitted. 
During this lag, the radio may transmit a repeater access tone 
or a lead in tone. This ensures that the receiving equipment 
has time to prepare to decode the incoming transmission. For 
example, a lead-in tone gives a repeater time to stabilise, 

tone set

The tone set is the set of frequencies 
represented by the characters 0-9 and 
A-F used to make up Selcall 
sequences. There are a number of 
internationally accepted standard tone 
sets available. There is a finite 
number of frequencies available to rep-
resent the various characters in a 
Selcall sequence; it is the frequencies 
used and their order that distinguishes 
one tone set from another.
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allows a radio time to come out of economy mode, or allows 
a scanning radio time to lock onto a channel before critical 
tones in a Selcall sequence are received.

The tone used for both the repeater access tone and the lead-
in tone is programmable, as is the duration of each tone. 

Making Selcall Calls
There are two ways to make Selcall calls on Tait Orca radios: 

� make a preset call (see “Selcall Presets” below)

� dial a call (see “Selcall Dialling” on page 159).

Preset calls are available on all Tait Orca radios, and are the 
only type of Selcall call that can be made on Orca Elan and 
Orca 5010 radios. Orca Excel, Orca Eclipse and Orca 5020 
radios support Selcall dialled calls.

Selcall Presets
There are three ways to make preset Selcall calls.

� Function key: On all radios, a preset Selcall call can be 
assigned to one of the function key settings. To send the 
call, the user selects the channel the Selcall call is assigned 
to and presses the assigned function key. Different preset 
calls can be programmed for different channels. See “Pro-
gramming Per Channel Selcall Calls” below.

� Call key: On Orca Excel and Eclipse radios, a preset 
Selcall call can be assigned to a long press of the call key. 
To send the call, the user selects the channel the Selcall 
call is assigned to and presses the assigned key. Different 
preset calls can be programmed for different channels. See 
“Programming Per Channel Selcall Calls” below.

� One touch call: On all radios, a single one-touch Selcall 
call can be assigned to one of the function keys. It is not 
necessary to change channels to send this call; the user 
simply presses the assigned function key. See “Program-
ming a One-Touch Selcall Call” on page 159.

Programming Per Channel Selcall Calls
Per channel calls assigned to the call key are set up in the 
Selcall Sequences (Tx) tab and the Channels form. See “Call 
Key Per Channel Calls” below.

Per channel calls assigned to function key settings are set up 
in the Selcall Sequences (Tx) tab, the Key Settings I tab and 
the Channels form. See “Programming a One-Touch Selcall 
Call” below.

Call Key Per Channel Calls
1. In the Selcall Sequences (Tx) tab, define the Fixed Call 

Sequence field.

fixed call sequence

The fixed call sequence is a Selcall 
sequence that is defined at radio pro-
gramming time and that can be trans-
mitted by a long press of the call key 
on Orca 5015, Orca Excel and 
Eclipse radios. 



© Copyright Tait Electronics Ltd, 2004  Introduction to Selcall 159

2. In the Channels form, assign the call to a channel by 
entering the number of the Selcall system the call has 
been defined for into the Selcall System field for the 
appropriate channel.

Function Key Per Channel Selcall Calls
1. In the Selcall Sequences (Tx) tab, define one of the func-

tion key preset calls.

2. In the Channels form, assign the call to a channel by 
entering the number of the Selcall system the call has 
been defined for into the Selcall System field for the 
appropriate channel.

3. In the Key Settings I tab, select the required Preset Call 
option for one of the function key settings.

Programming a One-Touch Selcall Call
A one-touch Selcall call is set up in the Selcall Sequences 
(Tx) tab, the Alpha Symbols form and the Key Settings I tab. 

1. In the Selcall Sequences (Tx) tab, define the Fixed Call 
Sequence fields. If the Selcall system the call is transmitted 
on requires any of repeater identity, caller identity and 
status, they are read from the fixed call sequence.

2. In the Alpha Symbols form, if no alpha symbols have 
been defined, press the F2 key or the Add button. If more 
than one alpha symbol is listed, select the first alpha sym-
bol in the list. The one touch call programmed is the first 
alpha symbol in the list. For the first symbol in the list, set:

a. A Symbol Name, New Channel and New Status suit-
able for the radio being programmed. The New 
Channel should have assigned to it the Selcall system 
for which you defined the Fixed Call Sequence.

b. Signalling Type to Selcall.

c. Signalling Number to the Selcall sequence that is 
transmitted. The Signalling Number should be the 
receiver identity only since the other bursts, if 
required, is read from the fixed call sequence.

3. Assign the call to a function key setting by selecting the 
One Touch option for one of the function key settings in 
the Key Settings I tab.

Selcall Dialling
The Selcall dialling feature allows the radio user to dial Selcall 
sequences using the numeric keypad. Selcall dialling is avail-
able on Orca Excel, Orca Eclipse and Orca 5020 radios and 
is enabled by defining the variable call sequence (Selcall Iden-
tity (Rx) tab). 

In the variable call sequence, set the tones the user dials to V. 
For example, if a group of users has been assigned identities 

alpha symbol

An alpha symbol is a sequence of com-
mands that, depending on the radio 
type, can change to a specific channel, 
dial a Selcall or DTMF call, change 
the radio’s status or any combination 
of these three tasks. The first alpha 
symbol defined can be assigned to a 
function key setting. This is called a 
one touch call, and is the only alpha 
symbol available for Orca Elan, Orca 
Excel, Orca 5010 and Orca 5015 
radios.
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45601 to 45610, you could set the R burst of the variable call 
sequence to 456VV. The radio user would then dial 10 to call 
radio 45610.

On Orca Excel radios, up to three of the tones in the B, R 
and C bursts of the variable call sequence can be set to V. On 
Orca Eclipse and Orca 5020 radios, up to eight of the tones 
in the B, R and C bursts can be set to V. On Orca Eclipse 
and Orca 5020 radios, the status burst can also be set to V. 
See “Status Messages and Control Status” on page 160 for 
more information.

Status Messages and Control Status
Selcall sequences can include one or two additional tones 
called status digits. In the transmit format and receive format, 
the status digit is represented by the character S, and so this 
part of a sequence is known as the S burst.

There are two types of status:

� status messages

� control status.

Status messages are available on Orca Eclipse and Orca 5020 
radios. Control status are available on all radios. Status mes-
sages and control status are set up in the Selcall Control Status 
Definitions form. 

The status digit is the information transmitted. If the receive 
format has one S, then there are 16 possible status digits, 
numbered 0 to 15. If the receive format has two Ss, there are 
100 possible status digits, numbered from 0 to 99. 

If a radio is operating on Selcall systems that have a mix of no 
status or one-tone (0 to 15) and two-tone (0 to 99) status 
bursts:

� no status digits are valid on systems that do not include 
status in the receive format

� status digits 16 to 99 are not valid on systems that have 
only one status tone.

Status Messages
Status messages are used to represent the current activity of a 
radio user. Status messages are made up of a status digit and a 
status label.

The status label is up to eight characters long and is displayed 
when its associated status digit is decoded in an incoming 
Selcall sequence. The Automatic Caller Identification feature 
must be enabled for the radio to display received status. If no 
status labels are defined or if the received status digit does not 
match any of the status labels, then status is displayed as a digit 
rather than a label.

Only one set of status messages can be defined for a radio 
(Status Labels tab). 

variable status

The S burst of a Selcall sequence can 
be programmed with a V. When the 
sequence is transmitted, the status 
digit included is the one the user last 
selected in status entry mode.
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The status messages and control status defined in the Selcall 
Control Status Definitions form are shared by all Selcall sys-
tems defined for a radio.

Control Status
Control status initiate a particular radio operation when 
decoded in an incoming Selcall sequence. Unlike status mes-
sages, control status do not have to have a corresponding sta-
tus label. Tait Orca radios support control status for the fol-
lowing functions.

� Priority calls: When the priority control status is received, 
the radio activates the alert specified for priority calls in 
the Selcall Rx Decode Setup form and clears down any 
call in progress that is not a priority call. The priority call 
control status is set in the Control Status tab.

� Quiet interrogation: When the quiet interrogation con-
trol status is received, the radio transmits the auto 
acknowledge sequence for the current Selcall system 
without alerting the radio user to the receipt of the Selcall 
sequence. The quiet interrogation control status is set in 
the Control Status tab.

� Stun and revive: Two control status are provided for the 
stun and revive feature. When the activate stun control 
status is received, the radio ceases normal operation. 
When the deactivate stun control status is received, a 
stunned radio resumes normal operation. The stun and 
revive control status are set in the Control Status tab.

� Data operation: When the data control status is received, 
the radio stops all Selcall decoding and starts up data 
decoding. The data control status is set in the Control 
Status tab.

� Call diversion: When the call diversion control status is 
received in an auto acknowledge, the radio selects the call 
diversion channel and indicates to the radio user that the 
called radio is in call diversion mode. The user can then 
make a new call on that channel if they wish. The call 
diversion control status is set in the Selcall Features form.

The status messages and control status defined in the Selcall 
Control Status Definitions form are shared by all Selcall sys-
tems defined for a radio. The call diversion control status is 
set in the Selcall Features form and is also shared by all Selcall 
systems defined for a radio.



162 Introduction to DTMF   © Copyright Tait Electronics Ltd, 2004

Appendix C: Introduction to DTMF

DTMF (dual tone multiple frequency) is the tone-based sys-
tem used for the world’s telephone networks. A DTMF tone 
actually consists of a pair of tones.

Tait Orca radios can encode series of DTMF tones (referred 
to as DTMF strings) and so can make DTMF calls, but can-
not decode DTMF tones and so cannot receive DTMF calls. 
If the system a radio is operating on has access to systems that 
make use of DTMF tones, the radio can make DTMF calls 
to those systems. Examples of such systems are the public 
switched telephone network, message retrieval systems and 
telephone banking facilities.

Tait Orca radios can make DTMF calls in three ways:

� DTMF presets

� DTMF dialling

� DTMF ANI.

DTMF dialling is available for Orca Excel, Orca Eclipse and 
Orca 5020 radios. How DTMF tones are transmitted is the 
same for both DTMF presets and DTMF dialling.

DTMF Tone Transmission
How DTMF strings are transmitted is illustrated in the dia-
gram below.

The different timing parameters are programmable and are 
defined in the DTMF Dialling tab.

The transmit key up delay is the time, in milliseconds, 
between when the transmission has been initiated (by the 
press of a function key, the DTMF key or the enter key) and 
the time transmission of the DTMF string actually starts. The 
transmit key up delay gives the repeater time to stabilise 
before the first DTMF tone is transmitted, and is set in the 
Transmit Key Up Delay field. 

X is how long each tone in the string is transmitted, or the 
tone duration, in milliseconds. The minimum tone duration 
is programmable, as outlined below. The actual duration may 
be longer if the radio user presses the key for longer than the 
minimum tone duration.

� The duration of tones 0-9 and A-D is set in the Mini-
mum Tone Duration (0-9, A-D) field.

� The duration of tones * and # is set in the Minimum 
Tone Duration (*, #) field.

tone

A tone is a sound wave of a particular 
frequency. When defining DTMF 
strings, the different tones are repre-
sented by the characters 0-9, A-D, * 
and #. The frequencies used are deter-
mined by an internationally accepted 
standard.

DTMF string

A DTMF string is a series of DTMF 
tone pairs. 

transmit key 
up delay (ms) Tone 1

X
Gap

Y
Tone 2

X
Gap

Y
Tone 3

X
...
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Y is the amount of time between the transmission of each 
tone in the string, or the gap duration, in milliseconds. The 
gap duration is set in the Minimum Intertone Gap field. 

DTMF Presets
There are three ways to make preset DTMF calls.

� Function key: On all radios, a preset DTMF call can be 
assigned to one of the function key settings. To send the 
call, the user selects the channel the DTMF call is 
assigned to and presses the assigned function key. Differ-
ent preset calls can be programmed for different channels. 
See “Programming Per Channel DTMF Calls” below.

� DTMF key: On Orca Excel and Eclipse radios, a preset 
DTMF call can be assigned to a long press of the DTMF 
key. To send the call, the user selects the channel the 
DTMF call is assigned to and presses the assigned key. 
Different preset calls can be programmed for different 
channels. See “Programming Per Channel DTMF Calls” 
below.

� One touch call: On all radios, a single one-touch DTMF 
call can be assigned to one of the function keys. It is not 
necessary to change channels to send this call; the user 
simply presses the assigned function key. See “Program-
ming a One-Touch DTMF Call” on page 164.

Programming Per Channel DTMF Calls
Per channel DTMF calls, whether assigned to a function key 
or to the DTMF key, are programmed in a similar manner. 

Per channel calls assigned to the DTMF key are set up in the 
DTMF Presets tab and the Channels form. See “DTMF Key 
Per Channel Calls” only.

For per channel calls assigned to a function key, you must 
also set a field in the Key Settings I tab. See “Function Key 
Per Channel DTMF Calls” below.

DTMF Key Per Channel Calls
1. In the DTMF Presets tab, set:

a. a DTMF ID, which is a number from 1 to 20; and

b. a Preset Call String, which is the sequence of DTMF 
tones that is transmitted.

2. In the Channels form, assign the preset call to a channel 
by entering:

a. the preset call’s DTMF ID into the DTMF ID field 
for the appropriate channel.

Function Key Per Channel DTMF Calls
If you wish to assign DTMF preset calls to a press of the func-
tion key, follow the steps outlined for “DTMF Key Per 



164 Introduction to DTMF   © Copyright Tait Electronics Ltd, 2004

Channel Calls” on page 163 and then in the Key Settings I 
tab, choose the Channel’s DTMF Preset option for one of 
the function key settings.

Programming a One-Touch DTMF Call
A one-touch DTMF call is set up in the Alpha Symbols form 
and the Key Settings I tab. In the Alpha Symbols form, if no 
alpha symbols have been defined, press the F2 key or the Add 
button. If more than one alpha symbol is listed, select the first 
alpha symbol in the list. The one touch call programmed is 
the first alpha symbol in the list.

1. For the first symbol in the list, set:

a. a Symbol Name, New Channel and New Status suit-
able for the radio being programmed;

b. Signalling Type to DTMF

c. Signalling Number to the DTMF string that is trans-
mitted.

2. To assign the call to a function key setting:

a. for one of the function key settings (Key Settings I 
tab), choose the One Touch option.

DTMF Dialling
The DTMF dialling feature allows the radio user to dial 
DTMF strings using the numeric keypad. DTMF dialling is 
available on Orca Excel, Orca Eclipse and Orca 5020 radios.

Most DTMF dialling features are set in the DTMF Dialling 
tab. Exceptions are:

� Default Mode (Specifications form). If you wish to use 
DTMF dialling mode as the default mode, then set 
Default Mode to DTMF.

� DTMF Dialling Type (User Selectable Parameters form). 
On Orca Eclipse radios, ticking the In User Menu? box 
gives the radio user the option to change the dialling type 
using the user function menu.

The relevant fields in the DTMF Dialling tab are as follows.

� The Manual DTMF Dialling field enables and disables 
DTMF dialling.

� The Interdigit Tx Hold Time field determines how long 
the radio keeps transmitting between the encoding of 
each tone. This provides a delay for the user to dial the 
next digit without transmission stopping and restarting 
again. Some systems require continuous transmission 
between DTMF tones and for such systems, this field 
should be set to a long hold time.

� The DTMF Redial Transmission field enables and disa-
bles the DTMF redial feature.

alpha symbol

An alpha symbol is a sequence of com-
mands that, depending on the radio 
type, can change to a specific channel, 
dial a Selcall or DTMF call, change 
the radio’s status or any combination 
of these three tasks. The first alpha 
symbol defined can be assigned to a 
function key setting. This is called a 
one touch call, and is the only alpha 
symbol available for Orca Elan, Orca 
Excel, Orca 5010 and Orca 5015 
radios.

DTMF dialling mode

In DTMF dialling mode, the user can 
dial DTMF strings. DTMF dialling 
mode is available when the Manual 
DTMF Dialling field in the DTMF 
form is enabled. 
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� The PTT as Shift Key field enables and disables the PTT 
as shift key feature.

� The DTMF Dialling Type Buffered field determines 
whether the dialling type is normal dialling or buffered 
dialling.

� The DTMF Mode Selcall ANI Transmission field deter-
mines whether ANI transmission continues while the 
radio is in DTMF dialling mode. If the PTT as shift key 
feature has been enabled and a DTMF call is being made 
on a Selcall system, the transmission of the ANI sequence 
when the PTT is pressed could result in interference.

ANI

ANI stands for “automatic number 
identification”. A Selcall or DTMF 
system can be set up so that each radio 
automatically transmits its identity at 
regular intervals throughout the dura-
tion of a call. Each radio’s identity is 
transmitted on each exchange of trans-
missions (each press of the PTT) 
unless the ANI suppression time has 
not expired. ANI makes it possible to 
set up a log of a radio’s channel activ-
ity. 
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Appendix D: Reducing Power Consumption 
on Tait Orca Radios

There are three programmable options for reducing power 
consumption for Tait Orca radios.

� Use economy mode. See “Economy Mode” below.

� Reduce the amount of time backligthing remains active. 
See “Backlighting” on page 168.

� Reduce the transmit power. See “Set Low Power On All 
Channels” on page 138 to reduce the transmit power for 
all channels, and “Power Level” on page 46 to reduce the 
transmit power of individual channels.

Economy Mode
Economy mode reduces the radio’s power consumption 
when it is idle. When economy mode is active, and there has 
been no valid activity on a channel for the duration of the 
economy mode timer, the radio begins economy cycling. 
The beginning of a transmission may be lost following a 
period of inactivity.

Economy Cycling
Economy cycling is the switching between states that occurs 
when economy mode is active and after there is no valid 
activity on a channel for the duration of the economy mode 
timer.

Economy cycling consists of two states:

� Receive state: The radio powers up to determine 
whether the current channel is carrying valid traffic. 

� Standby state: The radio’s circuitry is either switched off 
or placed in standby mode.

The amount of time the radio spends in each state is deter-
mined by the economy duty cycle. 

The radio cycles between the receive and standby states until 
economy cycling is suspended or until economy mode is 
deactivated. Economy cycling is suspended if:

� valid activity is found on a channel or

� if the radio is switched to a scan group. 

Economy cycling recommences when there is no longer 
valid activity on a channel or when a scan group is no longer 
selected, although the radio’s indicators continue to show 
that the radio is in economy mode.

economy mode timer

The economy mode timer sets the time 
between when valid activity was last 
detected on a channel and the start of 
economy cycling.
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Economy Duty Cycle
The economy duty cycle determines the amount of time the 
radio spends in the receive and standby states while economy 
cycling. There are three options.

� Low: 200 ms standby

� Medium: 500 ms standby

� High: 800 ms standby.

The radio spends between 120 and 500 ms in the receive 
state, depending on the signalling on the channel.

Using Economy Mode with Selcall
Selcall systems can be set up so that a lead-in tone is transmit-
ted for a preprogrammed period of time (the lead-in delay) 
at the start of Selcall sequences. This allows receiving radios 
time to halt scanning and lock onto the channel before crit-
ical tones are received.

If, however, the receiving radio is in the standby state when 
another radio sends a Selcall sequence, the receiving radio 
could switch into the receive state towards the end of the 
lead-in tone or after it has been transmitted. The receiving 
radio may not be able to reliably decode the remainder of the 
Selcall sequence. For this reason, it is important to set the 
lead-in delay to at least 100 ms longer than the time the radio 
spends in the standby state. For example, if the economy 
duty cycle is Medium (standby = 500 ms), the lead-in delay 
should be set to at least 600 ms, especially if the radio is oper-
ating on a repeater.

The economy duty cycle setting of High is not recom-
mended for Selcall systems operating on a repeater as the 
lead-in delay would need to be set to at least 900 ms.

Activating Economy Mode
Economy mode can be activated in the following ways.

� Economy mode can be permanently enabled. In the User 
Selectable Parameters form, ensure that the Initial Setting 
box is ticked for the field Economy Mode Control.

� Economy mode can be turned on and off by the press of 
a function key. Set one of the function key settings for 
Economy Mode Control (Key Settings I tab).

� On Orca Eclipse and Orca 5020 radios, economy mode 
can be turned on and off from the user function menu 
entry mode. For the Orca Eclipse, ensure that the In User 
Menu? box is ticked for the field Economy Mode Con-
trol (User Selectable Parameters form). For the Orca 
5020, tick the ECONOMY box in the User Defined 
Menu form.

Selcall

For more information on Selcall see 
“Introduction to Selcall” on page 
153.

user function menu entry mode

In user function menu entry mode, the 
user can customise radio options. For 
Orca Eclipse radios, the user defined 
menu is set up in the User Selectable 
Parameters Form. For Orca 5020 
radios, the user defined menu is set up 
in the User Defined Menu Form. 
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Backlighting
Backlighting is the lighting up of the radio’s LCD whenever 
there is activity on the radio, such as when valid activity is 
detected on a channel, when a key is pressed or when a call 
is received.

The backlighting timer determines how long backlighting 
remains on, once it is activated. There are two ways back-
lighting can be activated, and how it was activated affects 
how the backlighting timer operates.

� Backlighting activation: If backlighting is activated by the 
press of a function key programmed with the Backlight-
ing option, backlighting remains on for the duration of 
the backlighting timer.

� Night use activation: If backlighting is activated as part of 
the night use feature, backlighting remains on for the 
duration of the backlighting timer, which resets to its 
programmed value and begin counting down again 
whenever there is activity on the radio.

Battery life can be extended by reducing the amount of time 
radio backlighting remains active.
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Appendix E: What’s New - Orca 5000 Series

This section outlines new features for Orca 5010, Orca 5015 
and Orca 5020 radios. Each feature will be available on radios 
with the corresponding version number or higher.

Feature Form Firmware Version Database Version

Mix DCS and CTCSS on 
channel

Channels 2.10 3.03

Man Down Accessory 
Connected

General Options 2.10 3.03

Channel Banking (Orca 
5020)

Channel Selection 2.10 3.03

Subaudible Signalling on 
Rx Gate

Subaudible Signalling 2.07 3.02

Channel Selector and 
Selector Position

Channel Selection 2.07 3.02

Lone Worker General Options 2.07 3.02

Short and long press of 
external function keys

Key Settings 2.07 3.02

DTMF ANI DTMF 2.07 3.02

Orca 5015 radio model Specifications 2.06 3.01

Flexiscan (options) Scan Groups 2.05 3.01

Flexiscan (initial setting) User Selectable 2.05 3.01

Audio Noise Reduction Receiver Monitoring 2.05 3.01

Tone Blanking: Number of 
Tones to Activate and 
Deactivation Timer

Selcall Features 2.05 3.01
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Glossary

Terms in italics are defined in the glossary.

16-way selector The 16-way selector is the larger of the two switches on the top of Orca 
Elan, Orca Excel, Orca 5010, Orca 5015 and Orca 5020 radios. Each position 
on the 16-way selector can denote a channel or a scan group. 

accessory An accessory is an external device fitted to a radio, such as an external 
speaker microphone or lapel microphone. Accessories are fitted to the radio 
via the accessory connector on the back of the radio.

alpha symbol An alpha symbol is a sequence of commands that, depending on the radio 
type, can change to a specific channel, dial a Selcall or DTMF call, change 
the radio’s status or any combination of these three tasks.

The first alpha symbol defined can be assigned to a function key setting. 
This is called a one touch call, and is the only alpha symbol available for Orca 
Elan, Orca Excel, Orca 5010 and Orca 5015 radios. 

Orca Eclipse and Orca 5020 radios can have up to 20 alpha symbols, which 
are available through alphanumeric entry mode.

Alpha symbols are defined in the Alpha Symbols form.

alphanumeric 
entry mode

In alphanumeric entry mode, the user can select and execute up to 20 alpha 
symbols.

Alphanumeric entry mode is available on Orca Eclipse and Orca 5020 radios 
once an alpha symbol has been defined in the Alpha Symbols form.

ANI ANI is a Selcall and DTMF feature.

ANI stands for “automatic number identification”. A Selcall or DTMF sys-
tem can be set up so that each radio automatically transmits its identity at 
regular intervals throughout the duration of a call. Each radio’s identity is 
transmitted on each exchange of transmissions (each press of the PTT) 
unless the ANI suppression time has not expired. ANI makes it possible to set 
up a log of a radio’s channel activity. 

All Tait Orca radios can be set up to transmit (encode) Selcall ANI. Orca 
5010, Orca 5015 and Orca 5020 radios can transmit (encode) DTMF ANI. 
Orca Eclipse and Orca 5020 radios can also decode Selcall ANI and so deter-
mine what radios are transmitting on the system.

Selcall ANI encoding and decoding are enabled in the Selcall Features form. 
DTMF ANI encoding is set in the DTMF ANI tab. DTMF ANI can only 
be enabled on a channel that has a DTMF ID, and does not have a Selcall 
System, associated with it.

ANI suppression 
time

The ANI suppression time is the minimum amount of time between sub-
sequent transmissions of the ANI sequence.
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appended C 
tone monitor 
reset

Appended C tone monitor reset is a Selcall feature.

The monitor is deactivated when an incoming Selcall sequence that contains 
the radio’s identity has a C tone appended to the end of a burst. Emergency 
cycling (see Emergency mode) is also deactivated.

Appended C tone monitor reset is enabled in the Selcall Features form.

audible 
indicators

Tait Orca radios use combinations of audible indicators and visual displays 
to indicate the radio’s current state and activity.

Audible indicators include keypress confidence tones, received call signals, low 
battery and high temperature warnings, transmit timer and unanswered call 
signals.

Audible indicators are enabled in the User Selectable Parameters form.

auto 
acknowledge

Auto acknowledge is a Selcall feature.

When a radio receives a Selcall sequence that contains its identity, it can be 
programmed to transmit an auto acknowledge sequence. 

An auto acknowledge sequence can also include a status digit. If on Orca 
Eclipse and Orca 5020 radios the called unit status display feature is enabled, a 
status message is displayed upon receipt of the auto acknowledge.

auto quiet timer The auto quiet timer determines how long monitor remains active. The auto 
quiet timer is suspended while the radio is transmitting or while there is 
valid activity on a channel. Once a transmission is complete or when the 
radio is switched to another channel, the auto quiet timer either begins 
counting down once again (continuous) or resets to the programmed dura-
tion of the auto quiet timer (reset).

The duration of the auto quiet timer and whether it counts down contin-
uously or resets are set in the Receive Monitoring form.

automatic caller 
identification

Automatic caller identification is a Selcall feature available on Orca Excel, 
Orca 5015 and Orca 5020 radios.

When an incoming call is received, the caller identity is displayed so the 
radio user can identify the caller before responding.

Automatic caller identification is enabled in the Selcall Features form.

backlighting The radio’s LCD lights up when there is activity on the radio, such as when 
a key is pressed or when a call is received.

Battery life can be extended by reducing the amount of time radio back-
lighting remains active.

Backlighting can be activated in two ways.

� A function key can be programmed to activate backlighting (Backlight-
ing On/Off option).

� The radio can be programmed for night use, which can be turned on and 
off by the press of a function key (Night Use option) and on Orca Eclipse 
and Orca 5020 radios via the user function menu option.



172 Glossary   © Copyright Tait Electronics Ltd, 2004

The value of the backlighting timer and how backlighting was activated deter-
mine how long backlighting remains on.

backlighting 
timer

The backlighting timer determines how long backlighting remains on once 
it is activated. There are two ways backlighting can be activated, and how 
it was activated affects how the backlighting timer operates.

� If activated via the Backlighting On/Off function key setting, back-
lighting remains on for the duration of the backlighting timer.

� If activated via the Night Use function key setting or via the NIGHT 
user function menu option, backlighting remains on for the duration of the 
backlighting timer, which resets whenever a key is pressed or a call is 
received.

The duration of the backlighting timer is set in the Power Save Features 
form. 

birdie A birdie is a hum or whistle on a channel caused by internal interference. 
A birdie can be eliminated by activating a birdie killer on the channel.

birdie killer A birdie killer is an internal circuitry switch that greatly reduces the effect 
of a birdie on a channel.

Birdie killers are set in the Birdie Channels form.

buffered dialling When a DTMF string is dialled, the string is either transmitted separately as 
each individual key is pressed (normal dialling) or in its entirety once the 
enter key is pressed (buffered dialling).

The DTMF dialling type is set in the DTMF form.

burst A burst is a series of tones (a tone burst) or gaps (a gap burst) in a Selcall sequence.

calibration Calibration is the process whereby a radio is electronically tuned. Orca Elan, 
Orca Excel and Orca Eclipse radios are calibrated using a PC running either 
the Calibration System for Tait Orca Radios (DOS-based) or the Calibra-
tion Application (Windows-based).Orca 5010, Orca 5015 and Orca 5020 
radios are calibrated using the Windows-based Calibration Application. 

call diversion Call diversion is a Selcall feature available on Orca Eclipse and Orca 5020 
radios.

Call diversion allows the radio user to divert received calls to another chan-
nel, and although it is not available on Tait Orca radios, Orca Eclipse and 
Orca 5020 radios recognise a call diversion message from another radio and 
switch to the designated channel.

Call diversion is enabled in the Selcall Features form.

call queuing Call queuing is a Selcall feature available on Orca Eclipse and Orca 5020 
radios.
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If the radio user is unable to answer calls immediately, they can be stored in 
the call queue so that the user can call back later. Up to 15 calls can be 
stored.

Call queuing is enabled in the Selcall Features form (Received Call Queu-
ing field).

called unit status 
display

Called unit status display is a Selcall feature available on Orca Eclipse and Orca 
5020 radios.

When a called radio responds with an auto acknowledge that contains status 
digit, the auto acknowledge sequence is displayed on the calling radio, 
together with any attached status message.

Called unit status display is enabled in the Selcall Features form.

caller identity In a Selcall sequence, the caller identity is the part of the sequence that iden-
tifies the radio transmitting the sequence. In the transmit (Tx) format and 
receive (Rx) format, the caller identity is represented by the character C, and 
so this part of a sequence is known as the C burst.

captured 
channel

When the radio is scanning a group of channels and valid activity is found on 
one of those channels, the radio remains on that channel until the activity 
is no longer valid and the group hold time has expired or until valid activity 
is found on a higher priority channel. While the radio is stopped on that chan-
nel, the channel is said to be captured, and transmissions are on the captured 
channel rather than on the home channel.

captured priority 
sample timer

The value of the captured priority sample timer determines how often pri-
ority channels are scanned when a lower priority channel is captured.

The duration of the captured priority sample timer is set in the Scan Groups 
form.

CCDI See computer controlled data interface

CCIR CCIR is one of the Selcall tone sets the Conventional Programming Appli-
cation supports. 

channel A channel is a pair of radio frequencies, one used for transmitting and one 
used for receiving. 

Channels are set up in the Channels form.

channel banking Channel banking is a feature in Orca 5020 radios, that enables a large 
number of channels to be managed by dividing them into banks. How 
channels are assigned to banks is dependant on the 16-way Selector Mode 
setting.

� If set to Bank Selection, the total number of channel banks will be 16, 
and each bank will have a total of 32 channels (except the last bank with 
29 channels). Channel IDs 1 to 32 will be assigned to the first bank, 
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channel IDs 33 to 64 to the second and so on. Banks can be selected via 
the 16-way selector. When a new bank is selected, the radio's channel 
will change to the first channel within the newly selected bank, with the 
Channel Name on the radio display. Channels within a bank can be 
selected using the keypad.

� If set to Channel Selection, the total banks will be 32, and each bank 
will have 16 channels (except the last bank with 13 channels). Channel 
IDs 1 to 16 will be assigned to the first bank, channel IDs 17 to 32 to 
the second and so on. Banks can be selected via the SELECT BANK 
user defined menu option. When a new bank is selected, the radio's 
channel will change to the channel specified by the 16-way selector 
position within the newly selected bank, with the Channel Name on 
the radio display. Channels within a bank can be selected using the 16-
way selector or the keypad.

channel entry 
lock

The channel entry lock feature is available for Orca Excel, Orca 5015 and 
Orca 5020 radios.

Channel entry lock prevents the user from selecting a new channel from the 
keypad when a valid channel has already been selected from the 16-way 
selector. When the user tries to enter a new channel, the radio gives a long, 
low-pitched beep to indicate that the action is invalid.

Channel entry lock is enabled in the Specifications form.

channel entry 
keypad lockout

See channel entry lock

channel entry 
mode

In channel entry mode, or channel selection mode, the user can change to 
a different channel or scan group. Channel entry mode is automatically avail-
able on all radios.

channel 
reversion timer

The channel reversion timer applies to Orca Excel, Orca 5015 and Orca 5020 
radios. 

The channel reversion timer determines how long the radio remains on a 
channel selected from the keypad after a period of inactivity. When the 
channel reversion timer expires, the radio reverts to the channel indicated 
by the position of the 16-way selector.

The duration of the channel reversion timer is set in the Specifications form 
(Channel Reversion Timer field). 

channel selector See 16-way selector.

channel spacing Channel spacing is the interval between channels. For Tait Orca radios, this 
is 12.5, 20 or 25 kHz. Wide Band radios can be programmed for operation 
on 20 and 25 kHz channels only. Universal Band radios can be programmed 
for operation on 12.5, 20 and 25 kHz channels.

Channel spacing is set in the Channels form.
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city squelch When a radio’s squelch threshold is programmed for city squelch, the radio is 
less sensitive to interference than if programmed for country squelch and so 
stronger signals are required for the radio’s speaker to unmute.

The value of city squelch is set at radio calibration time.

computer 
controlled data 
interface

The computer controlled data interface (CCDI) provides a means of con-
trolling Tait Orca conventional radios from some form of computer equip-
ment. The CCDI allows for the implementation of semi- and fully-auto-
matic communications systems such as short data messaging (SDMs), 
computerised despatch terminals, remote outstations and data radio termi-
nals.

confidence 
indicator

Confidence indicators provide feedback to the radio user on how the cur-
rent operation is proceeding. For example, keypress confidence tones are the 
tones heard when a keypad key or a function key is pressed and tell the user 
whether or not an action is permitted.

contrast 
adjustment

The contrast adjustment feature allows the radio user to adjust the display 
contrast. Once activated, the radio user adjusts contrast using the scroll keys. 
The radio returns to its previous mode of operation after a few seconds of 
inactivity.

control status Control status is a Selcall feature.

A control status is a status digit that when received, initiate a particular radio 
operation. For example, when a radio receives a quiet interrogation status 
digit, it transmits its auto acknowledge sequence with its current status 
appended without activating the call received indicator.

country squelch When a radio’s squelch threshold is programmed for country squelch, the 
radio is more sensitive than if programmed for city squelch and so the radio’s 
speaker unmutes more readily. When programmed for country squelch, the 
radio can be used in areas where the signal may be weak and where maxi-
mum range is desirable.

The value of country squelch is set at radio calibration time.

CTCSS CTCSS (continuous tone controlled squelch system) is a type of signalling 
used for segregating groups of users. CTCSS uses subaudible tones between 
67 and 250.3 Hz to identify a group of radio users.

CTCSS invalid 
confirmation 
delay

When an incoming CTCSS signal has been found to be valid but then 
degrades to the point where the radio can no longer accurately decode it, 
the radio continues to consider it valid for the duration of the CTCSS 
invalid confirmation delay. If once the delay has expired the signal still can-
not be accurately decoded, the signal is treated as invalid.

The CTCSS invalid confirmation delay is set in the Subaudible Signalling 
Setup form.
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CTCSS/DCS filter The CTCSS/DCS filter removes any CTCSS or DCS tones that may be 
present on the received audio. The filter limits the range of frequencies the 
radio passes from the incoming signal to the speaker and so in some situa-
tions affects signal quality. Filtering can be automatically switched off for 
channels that do not have CTCSS or DCS.

The CTCSS/DCS filter is enabled in the Subaudible Signalling Setup form.

data See computer controlled data interface.

data identity The data identity is the identity assigned to the radio for operation in the 
computer controlled data interface. A data identity must be assigned if the radio 
is to receive short data messages (SDMs).

The data identity is set in the Data Parameters form.

DCS DCS (digital coded squelch) is a type of signalling used for segregating 
groups of users. DCS uses subaudible tones between 10 and 134 Hz to trans-
mit digital data to identify a group of radio users.

DCS codes take the form of a continuously repeating 23-bit digital code-
word that represents a user group. Codewords are identified by a three-digit 
octal number, which forms part of the codeword. The remainder of the 
codeword includes a sequence of bits derived mathematically from the 
three-digit code. 

When assigning DCS signalling for a channel, it is only necessary to specify 
the three-digit code. See “Standard DCS Codes and Their Inverses” on 
page 147 and “Commonly Used DCS Codes and Their Inverses” on page 
148 for the DCS codes Tait Orca radios support. 

DCS polarity DCS signals are susceptible to polarity inversion at various points in the sig-
nal path from originator to recipient. On some systems, consistent inver-
sions can be compensated for by forcing the radio to decode the inverse of 
every codeword.

default mode The default mode is the mode the radio enters into once the power-up 
sequence is complete and after 10 seconds of no user activity. 

Possibilities are:

� alphanumeric entry mode

� channel entry mode

� DTMF dialling mode

� Selcall dialling

� status entry mode

� user function menu entry mode

No default mode is also an option. 

When no default mode has been programmed, the radio powers up in the 
mode selected when the radio was last on.

Default mode is set in the Specifications form.
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deferred calling Deferred calling is a Selcall feature.

When the transmit inhibit conditions are Busy or Mute, a Selcall call cannot 
be transmitted on a busy channel. When the deferred calling feature is ena-
bled, the call is stored and sent at a random time between 1 and 10 seconds 
after the channel becomes free. 

When a call has been deferred, scanning is suspended until the call is success-
fully sent or until the deferred call is cancelled (by pressing any key or 
switching to another channel).

Deferred calling is enabled in the Selcall Features form.

double voting Double voting is a type of voting in which the signal strength of each chan-
nel in the group is measured twice.

double voting 
with signalling

Double voting with signalling is a type of voting in which a channel must 
have valid signalling before it is made the home channel. The channel’s signal 
strength is measured twice.

DTMF DTMF (dual tone multiple frequency) is the tone-based system used for the 
world’s telephone networks. A DTMF “tone” actually consists of a pair of 
tones. DTMF tones are sometimes referred to as “touch tones”.

Tait Orca radios can encode DTMF tones and so can make DTMF calls (see 
DTMF string), but cannot decode DTMF tones and so cannot receive 
DTMF calls.

DTMF call See DTMF string.

DTMF dialling The DTMF dialling feature allows the radio user to dial DTMF strings using 
the numeric keypad. The alternative to DTMF dialling is DTMF presets.

DTMF dialling 
mode

DTMF dialling mode is available on Orca Eclipse, Orca Excel, Orca 5015 and 
Orca 5020 radios.

In DTMF dialling mode, the user can dial DTMF strings. DTMF dialling 
mode is available when the Manual DTMF Dialling field in the DTMF 
form is enabled.

DTMF preset A DTMF preset is a string of DTMF tone pairs defined for a radio at pro-
gramming time.

DTMF redial DTMF redial is a feature of DTMF dialling mode. When the radio user enters 
DTMF dialling mode, the last DTMF string transmitted is displayed. The 
user can transmit that string by pressing the enter key.

DTMF redial is enabled in the DTMF form.

DTMF string A DTMF string is a series of DTMF tone pairs.
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dual priority 
scanning

Dual priority scanning is a type of scanning in which two of the member chan-
nels are designated as priority channels. The priority channels are scanned 
more often than the other member channels. How often the priority chan-
nels are scanned is determined by the priority sample timers.

DZVEI DZVEI is one of the Selcall tone sets the Conventional Programming Appli-
cation supports. 

economy cycling Economy cycling is the switching between states that occurs when economy 
mode is active and after there is no valid activity on a channel for a prepro-
grammed time (the economy mode timer). Economy cycling consists of two 
states, the receive state and the standby state. The amount of time the radio 
spends in each state is determined by the economy duty cycle. 

The radio cycles between these two states until economy cycling is sus-
pended or until economy mode is deactivated. Economy cycling is sus-
pended if valid activity is found on a channel and while the radio is scanning 
or voting. Economy cycling recommences when there is no longer valid 
activity on a channel or when a scan group is no longer selected.

Economy cycling is suspended while a scan group is selected.

economy duty 
cycle

The economy duty cycle is the amount of time the radio spends in the 
receive and standby states during economy cycling. 

The economy duty cycle is set in the Power Save Features form.

economy mode Economy mode reduces the radio’s power consumption when it is idle. 
When economy mode is active, and there has been no valid activity on a 
channel for the duration of the economy mode timer, the radio begins economy 
cycling.

The beginning of a transmission may be lost if it is received after a period 
of inactivity.

economy mode 
timer

The economy mode timer sets the time between when valid activity was last 
detected on a channel and the start of economy cycling. 

The duration of the economy mode timer is set the Power Save Features 
form.

EEA EEA is one of the Selcall tone sets the Conventional Programming Applica-
tion supports. 

EIA EIA is one of the Selcall tone sets the Conventional Programming Applica-
tion supports. 

emergency call The emergency call is a Selcall feature.

The emergency call can be assigned to a function key setting and when 
transmitted, puts the radio into emergency mode.

Emergency operation is set up in the Selcall Emergency Setup form.
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emergency 
mode

Emergency mode is a Selcall feature.

When in emergency mode, the radio cycles between receiving and trans-
mitting so that the called party can hear activity near the radio and so decide 
how to respond. The radio can be programmed so that all indicators remain 
unchanged while in emergency mode.

Emergency operation is set up in the Selcall Emergency Setup form.

fixed call 
sequence

The fixed call sequence is a Selcall feature.

The fixed call sequence is a Selcall sequence that is defined at radio program-
ming time and that can be transmitted by a long press of the call key on Orca 
5015, Orca Excel and Eclipse radios. 

The fixed call sequence is also used when an alpha symbol that is a Selcall call 
is executed. If the signalling sequence defined for the alpha symbol is fewer 
tones than the fixed call sequence, the missing tones are substituted from 
the fixed call sequence.

The fixed call sequence for each Selcall system is set in the Selcall Identity 
(Tx) tab.

forced audio 
mute

Forced audio mute is part of the Selcall emergency mode. When forced audio 
mute is enabled, the radio’s mute remains active while in emergency mode 
and so the radio does not broadcast noise that may draw attention in an 
emergency situation.

Forced audio mute is enabled in the Selcall Emergency Setup form.

flexiscan Flexiscan is an Orca 5010/5015/5020 feature.

When Flexiscan scanning is turned on, a group of channels in a prepro-
grammed Flexiscan scan group is scanned for valid activity, while the radio 
user is able to communicate on an unrelated channel.

Flexiscan is set up in the Flexiscan tab (Scan Groups form).

free-form 
sequence

A free-form sequence is a Selcall sequence that does not have to conform 
to the Selcall system’s transmit (Tx) format.

frequency band The radio’s frequency band is the range of frequencies it is capable of trans-
mitting and receiving on.

The frequency band the radio operates on is set in the Specifications form.

function key Each radio has two function keys above the PTT key. Orca 5020 radios have 
a third function key, which is the leftmost key in the row of four keys 
underneath the LCD display. These radio function keys can have functions 
assigned to both short and long keypresses. A short keypress is less than one 
second. The radio user may need to experiment to become familiar with 
the duration of short and long keypresses. The third function key on Orca 
5020 radios can also be operated as a “shortcut” to up to three user function 
menu options. 
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Some radio accessories also have function keys, and most of the options 
available for the radio function keys are also available for external function 
keys. However, these external function keys do not have short and long 
keypresses.

function key 
preset call

Function key preset calls are a Selcall feature.

Tait Orca radios can have two function key preset Selcall calls defined for 
each Selcall system at radio programming time.

The function key preset calls are defined in the Selcall Identity (Tx) tab.

gap A gap is a pause in the transmission of tones in a Selcall sequence. When con-
structing Selcall sequences, a gap is represented by a hyphen (-).

A series of gaps makes up a gap burst.

gap burst A gap burst is a series of gaps. The gap burst length is determined by the gap 
period and the number of gaps in the burst.

Gap bursts are used to separate tone bursts in a Selcall sequence.

gap period The gap period is the duration of each gap in a Selcall sequence. For example, 
if the gap period is 10 ms, then a gap burst of three gaps lasts for 30 ms.

The gap period is set in the Selcall Tone Options tab.

group A group can refer to a scan group or to a group of radios that is the recipient 
of a Selcall group call.

group call Group calling is a Selcall feature.

A Selcall call can be made to a group of radios by including a group tone in 
the Selcall sequence.

group hold time The group hold time is the pause between when valid activity on a scan group 
member channel ceases and when scanning resumes.

The group hold time is set in the Scan Groups form.

group tone Group tones are a Selcall feature.

Each Selcall system can have a group tone that acts as a wildcard tone and so 
is equivalent to all of tones 0 to 9 and A to F. For example, if a Selcall 
sequence containing 123GG for the receiver identity were transmitted, all 
radios whose Rx decode sequence is five tones long and starts with tones 123 
recognises the Selcall sequence and respond to it.

The group tone is set in the Selcall Tone Options tab.

group user 
programmable

See programmable scanning and voting groups.
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handset micro-
phone

The handset microphone is the microphone at the bottom of the radio. 
When handset mode is active, the handset microphone operates. The radio 
can also be programmed so that the handset microphone is the default 
microphone (Specifications form).

handset 
operation

Tait Orca radios can be operated as a normal radio where the user holds the 
radio with the microphone about 15 cm away from the mouth or it can be 
operated like a telephone handset. Handset mode is useful in noisy environ-
ments, when privacy is required or in quiet environments when the lowest 
volume setting seems too loud.

handshaking Handshaking refers to the character definitions used to begin and end data 
flow in CCDI (computer controlled data interface) operation. The handshaking 
characters prevent the loss of data between the radio unit and the computer 
equipment.

Handshaking options are set in the Data Parameters form.

hidden channel A hidden channel is a scan group member channel that is not accessible as an 
individual channel.

Hidden channels are enabled in the Scan Groups form.

home channel For scanning, the home channel is the channel in a scan group on which trans-
missions are made, unless another channel has been captured. The home 
channel is the first channel included in the group in the Scan Group Mem-
bers list.

For voting, the home channel is the channel that has been determined as 
having the greatest signal strength. If no channel has been selected, then the 
home channel is the first channel included in the group in the Scan Group 
Members list.

immediate 
callback

When an incoming call is terminated, a radio may be programmed to dis-
play the caller’s identity. If the radio user wishes to call the party back, they 
can do so by pressing the enter key.

indicator Indicators provide feedback to the radio user on how the current operation 
is proceeding and on the operating state of the radio. Tait Orca radios use 
combinations of audible and visual indicators.

invalid activity Invalid activity is traffic on a channel that carries signalling that does not 
match that of the receiving radio.

keypad lock The keypad lock prevents accidental operation of the radio by locking the 
keypad so that only a certain set of keys can be used. 

What keys are locked depends on how the radio was programmed (Keypad 
Lock Disables fields, Key Settings II tab).
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keypress confi-
dence tones

Keypress confidence tones are a confidence indicator that tells the radio user 
whether or not an action is permitted whenever a keypad key or function 
key is pressed.

Keypress confidence tones are enabled in the User Selectable Parameters 
form.

label A label is a sequence of up to eight characters that can give the radio user 
additional information about the radio’s current state. For example, a label 
can be set that indicates which channel is currently selected. 

In the case where the label stands for a string that is to be transmitted, e.g. 
for a status message, it is not the status label that is transmitted but rather the 
status digits. In order for the correct status label to be displayed on the 
receiving radio, status messages (status digit plus status label) should be set 
the same for all radios in a fleet.

LCD display Orca Eclipse, Orca Excel, Orca 5015 and Orca 5020 radios have a 2 x 12 char-
acter LCD (liquid crystal) display.  In combination with the radio’s LED 
indicator and audible indicators, the display provides the radio user with infor-
mation on the state of the radio.

lead in delay A lead in delay is the delay between when the radio starts transmitting and 
when the first tones in a sequence are sent. A lead in delay gives the receiver 
time to prepare to decode the incoming transmission (e.g. time to halt scan-
ning, come to full power or come out of economy mode).

LED indicator The LED (light-emitting diode) at the top of the radio is the main indicator 
for displaying the state the radio is in. The audible indicators and the LCD 
display provide information intended to supplement that provided by the 
LED.

low power 
transmit

The low power transmit feature can be used to change the transmit power 
from the programmed level to low.

lone worker Lone worker is a feature in Orca 5010, Orca 5015 and Orca 5020 radios. 
When activated, the radio begins a pre-programmed inactivity timer. Once 
this time has counted down with no keypress (or motion detected if pro-
grammed), an audible alert will sound for the length of the warning timer. 
If no key is pressed in this time (or motion detected), then either a Selcall 
or DTMF emergency call is made.

The purpose is to get the radio user to press any key every specified period, 
to restart the inactivity timer. If no key is pressed, then it is an indication 
that the worker is incapacitated and an emergency call is automatically 
made.

Lone Worker options are set in the General Options form.

member channel A member channel is a channel that belongs to a scanning or voting group.
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monitor Monitor allows the radio user to override a channel’s signalling and so hear 
all traffic on a channel. 

Note that monitor is not permitted in some countries.

mute A mute controls the circumstances under which a received signal is passed 
to the radio’s speaker. When a mute is active, the radio’s speaker only 
unmutes under certain conditions, determined by the type of signalling 
operating on a channel.

NATEL NATEL is one of the Selcall tone sets the Conventional Programming 
Application supports. 

night use When the night use feature is on, the radio’s backlighting activates whenever 
valid activity is detected, a key on the radio is pressed or when the radio 
receives a call. Backlighting remains on for the duration of the backlighting 
timer unless further activity is detected.

no acknowledge 
retry

The no acknowledge retry feature determines how many times the radio 
will resend a Selcall sequence that requires an auto acknowledge when no auto 
acknowledge is received.

non-captured 
priority sample 
timer

The value of the non-captured priority sample timer determines how often 
priority channels are scanned when there is no captured channel.

The duration of the non-capture priority sample timer is set in the Scan 
Groups form.

normal dialling When a DTMF string is dialled, the string is either transmitted as each indi-
vidual key is pressed (normal dialling) or in its entirety once the enter key 
is pressed (buffered dialling).

The DTMF dialling type is set in the DTMF form.

nuisance delete The nuisance delete feature allows the radio user to temporarily delete a 
busy channel from a scan group. When the scan group is next selected, the 
channel is again part of the group.

Nuisance delete does not work for voting groups.

on/off/volume 
control

The on/off/volume control is the smaller of the two switches on the top of 
Orca Elan, Orca Excel, Orca 5010, Orca 5015 and Orca 5020 radios.

one touch call The first alpha symbol defined in the Alpha Symbols form can be designated 
a one touch call, which can be made by a press of a function key.
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Orca 5020
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Orca Excel

polling Polling is the sampling of member channels to measure their signal strength 
when the radio is voting a scan group.

polling interval The polling interval is how often the member channels in a voting group are 
sampled (“polled”) for greatest signal strength. 
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Handset Microphone

PTT 
Key
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Speaker/
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LED 
Indicator
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Microphone

LED 
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Display

Keypad
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power-up 
message

The power-up message is the message displayed after the radio is turned on. 

The power-up message is programmable (Power-up Message fields,  Spec-
ifications form).

preset call A preset call is a call sequence defined at radio programming time. Preset 
calls can be Selcall sequences or DTMF strings.

priority call Priority calling is a Selcall feature.

A priority call is a Selcall sequence that has a priority control status appended. 
When the receiving radio decodes the priority status digit, it alerts the user 
that a priority call has been received and clears down any call in progress 
that is not a priority call.

The priority call control status is set in the Selcall Control Status Definitions 
form.

priority channel A priority channel is a scan group member channel that is scanned more often 
than the other member channels. How often a priority channel is scanned 
is determined by the priority sample timers.

priority sample 
timer

The non-captured priority sample timer and the captured priority sample timer 
determine how often priority channels in a scan group are scanned.

priority scanning Priority scanning is a type of scanning in which one of the member channels is 
designated the priority channel, which is scanned more often than the other 
member channels. How often the priority channel is scanned is determined 
by the priority sample timers.

priority call 
status

The priority call status is the status digit that a radio must receive before 
alerting a call as a priority call.

The priority call control status is set in the Selcall Control Status Definitions 
form.

programmable 
channel 
signalling

The programmable channel signalling feature allows the radio user to 
change the subaudible signalling used on a channel.

programmable 
scanning and 
voting groups

The programmable scanning and voting groups feature allows the radio user 
to change the mix of channels that belong to scanning and voting groups.

programming 
database

The programming database is the information that is altered using the Con-
ventional Programming Application.  When the Radio>Read command is 
selected, the radio’s programming database is read and the information in it 
is loaded into the fields and forms in the programming application. When 
the Radio>Program command is selected, the radio’s programming data-
base is overwritten with the information altered in the programming appli-
cation.
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PTT key The PTT (press-to-talk) key is the key pressed to transmit. The radio can-
not receive while the PTT is pressed.

The amount of time the radio is permitted to transmit is limited by the trans-
mit timer. When the transmit timer expires, the radio emits a series of warn-
ing tones before returning to the receive state.

Once the transmit timer expires, the radio may be prevented from transmit-
ting for the duration of the transmit lockout timer. 

PTT as shift key The PTT as shift key feature is part of the DTMF dialling function. If the 
user wishes to dial tones A to D or a pause, the PTT can be used as a “shift” 
key in conjunction with the numeric keypad. For example, on the Orca 
Excel:

PTT +  = A

PTT +  = B

PTT +  = C

PTT +  = D

PTT +  = pause

So pressing the PTT key, holding it, then pressing the  key enters tone 
A in the DTMF string. Pressing the PTT, holding it, and then pressing the 

 key enters a pause in the string. A hyphen is entered in the display to 
indicate the pause.

PTT as shift key is enabled in the DTMF form.

PZVEI PZVEI is one of the Selcall tone sets the Conventional Programming Appli-
cation supports. 

quiet state Quiet state is the state the radio is in when monitor is inactive, and the radio 
user does not have to listen to traffic that is not intended for them.

quiet status 
interrogation

The quiet status interrogation feature allows a radio to send a control status 
to another radio requesting that the radio transmit its current status without 
alerting the radio user. Upon receiving the control status, the called radio 
responds by transmitting its auto acknowledge sequence with its current status 
appended.

The quiet interrogation control status is set in the Selcall Control Status 
Definitions form.

radio identity When a radio is operating on a Selcall system, it can have a unique identity 
assigned. This identity is defined by the Rx decode sequence.

The radio’s Rx decode sequences are set in the Selcall Identity (Rx) tab.

receive (Rx) 
format

The receive (Rx) format is a Selcall feature.

The receive format defines the format all incoming Selcall sequences must fol-
low in order to be correctly decoded by the receiving radio. The receive 
format should be the same for all radios using a particular Selcall system.
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If the receive format has an S burst, it must match the S burst for the Selcall 
system’s transmit (Tx) format.

The receive format for each Selcall system is set in the Selcall Identity (Rx) 
tab.

receive (Rx) 
frequency

The receive frequency is the frequency that a radio is currently tuned to.

The receive frequency for each channel is set in the Channels form.

receive 
signalling

The receive signalling is the signalling that must accompany incoming trans-
missions in order for the radio to recognise the signal as valid and so open 
the radio’s mute.

The receive signalling for each channel is set in the Channels form.

received call 
queuing

See call queuing.

received signal 
tracking

Received signal tracking eliminates any frequency offset between the 
incoming signal and the radio’s receiver, making the radio more tolerant of 
frequency errors in other radios. 

Received signal tracking is enabled in the Specifications form (Received 
Signal Tracking field).

receiver identity In a Selcall sequence, the receiver identity is the part of the sequence that 
identifies the radio the sequence is intended for. In the transmit (Tx) format 
and receive (Rx) format, the receiver identity is represented by the character 
R, and so this part of a sequence is known as the R burst.

remote monitor 
reset

Remote monitor reset is a Selcall feature.

A remote monitor reset sequence can be assigned for each Selcall system a 
radio operates on. When the radio receives this sequence and the remote 
monitor reset function has been enabled, the radio deactivates monitor,  
squelch override and/or emergency cycling, if they are active.

repeat tone Repeat tones are a Selcall feature.

A repeat tone is used to ensure that Selcall sequences are correctly decoded by 
a receiving radio. When two adjacent tones in a Selcall sequence are the 
same tone, the repeat tone is substituted for the second occurrence of the 
duplicated tone. The repeat tone is always tone E.

repeater A repeater receives a radio signal and retransmits it. Use of a repeater 
increases the coverage area of a two-way radio system and ensures more 
reliable performance in areas where signals are reflected or attenuated by 
buildings or terrain.

In a repeater-based system, the radio’s transmit frequency is the frequency 
the repeater is listening on, and the radio’s receive frequency is the fre-
quency the repeater rebroadcasts signals on.
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repeater access 
tone

Repeater access tones are a Selcall feature.

A repeater access tone is a single tone that is transmitted before a voice or 
data transmission. The repeater access tone is used to key up the repeater 
before a transmission is sent so that no information is lost at the beginning 
of the transmission.

The repeater access tone is set in the Selcall Tone Options tab.

repeater identity In a Selcall sequence, the repeater identity is the part of the sequence that 
the radio transmits so that the repeater recognises the radio as having access 
to the repeater. In the transmit (Tx) format, the repeater identity is repre-
sented by the character B, and so this part of a sequence is known as the B 
burst. If the transmit format includes a repeater burst, it must come before 
all other bursts.

repeater talka-
round

Repeater talk around allows the radio user to bypass repeater operation and 
so communicate directly with other radios. While repeater talk around is 
active, all transmissions are made on the receive frequency programmed for 
the channel. 

Repeater talk around may be required if the radio is operating outside the 
range of the repeater. Note that repeater talk around is not permitted in 
some countries.

Repeater talk around is enabled in the Transmitter Setup form.

reverse tone 
burst

Reverse tone bursts can be used when CTCSS subaudible signalling is used. 
When reverse tone bursts are enabled, the phase of the generated tones is 
reversed for a number of cycles just before transmission ceases, which can 
increase the speed of receiver shutdown in some repeaters and associated 
equipment.

The phase reversal occurs after any ANI transmission.

The reverse tone burst duration is set in the Subaudible Signalling Setup 
form.

revive See stun and revive.

RSSI indicator Orca Eclipse and Orca 5020 radios can be programmed to display bars on the 
display ( ) that indicate the signal strength (RSSI) whenever the radio is 
receiving a signal (User Selectable Parameters form, RSSI Indicator). If sig-
nal strength is low, calls may not get through.

Rx Rx is an abbreviation for receive.

Rx decode 
sequence

The Rx decode sequence is a Selcall feature.

The Rx decode sequence is the radio’s unique identity on a Selcall system. 
When the radio’s Rx decode sequence is decoded as the receiver identity in 
an incoming Selcall sequence, the radio recognises the sequence as intended 
for it and responds appropriately.
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Each radio operating on a Selcall system can have one or two Rx decode 
sequences assigned. In addition to tones 0 to 9, A to D and F, a V can be 
used in the Rx decode sequence. A radio that has an Rx decode sequence 
of 456VV responds to all call sequences with a receiver identity five tones 
long starting with 456.

scan group A scan group is a group of two to 16 channels. Each scan group member chan-
nel is routinely sampled for activity (scanning) or greatest signal strength (vot-
ing). Scan groups are set up in the Scan Groups form.

scanning Scanning is the systematic sampling of a group of channels (a scan group) for 
valid activity. There are two variations of normal scanning: priority scanning 
and dual priority scanning.

SDM Short data messages (SDMs) are data messages of up to 32 characters. All 
Tait Orca radios can send and receive SDMs while connected to some form 
of computer equipment. Orca Excel, Orca Eclipse, Orca 5015 and Orca 5020 
radios can display received SDMs on the radio display. Orca Eclipse and 
Orca 5020 radios can also enter SDMs via the radio keypad. 

SDM entry mode SDM entry mode is the mode in which short data messages are received and 
sent.

security PIN A security PIN (personal identification number) is a number up to five dig-
its long the user is required to enter when the radio first powers up. When 
a security PIN is required, the radio displays the message ENTER CODE 
and then waits for the correct PIN to be entered before displaying the 
power-up message.The radio cannot be used until the correct PIN has been 
entered.

The security PIN is set in the  Specifications form.

Selcall Selcall stands for “selective calling”, which is a signalling system that uses 
sequences of audible tones to isolate calls intended for specific radios. Each 
radio operating on a Selcall system can have a unique identity assigned.

Selcall dialling Selcall dialling is available on Orca Excel, Orca Eclipse and Orca 5020 radios.

Using Selcall dialling, the user can dial Selcall sequences using the keypad. 

Selcall dialling is available once Selcall has been enabled (Enable Selcall in 
the Selcall Identity (Rx) tab) and a variable call sequence has been defined 
(Selcall Sequences (Tx) tab).

Selcall muting When Selcall muting is enabled, the radio only unmutes when a valid Selcall 
sequence is received. The radio user cannot initiate calls using the PTT unless 
monitor is active, but can only make Selcall calls.

Selcall muting is enabled in the Selcall Identity (Rx) tab.
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Selcall sequence A Selcall sequence is a series of tones and gaps that for a simple Selcall system 
represents the identity of a radio (the receiver identity). A Selcall sequence can 
also contain the identity of the calling radio (the caller identity), the repeater 
identity and the caller’s current activity (status).

Selcall system A Selcall system is the call sequence formats and tone options the radios on 
that system must use to communicate with one another. 

short data 
message

See SDM.

sidetones Sidetones are the tones heard when a DTMF string or Selcall sequence is trans-
mitted and they indicate to the radio user that a call has been transmitted. 
The radio can be programmed to not generate sidetones when a Selcall 
sequence is transmitted (Selcall Features form).

signal 
programming 
mode

Signal programming mode is part of the programmable channel signalling fea-
ture. In signal programming mode, the radio user can change a channel’s 
subaudible signalling.

signalling Signalling is non-voice coding on a channel for the purpose of identifying 
parties and segregating groups of users. If a radio receives signalling that 
matches that programmed for the radio, the signalling is said to be valid and 
the radio’s mute opens. Otherwise, the transmission is ignored and the radio 
remains silent, although the radio’s channel busy indicator is activated. See 
CTCSS, DCS and Selcall. 

squelch The squelch feature ensures that the radio’s speaker only unmutes when an 
intelligible signal is received. A signal is considered intelligible when it is 
strong enough to exceed a predetermined squelch threshold.

squelch override Squelch override allows the user to disable the radio’s squelch and so hear all 
activity on a channel, including noise.

Squelch override is enabled in the Receive Monitoring form.

squelch 
threshold

The squelch threshold is the level the signal must reach before it is regarded 
as intelligible and the radio’s mute is opened. Tait Orca radios can operate 
at two different squelch thresholds: city and country squelch.

The squelch threshold for each channel is set in the Channels form.

status Status is a Selcall feature.

Status is the current activity of the radio user, which can be represented by 
a status message.

Another type of status is control status, which when received, initiate a par-
ticular radio operation.
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status digit Status digits are a Selcall feature.

In a Selcall sequence, the status digit is the part of the sequence that identifies 
the current activity (status) of the radio transmitting the sequence. In the 
transmit (Tx) format and receive (Rx) format, the status digit is represented by 
the character S, and so this part of a sequence is known as the S burst.

status entry 
mode

Status entry mode is a Selcall feature available on Orca Eclipse and Orca 5020 
radios.

In status entry mode, the radio user can change the status to reflect their cur-
rent activity. The corresponding status digit is sent with Selcall sequences that 
include a variable status. 

Status entry mode is available once Selcall has been enabled and when at 
least one of the Status fields for the fixed call sequence or the variable call 
sequence (Selcall Identity (Rx) tab) contains a V.

status label Status labels are a Selcall feature available on Orca Eclipse and Orca 5020 
radios.

A status label is a label that is associated with a particular status digit.

When a Selcall sequence is sent, the status digit is transmitted, but the status 
label is not. If a receiving radio has been programmed with a status label that 
corresponds to the status digit transmitted, it displays that label, which is 
why it is important that all radios using the same Selcall system be pro-
grammed with the same status messages.

status message Status messages are a Selcall feature.

A status message represents the current activity of the radio user in the form 
of a status digit and a status label. 

When a Selcall sequence is transmitted, it can include a status digit. Because 
only the status digit is transmitted, all radios using a Selcall system must be 
programmed with the same status messages in order for status labels to be dis-
played correctly.

stun and revive Stun and revive is a Selcall feature.

At radio programming time, two control status can be assigned, one to stun 
the radio, which makes it inoperable, and the other to revive the radio, 
which returns it to a useable state.

The stun and revive control status are set in the Selcall Control Status Def-
initions form.

subaudible 
signalling

Subaudible signalling is signalling that is at the bottom end of the range of  
audible frequencies. Tait Orca radios support CTCSS and DCS subaudible 
signalling.

Tait Radio 
Modem

The Tait Radio Modem is a data radio intended primarily for data commu-
nications. Operating at 1200 baud, it is suitable for stand-alone use in point-
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to-point or point-to-multipoint data communications, as a telemetry unit 
in Scada Systems, or for system integrators.

third tone 
monitor reset

Third tone monitor reset is a Selcall feature.

The monitor and squelch override are deactivated when the first three tones of 
the receiver identity for an incoming Selcall sequence match the first three tones 
of one of the radio’s Rx decode sequences.

Third tone monitor reset is enabled in the Selcall Features form.

toggle The term toggle is used to describe the switching between two states.

tone A tone is a sound wave of a particular frequency.

For CTCSS and DCS, the tone is transmitted continuously as long as the 
radio is transmitting. For Selcall sequences and DTMF strings, the transmit 
time of each tone is programmable (see tone duration/period). 

When constructing Selcall sequences, different tones are represented by the 
characters 0-9 and A-F. A series of tones makes up a tone burst. The frequen-
cies used for tones 0-9 and A-F are dependent upon the tone set.

When defining DTMF strings, the different tones are represented by the 
characters 0-9, A-D, * and #. The frequencies used are determined by an 
internationally accepted standard.

tone blanking Tone blanking is a Selcall feature.

Tone blanking blanks out the tones of a received Selcall sequence so that the 
user does not hear them. The user may, however, hear the first few tones.

The radio’s Rx decode sequences are set in the Selcall Identity (Rx) tab.

Tone blanking is enabled in the Selcall Features form.

tone burst A tone burst is a series of tones in a Selcall sequence. A burst can correspond 
to a particular piece of information, such as:

� receiver identity (R burst),

� caller identity (C burst),

� repeater identity (B burst) and
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� status (S burst).

For example, the R burst defines the receiver identity and can be up to 
eight tones long. An R burst of five tones would be defined in the Tx and 
Rx Formats as RRRRR. For a Selcall sequence that places a call to radio 
12345, the R burst would be 12345.

How long a tone burst lasts is determined by the tone duration/period and the 
number of tones in the burst. Tone bursts are usually, but not always, sep-
arated by a gap burst.

tone duration/
period

The tone period, or tone duration in the case of DTMF, is how long a tone 
is transmitted. For example, if the tone period for a Selcall sequence is 10 
ms, then a tone burst of three tones lasts for 30 ms.

For Selcall sequences, tone period is set in the Selcall Tone Options tab. For 
DTMF strings, tone duration is set in the DTMF Dialling tab.

tone set The tone set is the set of frequencies represented by the characters 0-9 and 
A-F used to make up Selcall sequences.

There are a number of internationally accepted standard tone sets available. 
There is a finite number of frequencies available to represent the various 
characters in a Selcall sequence; it is the frequencies used and their order 
that distinguishes one tone set from another.

The Conventional Programming Application supports the following tone 
sets: CCIR, EIA, EEA, ZVEI-I, ZVEI-II, ZVEI-III, PZVEI, NATEL and 
DZVEI.

The tone set for each Selcall system is set in the  Selcall Tone Options tab.

traffic Traffic is an intelligible signal on a channel that exceeds the radio’s squelch 
threshold.

transmit (Tx) 
format

The transmit (Tx) format is a Selcall feature.

The transmit format defines the format all outgoing Selcall sequences must 
follow in order to be correctly decoded by other radios using the same 
Selcall system. The transmit format should be the same for all radios using a 
particular Selcall system.

The transmit format for each Selcall system is set in the Selcall Identity (Rx) 
tab.

transmit (Tx) 
frequency

The transmit frequency is the frequency that all outgoing transmissions are 
made on.

The transmit frequency for each channel is set in the Channels form.

transmit inhibit The transmit inhibit feature determines under what conditions a press of the 
PTT results in the radio not transmitting.

The radio can be prevented from transmitting whenever there is activity on 
the channel, whether it is valid or invalid (Busy option), or invalid activity 
only (Mute option). Note that if the Mute option is selected and the radio 
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user has activated monitor, the radio transmits when the PTT is pressed, even 
if there is valid activity on the channel. The conditions under which trans-
mission is inhibited are set in the Transmitter Setup form (Tx Inhibit field). 

transmit lockout The transmit lockout feature prevents the radio from transmitting once the 
transmit timer has expired.

How long transmitting is locked out is set in the Transmitter Setup form.

transmit 
signalling

The transmit signalling is the signalling that accompanies all outgoing trans-
missions made.

The transmit signalling for each channel is set in the Channels form.

transmit timer The transmit timer determines the longest continuous transmission permit-
ted by a radio. When the transmit timer expires, the radio emits a series of 
warning tones before returning to the receive state.

How long the radio can transmit continuously is set in the Transmitter 
Setup form (Transmit Timer Duration field).

Tx Tx is an abbreviation for transmit.

user function 
menu entry 
mode

User function menu entry mode is available on Orca Eclipse and Orca 5020 
radios.

In user function menu entry mode, the user can customise radio options. 
For Orca Eclipse radios, the user defined menu is set up in the User Selecta-
ble Parameters Form. For Orca 5020 radios, the user defined menu is set up 
in the User Defined Menu Form.

valid activity Valid activity is traffic on a channel that carries signalling that matches that 
programmed for the receiving radio. The radio’s mute opens upon detecting 
valid activity.

variable call 
sequence

The variable call sequence is a Selcall feature available on Orca Eclipse, Orca 
Excel, Orca 5015 and Orca 5020 radios.

The variable call sequence is a Selcall sequence that is defined as part of the 
Selcall dialling feature. In the variable call sequence, one or more tones are 
set to V. The V tones represent the tones the radio user keys in. When the 
variable call sequence is transmitted, the tones the user has keyed in are sub-
stituted for the Vs in the variable call sequence.

The variable call sequence for each Selcall system is set in the Selcall Identity 
(Tx) tab.

variable status Variable status is a Selcall feature.

The S burst of a Selcall sequence can be programmed with a V. When the 
sequence is transmitted, the status digit included is the one the user last 
selected in status entry mode.
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volume control 
keys

On Orca Eclipse radios, the volume control keys are the two keys on the side 
of the radio opposite the function keys and the PTT key. When the radio user 
first presses one of the volume keys, the message VOL appears in the upper 
lefthand corner of the display, as shown below.

 

The series of bars indicates the volume level.

voting Voting is the systematic sampling of a group of channels (a scan group) for the 
channel with the greatest signal strength. There are three variations of nor-
mal voting: voting with signalling, double voting and double voting with signalling.

voting with 
signalling

Voting with signalling is a type of voting in which a channel must have valid 
signalling before it is made the home channel.

ZVEI-I, ZVEI-II, 
ZVEI-III

ZVEI-I, ZVEI-II and ZVEI-III are among the Selcall tone sets the Conven-
tional Programming Application supports.
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